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> Preface

Preface

Thank you for purchasing this machine.

This Operation Guide is intended to help you operate the machine correctly, perform routine maintenance, and take
simple troubleshooting measures as needed so that the machine can always be used in the optimum condition.

Please read this Operation Guide before using the machine.

To maintain quality, we recommend using genuine Kyocera toner containers, which must
pass numerous quality inspections.

The use of non-genuine toner containers may cause failure.

We will not be liable for any damages caused by the use of third party supplies in this machine.

A label is affixed to our replacement genuine toner containers, as shown below.

0! KYOCERA

Checking the Equipment's Serial Number

The equipment's serial number is printed in the location shown in the figure.

You'll need the equipment's serial number when contacting your Service Representative. Please check the number
before contacting your Service Representative.
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> Machine Features

Machine Features

The machine is equipped with many useful functions.

®» Using Various Functions (page 6-1)

Here are some examples.

Optimize your office workflow

Save energy and cost

Save frequently used documents in
the machine (Custom Box)

—

[ — i\(

*

You can save the frequently used
document in the machine and print it
when needed.

®» Using a Custom Box (page 5-5)

Save energy as needed
(Energy Saver function)

The machine is equipped with Energy
Saver function that automatically
switched into Sleep Mode.

® FEnergy Saver function (page 2-27)

Use less toner for printing
(EcoPrint)

>

You can save toner consumption with this
function.

When you only need to check the printed
content, such as a trial print run or
documents for internal confirmation, use
this function to save toner.

Use this function when a high-quality print
is not required.

P EcoPrint Mode (page 7-10)

Save energy and cost

Strengthen security

Reduce paper use
(Paper Saving Printing)

1 i ;}
< > 1 2
* ¥

You can print originals on both sides of
the paper. You can also print multiple
originals onto one sheet.

Protect data on the SSD
(Encryption / Overwrite)

You can overwrite the unnecessary data
that remains on the SSD automatically.

To prevent an external leakage, the
machine is able to encrypt data before
writing it to the SSD.

®» Data Security (page 7-27)

Prevent loss of finished documents
(Private Print)

You can temporarily save a printer
document in the machine. By printing the
document from the machine prevents
someone takes your document.

> Printing Data Saved on the Printer
(page 4-8)

Vi




> Machine Features

Strengthen security

Use functions more efficiently

Log in by ID card
(Card Authentication)

— =
OK'!

You can log in simply by touching an ID
card. You don't need to enter the
administrator name and password.

= Card Authentication Kit(B) "Card
Authentication Kit" (page 10-3)

Strengthen security
(Settings for Administrator)

M
|

Various functions are available for
administrators to strengthen security.

P Strengthening the Security (page 2-

41)

Make the machine quiet
(Quiet Mode)

You can make the machine quiet by
reducing its running noise. You can
configure this mode by job.

P Quiet Mode (page 6-3)

Use functions more efficiently

Install the machine without concerning
the network cables (Wireless Network)

N (((t o

In an environment where the wireless

LAN is used, you can install the machine
without concerning the network cables. In
addition, Wi-Fi Direct, etc. are supported.

> Configuring the Wireless Network

(page 2-18)
Setting Wi-Fi Direct (page 2-23)

Use USB memory
(USB Memory)

q{/_
< Io—
& R

It is useful when you need to print
document outside your office or you
cannot print document from your PC.

You can print the document from the USB
memory by plugging it directly into the
machine.

® Printing Documents Stored in
Removable USB Memory (page 5-9)

Perform remote operation
(Command Center RX)

KOCER
Command Center BEE

[Z] papertonsea

——

You can accé"ss to the machine remotely
to print, send or download data.

Administrators can configure the machine
behavior or management settings.

% Command Center RX (page 2-42)

vii




> Guides Provided with the Machine

Guides Provided with the Machine

The following guides are provided with the machine. Refer to each guide as needed.

The contents of the guides are subject to change without notice for the purpose of improvement of machine
performance.

Printed guides
Quick Guide

Explains how to use basic functions of the machine, how to use convenient features, how
to perform routine maintenance, and what to do when problems occur.

Safety Guide

> Provides safety and cautionary information for installation environment and use of the
machine. Be sure to read this guide before using the machine.

Start using the
machine quickly >

For safe use of the
machine Safety Guide (ECOSYS P6230cdn)

Indicates the space required for machine installation, and describes the cautionary labels
and other safety information. Be sure to read this guide before using the machine.

viii



> Guides Provided with the Machine

Guides (PDF) on the DVD (Product Library)

Use the machine
thoughtfully

Use the ID card

Strengthen security

Easily register
machine information
and configure settings

Print data from a
computer

Directly print a PDF file

Monitor the machine
and printers on the
network

Print without using the
printer driver

Adjust the print
position

>

vV vV v v Vv Vv v

>

Operation Guide (This Guide)

Explains how to load paper and perform basic operations, and indicates default settings
and other information.

Card Authentication Kit (B) Operation Guide

Explains how to perform authentication using the ID card.

Data Security Kit (E) Operation Guide

Explains how to introduce and use the Data Security kit (E), and how to overwrite and encrypt
data.

Command Center RX User Guide

Explains how to access the machine from a Web browser on your computer to check and
change settings.

Printer Driver User Guide
Explains how to install the printer driver and use the printer function.

KYOCERA Net Direct Print Operation Guide

Explains how to print PDF files without launching Adobe Acrobat or Reader.

KYOCERA Net Viewer User Guide

Explains how to monitor your network printing system (the machine) with KYOCERA Net
Viewer.

PRESCRIBE Commands Command Reference
Describes the native printer language (PRESCRIBE commands).

PRESCRIBE Commands Technical Reference

Describes the PRESCRIBE command functions and control for each type of emulation.

Maintenance Menu User Guide
Maintenance Menu provides the explanation on how to configure the print settings.

Install the following versions of Adobe Reader to view the manuals on the DVD.

Version 8.0 or later



> About the Operation Guide (this Guide)

About the Operation Guide (this Guide)

Structure of the guide

The Operation Guide contains the following chapters.

Chapter Contents

1 | Legal and Safety Information Provides precautions regarding use of the machine and trademark information.
2 | Installing and Setting up the Explains part names, cable connections, installation of the software, login, logout, and
Machine other matters related to administration of the machine.
3 | Preparation before Use Explains preparations and settings that are required in order to use the machine, such
as how to use the operation panel, and load paper.
4 | Printing from PC Explains the basic steps for printing.
5 | Operation on the Machine Explains the basic procedures for using document boxes.
6 | Using Various Functions Explains convenient functions that are available on the machine.
7 | Setup and Registration (System | Explains System Menu and how it relates to the operation of the machine.
Menu)
8 | User Authentication and Explains user login and job accounting.
Accounting (User Login, Job
Accounting)
9 | Troubleshooting Explains what to do when toner runs out, an error is displayed, or a paper jam or other
problem occurs.
10 | Appendix Describes convenient options that are available for the machine. Provides information
on media types and paper sizes, and gives a glossary of terms. Explains lists the
specifications of the machine.




> About the Operation Guide (this Guide)

Conventions Used in This Guide

Adobe Reader Xl is used as an example in the explanations below.

Click an item in the Table of Click to move from the current page to the previously
Contents to jump to the displayed page. This is convenient when you want to return
corresponding page. to the page from which you jumped to the current page.

@@@@E}%‘f&ml (@) ‘—-I-Hz‘: Tools SignECumment

Booki ks
@ ‘ mar E m Preparation before Use > Loading Paper
- ® - .
KP 7 Precaution for Loading Paper
- Contents When you open a new package of paper, fan the sheets to separate them slighty prior 1o loading.
o 7o —— () IMPORTANT

[P Machine Features

[P Guides Provided with the 1
Machine E

Indicates operational requirements

/ﬂ and restrictions to operate the
Y * machine correctly, and avoid

[P About the Operation W
Guide (this Guide) = 4 ;
r 3 damage to the machine or property.
[F Menu Map In addition. note the following points.
[F 1 Legal and Safety + I the paper is ourled or folded, straighten it befare loading. Paper that s ouried or folded
- o may cause a jam.
I EMUELEL - Awoid exposing opaned paper to high temparatures and high humidity as dampness can be
- ; a cause of problems. Seal any remaining paper after loading in the multi purpose tray or T
F2 Installing and Setting cassettes back in the paper storage bag NOTE
up the Machine - If the machine will not be used for a prolonged perid, protact all paper from humidity by g

] Preparation before Use removing it from the cassettes and sealing it in the paper storage bag

Indicates supplemental

[P 4 Printing from PC (&) IMPORTANT i
r 5 Operation on the If you copy onto used paper (paper already used for printing), do not use paper that is explanatlons and reference
N Sfap!zd or clipped together. This may damage the machine or cause poor image H f t' f t'
Machine quality. Information tor operations.

Pe Using Various Functions

[ note

IF 7 Status/Job Cancel o T e S e BT S e | o A I e e
Fs Setup and Registration :;;:2:::::?:‘;;'):::;::EIE;;T :;dm‘ pgape]]r_w]awlh et ik Refer to
(System Menu) asiol M
7 ¢ User Authentication Acrvmon Click the underlined text to jump to

Eﬂd-ACCDUﬂTIHg (US-Ef The fixing unit is extremely hot. Take sufficient care when working in this area, as
Login, Job Accounting) there is a danger of getting burned.

P 10 Troubleshooting
1 Appendix

the corresponding page.

A\ caution

Indicates that personal injury or
mechanical damage may result
from insufficient attention to or
incorrect compliance with the
related points.

X-XX

1

NOTE

The items that appear in Adobe Reader vary depending on how it is used. If the Table of Contents or tools do not
appear, refer to Adobe Reader Help.

Certain items are indicated in this guide by the conventions described below.

Convention Description

[Bold] Indicates keys and buttons.

"Regular" Indicates a message or setting.

Xi



> About the Operation Guide (this Guide)

Conventions used in procedures for operating the machine

In this Operation Guide, continuous operation is as follows:

Actual procedure

Select the [Menu] key.
v

Select the [A] or [¥] key to select [Device Common].
v

Select the [P ] key.

Procedure indicated in this guide

[Menu] key > [A][V¥] key > [Device Common] > [P ] key

Xii




> Menu Map

Menu Map

This is a list of menus displayed on the message display. Depending on the settings, some menus may not be displayed.
Some menu names may differ from their reference titles.

Menu
&
h 4
Report Print Print Menu Map (page 7-4)
Print Config. List (page 7-4)
Print Status Page (page 7-4)
Print Fonts List (page 7-5)
Print RAM Disk File List (page 7-5)
Print SSD File List (page 7-5)
Print SD Card File List (page 7-5)
Print Data Sanitization Report (page 7-5)
USB Memory Print File (page 5-9)
Copies (page 5-9)
Paper Source (page 5-9)
Quiet Mode (page 7-28)
Remove Device (page 5-11)
Print File List (page 5-8)
Custom Box Select Box Print All Files (page 5-6)
(Selects the data) (page 5-6)
Delete All Files (page 5-7)
Print File List (page 5-8)
Print Box List (page 5-8)
Job Box Quick Copy (page 4-13)
Private/Stored (page 4-15)
Job Box Cofiguration Quick Copy (page 4-17)
Delete (page 4-17)
Storage Media (page 4-17)
Counter (page 2-40)

Xiii



> Menu Map

Paper Settings

MP Tray Size (page 7-6)

MP Tray Type (page 7-6)

Cassette1 Size (page 7-6)

Cassette2 Size (page 7-6)

Cassette3 Size (page 7-6)

Cassette4 Size (page 7-6)

Cassette 1 Type (page 7-7)

Cassette 2 Type (page 7-7)

Cassette 3 Type (page 7-7)

Cassette 4 Type (page 7-7)

Type Adjust

Paper Weight (page 7-7)

Duplex Path (page 7-7)

Reset Type Adjust (page 7-7)

Paper Setup Msg (page 7-7)

Print Settings

Paper Source (page 7-9)

Auto Cass.Change (page 7-9)

MP Tray Priority (page 7-9)

Paper Feed Mode (page 7-9)

Duplex (page 7-9)

Override A4/LT (page 7-9)

Emulation

Error Report (page 7-9)

Color Mode (page 7-9)

Print Quality

KIR Mode (page 7-10)

Gloss Mode (page 7-10)

EcoPrint Mode (page 7-10)

EcoPrint Save Lvl (page 7-10)

Resolution (page 7-10)

Page Set

Copies (page 7-10)

Orientation (page 7-10)

Wide A4 (page 7-10)

XPS FitTo Page (page 7-10)

TIFF/JPEG Size (page 7-10)

User Name (page 7-10)

Job Name (page 7-10)

Xiv




> Menu Map

Wi-Fi Direct Set Wi-Fi Direct (page 7-11)

Auto Disconnect

Timer (Day:Hour:Min) (page 7-11)

Wi-Fi Settings Wi-Fi (page 7-11)

Quick Setup (page 7-11)

TCP/IP

DHCP (page 7-12)

Auto-IP (page 7-12)

IP Address (page 7-12)

Subnet Mask (page 7-12)

Gateway (page 7-12)

TCP/IP (IPv6)

RA(Stateless) (page 7-13)

DHCPV6 (page 7-13)

Restart Network (page 7-13)

Wired Network TCP/IP

DHCP (page 7-12)

Auto-IP (page 7-12)

IP Address (page 7-12)

Subnet Mask (page 7-12)

Gateway (page 7-12)

TCP/IP (IPv6)

RA(Stateless) (page 7-13)

DHCPV6 (page 7-13)

LAN Interface (page 7-13)

Restart Network (page 7-13)

Network Settings Communication (page 7-14)

SSL Server (page 7-14)

IPSec (page 7-14)

Bonjour (page 7-14)

IP Filter (IPv4) (page 7-14)

IP Filter (IPv6) (page 7-14)

NetBEUI (page 7-14)

SNMPV3 (page 7-14)

FTP(Server) (page 7-14)

SNMP (page 7-15)

SMTP (page 7-15)

POP3 (page 7-15)

XV




> Menu Map

Network Settings

RAW Port (page 7-15)

LPD (page 7-15)

IPP (page 7-15)

IPP over SSL (page 7-15)

HTTP (page 7-16)

HTTPS (page 7-16)

ThinPrint (page 7-16)

ThinPrint over SSL (page 7-16)

WSD-PRINT (page 7-16)

Enhanced WSD (page 7-17)

REST (page 7-17)

REST over SSL (page 7-17)

Optional Network

TCP/IP

DHCP (page 7-12)

Auto-IP (page 7-12)

IP Address (page 7-12)

Subnet Mask (page 7-12)

Gateway (page 7-12)

Bonjour (page 7-14)

TCP/IP (IPv6)

RA (Stateless) (page 7-13)

DHCPV6 (page 7-13)

Netware (page 7-18)

AppleTalk (page 7-18)

IPSec (page 7-18)

LAN Interface (page 7-18)

MACAddressFilter (page 7-18)

Restart Network (page 7-18)

XVi




> Menu Map

Device Common

Message Language (page 7-19)

Date Setting

Date (Year/Mon/Day) (page 7-19)
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Information

Please read this information before using your machine. This chapter provides information on the following topics.
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Notice

Safety Conventions in This Guide

The sections of this guide and parts of the machine marked with symbols are safety warnings meant to protect the user,
other individuals and surrounding objects, and ensure correct and safe usage of the machine. The symbols and their
meanings are indicated below.

WARNING: Indicates that serious injury or even death may result from insufficient
A attention to or incorrect compliance with the related points.

CAUTION: Indicates that personal injury or mechanical damage may result from
A insufficient attention to or incorrect compliance with the related points.

Symbols

The A symbol indicates that the related section includes safety warnings. Specific points of attention are indicated
inside the symbol.

A ... [General warning]

& ... [Warning of high temperature]

The © symbol indicates that the related section includes information on prohibited actions. Specifics of the prohibited
action are indicated inside the symbol.

® ... [Warning of prohibited action]

@ ... [Disassembly prohibited]

The ® symbol indicates that the related section includes information on actions which must be performed. Specifics of
the required action are indicated inside the symbol.

0 ... [Alert of required action]
% ... [Remove the power plug from the outlet]

9 ... [Always connect the machine to an outlet with a ground connection]

Please contact your service representative to order a replacement if the safety warnings in this Operation Guide are
illegible or if the guide itself is missing (fee required).
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Environment

The service environmental conditions are as follows:
Temperature 50 t0 90.5 °F (10 to 32.5 °C)
Humidity 10 to 80%

Avoid the following locations when selecting a site for the machine.

» Avoid locations near a window or with exposure to direct sunlight.

* Avoid locations with vibrations.

» Avoid locations with drastic temperature fluctuations.

» Avoid locations with direct exposure to hot or cold air.

» Avoid poorly ventilated locations.

If the floor is delicate against casters, when this machine is moved after installation, the floor material may be damaged.

During printing, some ozone is released, but the amount does not cause any ill effect to one's health. If, however, the
machine is used over a long period of time in a poorly ventilated room or when making an extremely large number of
prints, the smell may become unpleasant. To maintain the appropriate environment for print work, it is suggested that the
room be properly ventilated.
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Precautions for Use

Cautions when handling consumables

A CAUTION

Do not attempt to incinerate parts which contain toner. Dangerous sparks may cause burns.
Keep parts which contain toner out of the reach of children.

If toner happens to spill from parts which contain toner, avoid inhalation and ingestion, as well as contact with your eyes
and skin.

» If you do happen to inhale toner, move to a place with fresh air and gargle thoroughly with a large amount of water. If
coughing develops, contact a physician.

» If you do happen to ingest toner, rinse your mouth with water and drink 1 or 2 cups of water to dilute the contents of
your stomach. If necessary, contact a physician.

» If you do happen to get toner in your eyes, flush them thoroughly with water. If there is any remaining tenderness,
contact a physician.

+ If toner does happen to get on your skin, wash with soap and water.

Do not attempt to force open or destroy parts which contain toner.

Other precautions

Return the exhausted toner container and waste toner box to your dealer or service representative. The collected toner
container and waste toner box will be recycled or disposed in accordance with the relevant regulations.

Store the machine while avoiding exposure to direct sunlight.

Store the machine in a place where the temperature stays below 40 °C while avoiding sharp changes of temperature
and humidity.

If the machine will not be used for an extended period of time, remove the paper from the cassette and the Multi Purpose
(MP) Tray, return it to its original package and reseal it.
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Laser Safety (Europe)

Laser radiation could be hazardous to the human body. For this reason, laser radiation emitted inside this machine is
hermetically sealed within the protective housing and external cover. In the normal operation of the product by user, no
radiation can leak from the machine.

This machine is classified as Class 1 laser product under IEC/EN 60825-1:2014.

Regarding CLASS 1 laser products, information is provided on the rating label.

4 )\

CLASS 1 LASER PRODUCT

KLASSE 1 LASER PRODUKT
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SAFETY OF LASER BEAM (USA)

1. Safety of laser beam

This machine has been certified by the manufacturer to Class 1 level under the radiation performance standards
established by the U.S.DHHS (Department of Health and Human Services) in 1968. This indicates that the product is
safe to use during normal operation and maintenance. The laser optical system, enclosed in a protective housing and
sealed within the external covers, never permits the laser beam to escape.

2. The CDRH Act

A laser-product-related act was implemented on Aug. 2, 1976, by the Center for Devices and Radiological Health
(CDRH) of the U.S. Food and Drug Administration (FDA). This act prohibits the sale of laser products in the U.S. without
certification, and applies to laser products manufactured after Aug. 1, 1976. The label shown below indicates
compliance with the CDRH regulations and must be attached to laser products marketed in the United States. On this
machine, the label is on the rear.

ECOSYS P6230cdn

Printer
SENNENNEEEEEEENI

3. Maintenance

For safety of the service personnel, follow the maintenance instructions in the other section of this manual.

4. Safety switch

The power to the laser unit is cut off when the front cover is opened.
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Safety Instructions Regarding the Disconnection of
Power

Caution: The power plug is the main isolation device! Other switches on the equipment are only functional switches and
are not suitable for isolating the equipment from the power source.

Attention: Le débranchement de la fiche secteur est le seul moyen de mettre I'appareil hors tension. Les interrupteurs
sur I'appareil ne sont que des interrupteurs de fonctionnement: ils ne mettent pas I'appareil hors tension.

Compliance and Conformity

Hereby, KYOCERA Document Solutions Inc. declares that the radio equipment type ECOSYS P6230cdn is in
compliance with Directive 2014/53/EU.

The full text of the EU declaration of conformity is available at the following internet address:
https://www.kyoceradocumentsolutions.eu/index/service/dlc.html

Module name Software Ver. Frequency band in Maximum radio-frequency power transmitted in the
which the radio frequency band in which the radio equipment
equipment operates: operates:
IB-51 (Option) 226 2.4GHz 100mwW
IB-36 (Option) 2014.12 2.4GHz 100mWwW

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

» The use of a non-shielded interface cable with the referenced device is prohibited.

CAUTION — The changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

This device complies with Part 15 of FCC Rules.

Operation is subject to the following two conditions; (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two
conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

The antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all
persons and must not be co-located or operating in conjunction with any other transmitter.

* The above statements are valid only in the United States of America and Canada.
NOTE — Use shielded interface cables.
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Other precautions
(for users in California, the United States)

Perchlorate Material - special handling may apply. See www.dlsc.ca.gov/hazardouswaste/perchlorate.

EN ISO 7779

Maschinenlarminformations-Verordnung 3. GPSGV, 06.01.2004: Der hochste Schalldruckpegel betragt 70 dB (A) oder
weniger gemaf EN ISO 7779.

EK1-ITB 2000

Das Gerat ist nicht fiir die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um
stérende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld
platziert werden.

Wireless Connection (Mexico only)

The operation of this equipment is subject to the following two conditions:

(1) it is possible that this equipment or device may not cause harmful interference, and (2) this equipment or device must
accept any interference, including interference that may cause undesired operation.

La operacién de este equipo esta sujeta a las siguientes dos condiciones:

(1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe
aceptar cualquier interferencia, incluyendo la que pueda causar su operacion no deseada.

Security Precautions when Using Wireless LAN
(If equipped)

Wireless LAN allows information to be exchanged between wireless access points instead of using a network cable,
which offers the advantage that a LAN connection can be established freely within an area in which radio waves can be
transmitted.

On the other hand, the following problems may occur if security settings are not configured, because radio waves can
pass through obstacles (including walls) and reach everywhere within a certain area.

Secretly Viewing Communication Contents

A third person with malicious objectives may intentionally monitor radio waves and gain unauthorized access to the
following communication contents.

» Personal information including ID, passwords, and credit card numbers
» Contents of email messages
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lllegal Intrusion

A third party with malicious intent may gain unauthorized access to personal or company networks and conduct the
following illegal actions.

» Extracting personal and confidential information (information leak)

» Entering into communication while impersonating a specific person and distributing unauthorized information
(spoofing)

* Modifying and retransmitting intercepted communications (falsification)

+ Transmitting computer viruses and destroying data and systems (destruction)

Wireless LAN cards and wireless access points contain built-in security mechanisms to address these problems and to
reduce the possibility of these problems occurring by configuring the security settings of wireless LAN products when
the product is used.

We recommend that customers take responsibility and use their judgment when configuring the security settings and
that they ensure that they fully understand the problems that can occur when the product is used without configuring the
security settings.

Limited Use of This Product (If equipped)

* Radio waves transmitted from this product may affect medical equipment. When using this product in a medical
institution or in the vicinity of medical instruments, either use this product according to the instructions and
precautions provided by the administrator of the institution or those provided on the medical instruments.

+ Radio waves transmitted from this product may affect automatic control equipment including automatic doors and fire
alarms. When using this product in the vicinity of the automatic control equipment, use this product according to the
instructions and precautions provided on the automatic control equipment.

+ If this product is used in devices that are directly related to service including airplanes, trains, ships, and automobiles
or this product is used in applications requiring high reliability and safety to function and in devices requiring accuracy
including those used in disaster prevention and crime prevention and those used for various safety purposes, please
use this product after considering the safety design of the entire system including adoption of a failsafe design and
redundancy design for reliability and safety maintenance of the entire system. This product is not intended for use in
applications requiring high reliability and safety including aerospace instruments, trunk communication equipment,
nuclear power control equipment, and medical equipment; hence, the decision as to whether to use this product in
these applications needs to be fully considered and determined.

Soélo México (Mexico only)

Este equipo utiliza el médulo de interfaz de red inalambrica modelo LBWA1ZZ1CA para conectarse a las redes
Inaldmbricas.
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Legal Information

Copying or other reproduction of all or part of this guide without the prior written consent of KYOCERA Document
Solutions Inc. is prohibited.

Regarding Trade Names

PRESCRIBE and ECOSYS are registered trademark of Kyocera Corporation.
KPDL is a trademark of Kyocera Corporation.

Microsoft, Windows, Windows Vista, Windows Server and Internet Explorer are registered trademarks or trademarks
of Microsoft Corporation in the U.S.A. and/or other countries.

PCL is a trademark of Hewlett-Packard Company.

Adobe Acrobat, Adobe Reader and PostScript are trademarks of Adobe Systems, Incorporated.

Ethernet is a registered trademark of Xerox Corporation.

Novell and NetWare are registered trademarks of Novell, Inc.

IBM and IBM PC/AT are trademarks of International Business Machines Corporation.

AppleTalk, Bonjour, Macintosh, and Mac OS are trademarks of Apple Inc., registered in the U.S. and other countries.

All European language fonts installed in this machine are used under licensing agreement with Monotype Imaging
Inc.

Helvetica, Palatino and Times are registered trademarks of Linotype GmbH.

ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and ITC ZapfDingbats are registered trademarks of
International Typeface Corporation.

ThinPrint is a trademark of Cortado AG in Germany and other countries.

UFST™ MicroType® fonts by Monotype Imaging Inc. are installed in this machine.

This machine contains the software having modules developed by Independent JPEG Group.

iPad, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other countries.
AirPrint and the AirPrint logo are trademarks of Apple Inc.

iOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license by
Apple Inc.

Google and Google Cloud Print™ are trademarks and/or registered trademarks of Google Inc.
Mopria™ is registered trademarks of Mopria™ Alliance.

Wi-Fi and Wi-Fi Direct are trademarks and/or registered trademarks of Wi-Fi Alliance.

All other brands and product names are registered trademarks or trademarks of their respective companies. The
designations ™ and ® will not be used in this Operation Guide.
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GPL/LGPL

This product contains GPL (http://www.gnu.org/licenses/gpl.html) and/or LGPL (http://www.gnu.org/licenses/Igpl.html)
software as part of its firmware. You can get the source code, and you are permitted to copy, redistribute and modify it
under the terms of GPL/LGPL. For further information including availability of the source code, visit
http://www.kyoceradocumentsolutions.com/gpl/.

OpenSSL License
Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to endorse or promote products derived
from this software without prior written permission.
For written permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without
prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software
developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS I1S" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so
as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are adhered to. The
following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the
SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the
holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used.

This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the
package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:
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1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library being used are not cryptographic related :-).

4. If youinclude any Windows specific code (or a derivative thereof) from the apps directory (application code) you must
include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e.
this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

Monotype Imaging License Agreement

1 Software shall mean the digitally encoded, machine readable, scalable outline data as encoded in a special format as
well as the UFST Software.

2 You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and
versions of letters, numerals, characters and symbols (Typefaces) solely for your own customary business or
personal purposes at the address stated on the registration card you return to Monotype Imaging. Under the terms of
this License Agreement, you have the right to use the Fonts on up to three printers. If you need to have access to the
fonts on more than three printers, you need to acquire a multiuser license agreement which can be obtained from
Monotype Imaging. Monotype Imaging retains all rights, title and interest to the Software and Typefaces and no rights
are granted to you other than a License to use the Software on the terms expressly set forth in this Agreement.

3 To protect proprietary rights of Monotype Imaging, you agree to maintain the Software and other proprietary
information concerning the Typefaces in strict confidence and to establish reasonable procedures regulating access
to and use of the Software and Typefaces.

4 You agree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy. You
agree that any such copy shall contain the same proprietary notices as those appearing on the original.

5 This License shall continue until the last use of the Software and Typefaces, unless sooner terminated. This License
may be terminated by Monotype Imaging if you fail to comply with the terms of this License and such failure is not
remedied within thirty (30) days after notice from Monotype Imaging. When this License expires or is terminated, you
shall either return to Monotype Imaging or destroy all copies of the Software and Typefaces and documentation as
requested.

6 You agree that you will not modify, alter, disassemble, decrypt, reverse engineer or decompile the Software.

7 Monotype Imaging warrants that for ninety (90) days after delivery, the Software will perform in accordance with
Monotype Imaging-published specifications, and the diskette will be free from defects in material and workmanship.
Monotype Imaging does not warrant that the Software is free from all bugs, errors and omissions.

The parties agree that all other warranties, expressed or implied, including warranties of fithess for a particular
purpose and merchantability, are excluded.

8 Your exclusive remedy and the sole liability of Monotype Imaging in connection with the Software and Typefaces is
repair or replacement of defective parts, upon their return to Monotype Imaging.

In no event will Monotype Imaging be liable for lost profits, lost data, or any other incidental or consequential
damages, or any damages caused by abuse or misapplication of the Software and Typefaces.

9 Massachusetts U.S.A. law governs this Agreement.
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10 You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written
consent of Monotype Imaging.

11 Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical Data
and Computer Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c)(1)(ii), as appropriate.

Further use, duplication or disclosure is subject to restrictions applicable to restricted rights software as set forth in
FAR 52.227-19 (c)(2).

12 You acknowledge that you have read this Agreement, understand it, and agree to be bound by its terms and
conditions. Neither party shall be bound by any statement or representation not contained in this Agreement. No
change in this Agreement is effective unless written and signed by properly authorized representatives of each party.
By opening this diskette package, you agree to accept the terms and conditions of this Agreement.
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Energy Saving Control Function

The device comes equipped with a Sleep where printer functions remain in a waiting state but power consumption is
reduced to a minimum after a certain amount of time elapses since the device was last used.

Sleep

The device automatically enters Sleep when 1 minute has passed since the device was last used. The amount of time of
no activity that must pass before Sleep is activated may be lengthened.

® Sleep and Auto Sleep (page 2-27)

Automatic 2-Sided Print Function

This device includes 2-sided printing as a standard function. For example, by printing two 1-sided originals onto a single
sheet of paper as a 2-sided print, it is possible to lower the amount of paper used.

Printing in duplex mode reduces paper consumption and contributes to the conservation of forest resources. Duplex
mode also reduces the amount of paper that must be purchased, and thereby reduces cost. It is recommended that
machines capable of duplex printing be set to use duplex mode by default.

Resource Saving - Paper

For the preservation and sustainable use of forest resources, it is recommended that recycled as well as virgin paper

certified under environmental stewardship initiatives or carrying recognised ecolabels, which meet EN 12281 :2002” or
an equivalent quality standard, be used.

This machine also supports printing on 64 g/m2 paper. Using such paper containing less raw materials can lead to
further saving of forest resources.

*: EN12281:2002 "Printing and business paper - Requirements for copy paper for dry toner imaging processes"

Your sales or service representative can provide information about recommended paper types.

Environmental benefits of "Power Management”™

To reduce power consumption when idle, this machine is equipped with a power management function that
automatically activates energy-saving mode when the machine is idle for a certain period of time.

Although it takes the machine a slight amount of time to return to READY mode when in energy-saving mode, a
significant reduction in energy consumption is possible. It is recommended that the machine be used with the activation
time for energy-saving mode set to the default setting.
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Energy Star (ENERGY STAR®) Program

We have determined as a participating company in the International Energy Star Program that this
product is compliant with the standards laid out in the International Energy Star Program.

ENERGY STAR®is a voluntary energy efficiency program with the goal of developing and promoting the
use of products with high energy efficiency in order to help prevent global warming. By purchasing

AN eAS\: ENERGY STAR® qualified products, customers can help reduce emissions of greenhouse gases during
product use and cut energy-related costs.
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Installing and Setting
up the Machine

This chapter provides information for the administrator of this machine, such as part names, cable connection, and
software installation.
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Connectors/Interior ........ccccoevuveveuneenn. 2-3
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Part Names

Machine Exterior

Top Tray 6 USB Memory Slot
Paper Stopper 7 Operation Panel
Cassette 1 8 Handles

Power Switch 9 Rear Cover 1

a A WO N -

Handles 10 Anti-theft Lock Slot
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Connectors/Interior

11

AW N =

5
USB Port 7 Paper Length Guide
USB Interface Connector 8 Paper Width Guides
Network Interface Connector 9 Multi Purpose Tray
Option Interface 10 Paper Width Guides
Feed Cover 11 Fuser Cover

D O~ W N -

Size Dial
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12
13
14
15
16

17
18

12 Toner Container (Black) 16 Toner Container Lock Lever

13 Toner Container (Magenta) 17 Waste Toner Cover

14 Toner Container (Cyan) 18 Waste Toner Box

15 Toner Container (Yellow)
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With Optional Equipments Attached

1 Cassette 2 4 Rear Cover 2
2 Cassette 3 5 Rear Cover 3
3 Cassette 4 6 Rear Cover 4

® Optional Equipment (page 10-2)
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Installing and Setting up the Machine > Connecting the Machine and Other Devices

Connecting the Machine and Other Devices

Prepare the cables necessary to suit the environment and purpose of the machine use.

When Connecting the Machine to the PC via USB

@ USB

When Connecting the Machine to the PC or Tablet by network cable, Wi-Fi, or Wi-Fi direct

Network cable
connection
1
Wi-Fi
connection’!
1
Wi-Fi access point
Wi-Fi Direct
Tablet L
ave .'“ connection’!
1

*1  Only for models with Wi-Fi.

NOTE

If you are using wireless LAN, refer to the following.

® Confiquring the Wireless Network (page 2-18)

Cables that Can Be Used

Connection Environment Function Necessary Cable
Connect a LAN cable to the Printer LAN cable (10BASE-T, 100BASE-TX,
machine. 1000BASE-T)

Connect a USB cable to the Printer USB 2.0 compatible cable (Hi-Speed USB
machine. compliant, max. 5.0 m, shielded)

(&) IMPORTANT
Using a cable other than a USB 2.0 compatible cable may cause failure.
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Connecting Cables

Connecting LAN Cable

@ IMPORTANT
If the power is on, turn the power switch off.

% Power Off (page 2-9)

1 Connect the cable to the machine.

1 Connect the LAN cable to the network interface connector.

( A

)

2 Connect the other end of the cable to the hub.

2 Power on the machine and configure the network.
® Network Setup (page 2-16)
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Connecting USB Cable

@ IMPORTANT
If the power is on, turn the power switch off.

% Power Off (page 2-9)

1 Connect the cable to the machine.

1 Connect the USB cable to the USB interface connector located on the left side of the body.

e A

2 Connect the other end of the cable to the PC.

2 Power on the machine.

Connecting the Power Cable

1 Connect the cable to the machine.

Connect one end of the supplied power cable to the machine and the other end to a power
outlet.

(@) IMPORTANT
Only use the power cable that comes with the machine.
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Power On/Off

Power On

1 Turn the power switch on.

Power Off

1 Turn the power switch off.

It takes about 3 minutes for power off.
In case of not using the machine for an extended period of time...

A\ caution

If this machine will be left unused for an extended period (e.g. overnight), turn it off at the main power switch.
If the machine will not be used for an even longer period of time (e.g. vacation), remove the power plug from
the outlet as a safety precaution.

(&) IMPORTANT
Remove paper from the cassettes and seal it in the paper storage bag to protect it from humidity.
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Using the Operation Panel

Operation Panel Keys

Menu

Displays the Menu screen.

* Increments or decrements
numbers, or selects menu
in the message display.

* When a specific error
occurs, select the [ @]
key to show the Help
screen.

Finalizes a function or menu,
and numbers that have been
entered.

Clears a specific error, and
wakes the machine from the
sleep state.

Menu

¥ Logout

(OReady ( EnergySaver ! Attention

Message display:

Displays the setting menu
and error messages.

9 Logout

Exits the operation for the
current user (i.e. log out).

Cancel a printing job.

Cancel

O Ready Lights up in the print ready state.
an Blinks during print processing or when an error occurs.
(Energy Saver | Lights up when the machine is in energy save mode.
(]
1 Attention Lights or blinks when an error occurs and a job is stopped.
(]




Installing and Setting up the Machine > Using the Operation Panel

Operation Method

This section explains how to operate the setting menus on the message display.

Displaying the Menus and Configuring Settings

Select the [Menu] key to display the setting menus. Select the [A] key, [ V] key, [ 4] key, [»] key, or [OK] key to select a
menu, and perform settings.

$an Logout

Menu  geject the [Menu] key to display

the setting menus.
Normal Screen

Setting Menus

Report Print >

Report Print >

Menu $an Logout Menu $an Logout

When the [A] or [ V] key is selected,
the selection moves line by line.

Cancel

V)

Cancel

(V)

Exiting the menu operation

Select the [Menu] key to exit the setting
Qnenu and return to the normal screen. )

When [>] appears, select the [»]
key to display a sub-menu. When the [A] or [ V] key is
selected, the selection
moves line by line.

Paper Settings q1 SMP Tray Size >Type Adjust >
24 CUsTOM 1

$an Logout Menu i Logout Menu $an Logout Menu $an Logout

A G

- OK »
v Cancel
V)

Select the [«] key to return to the Select the [OK] key to confirm
screen one level higher. the selected setting.



Installing and Setting up the Machine > Using the Operation Panel

Selecting a Menu

The setting menu is hierarchical. Select the [A] or [ V] key to display the desired menu.

» If the selected menu has a sub-menu, ">" is displayed after the menu. , .l
Paper Settings

Indicates that there is a sub-menu

+ ">"is displayed before the sub-menu. Indicates that this is the sub-menu
When there is a another sub-menu, ">" appears after the sub-menu name. , =
To move down a level to that sub-menu, select the [»] key. To move back up >type Adjust 74
to the next higher level, select the [«] key. CUSTOM 1 !

Indicates that there is another sub-menu

Il>>ll H H - )
is displayed before the second sub-menu {S>Paper Weignt

1 Normal 1

I
Indicates that this is the second sub-ment

Setting a Menu

Select the desired menu and then select the [OK] key. In the menu, select the desired item with the [A] or [ V] key, and
select the [OK] key. "?" will blink to the right of the selected item. Select the [OK] key to finalize the setting.

Cancelling Menu Selection

If you select the [Menu] key when a menu is selected, the message display returns to "Ready".

NOTE

Settings in an application or printer driver are given priority over operation panel settings.

Help Screen

If you have difficulty operating the machine, you can check how to operate it using the operation panel.

When "Press B key" is displayed on the message display, select the [B] key to display the Help screen. The Help
screen shows machine operation.

-—--—- HELP START ---- Open Cassette 1
Press i key Vand remove

Select the [ V] key to display the next step or select the [ A] key to display the previous step.

Select the [A] key to exit the Help screen.
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Login/Logout

If you are setting a function that requires administrator rights, you must enter your administrator ID and administrator
password.

[ NOTE

The factory default administrator ID and administrator password are set as shown below.
Administrator ID: 3000

Administrator Password: 3000

Login

1 Enter the administrator ID.

If the administrator login screen appears while you a using the machine, enter the
administrator ID and select the [OK] key.

NOTE
Enter an ID consisting of between 1 and 16 numbers.

Select the [A] or [ V] key to enter a number.
Select the [«] or [»] key to move the cursor left or right.

2 Enter the administrator password.

Enter the administrator password and select [OK] key.

NOTE
Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

3 Select the [OK] key.

Logout

Select the [Menu] key to exit the setting menu screen and log out. You will return to the normal
screen.

Users are automatically logged out in the following circumstances:
*  When the machine enters the sleep state.

*  When the auto panel reset function is activated.
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Default Settings of the Machine

Before using this machine, configure such settings as date and time, network configuration, and energy saving functions
as needed.

NOTE
The default settings of the machine can be changed in System Menu.
For settings that are configurable from System Menu, refer to the following:

® Setup and Registration (System Menu) (page 7-1)

Setting Date and Time

Follow the steps below to set the local date and time at the place of installation.
Set the date, time and time difference from GMT of the region where the machine is used.

[ NOTE

» The factory default administrator ID and administrator password are set as shown below.
Administrator ID: 3000
Administrator Password: 3000

» Be sure to set the time difference before setting the date and time.

» The correct time can be periodically set by obtaining the time from the network time server.

% Command Center RX User Guide

1 Display the screen.

1 [Menu] key >[A][V] key > [Device Common] > [»] key > [A] [ V] key > [Date Setting] >
[»>] key

2 Enter the administrator ID and select the [OK] key.

NOTE
Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

3 Enter the administrator password and select the [OK] key.

NOTE
» Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

* If you enter the incorrect administrator ID or password, the message "Wrong ID" or
"Wrong Password" appears and the input screen then reappears. Re-enter the ID or
password correctly.
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2 Configure the settings.

[A][V]key > [Time Zone] > [OK] key > Select the time zone > [OK] key > [A] [V ] key >
[Date (Year/Mon/Day)] > [OK] key > Set the date > [OK] key > [A] [ V] key >

[Time (Hour:Min:Sec)] > Set the time > [OK] key > [A] [ V] key > [Date Format] > [OK] key >
Select the Date Format > [OK] key

Item Description

Time Zone Set the time difference from GMT. Choose the nearest listed location from
the list. If you select a region that utilizes summer time, configure settings
for summer time.

Date (Year/Mon/Day) Set the date for the location where you use the machine.
Value: Year (2000 to 2037), Month (1 to 12), Day (1 to 31)

Time (Hour:Min:Sec) Set the time for the location where you use the machine.
Value: Hour (00 to 23), Minute (00 to 59), Second (00 to 59)

Date Format Select the display format of year, month, and date. The year is displayed
in Western notation.

Value: Month/Day/Year, Day/Month/Year, Year/Month/Day
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Network Setup

Configuring the Wired Network

The machine is equipped with network interface, which is compatible with network protocols such as TCP/IP (IPv4),
TCP/IP (IPv6), NetBEUI, and IPSec. It enables network printing on the Windows, Macintosh, UNIX and other platforms.

Set up TCP/IP (IPv4) to connect to the Windows network.

Be sure to connect the network cable before configuring the settings.

® Connecting LAN Cable (page 2-7)

For other network settings, refer to the following:

» Network Settings (page 7-14)

IPv4 setting

1 Display the screen.
[Menu] key > [A] [¥] key > [Wired Network] > [»>] key > [A] [¥] key > [TCP/IP] > [OK] key

2 Configure the settings.
1 [A][V]key > [On] > [OK] key
Select [>] key while "TCP/IP On" is displayed.
[A][V] key > [DHCP] > [OK] key > [A] [¥] key > [Off] > [OK] key

[A][V]key > [IP Address] > [OK] key

a A WO DN

Set the IP address.

[ NOTE

You can set any value between 000 and 255.
Select the [A] or [ V] key to enter a number.
Select the [ 4] or [»] key to move the cursor left or right.

6 Select the [OK] key.
7 [A][V]key > [Subnet Mask] > [OK] key

8 Set the subnet mask.

NOTE

You can set any value between 000 and 255.

Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

9 Select the [OK] key.

10[A] [V ] key > [Default Gateway] > [OK] key
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11 Set the default gateway.

[ NOTE

You can set any value between 000 and 255.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

12Select the [OK] key.
13[A][V] key > [Auto-IP] > [OK] key
14[0ff] > [OK] key

@ IMPORTANT

After changing the setting, restart the network from System Menu, or turn the
machine OFF and then ON.

® Restart Printer (page 7-4)

NOTE

Ask your network administrator for the IP address in advance, and have it ready when you
configure this setting.
In the following cases, set the IP address of DNS server on the Command Center RX.

* When using the host name with "DHCP" setting set to "Off"
* When using the DNS server with IP address that is not assigned by DHCP automatically.
Setting the IP Address of the DNS Server, refer to the following:

#® Command Center RX User Guide
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Configuring the Wireless Network

When the Wireless Network Interface Kit (IB-36 and I1B-51) is installed on the machine and the connection settings are
configured, it is possible to print or send in a wireless network (wireless LAN) environment.

P Wireless Network Interface Kit (IB-36) (page 10-5)
IB-51 "Wireless Network Interface Kit" (page 10-3)

The configuration methods are as follows:

Configuration Method Description Reference Page

Configuring the Connection Use Wi-Fi Settings or Wireless Network to configure the Wi-Fi Settings (page 7-11)

from the Operation Panel on network in details from System menu.

This Machine

Setting the Connection by This is the tool included in the Product Library. You can Setting the Connection by Using

Using the Wi-Fi Setup Tool configure the connection according to the instructions the Wi-Fi Setup Tool (page 2-18)
provided by the wizard.

Configuring Connections on The connection can be set from the Command Center RX. | Command Center RX User

the Web Page Guide
For the IB-51, the connection can be set on the IB-51 Operation Guide
dedicated Web page.

Setting the Connection by | This is the setup tool included in the CD of IB-51. You | IB-51 Operation Guide
Using the Setup Utility of can use it on both Windows and Mac OS.
IB-51

NOTE

When you want to switch to the network interface other than Wired (default) after installing an optional Network
Interface Kit (IB-50) and a Wireless Network Interface Kit (IB-36 or IB-51), select the desired setting on
"Communication".

& Communication (page 7-14)

Setting the Connection by Using the Wi-Fi Setup Tool

To send the Wi-Fi settings configured in the Wi-Fi Setup Tool to the machine, connect the computer or handheld device
with the machine locally. The connection methods are wired connection via LAN cable and wireless LAN connection (Wi-
Fi Direct).

NOTE
» Before using the Wi-Fi Setup Tool, connect your computer to this machine locally with wired LAN cable or Wi-Fi
Direct.

» To use Wi-Fi Direct, confirm that the Wi-Fi Direct is enabled (Wi-Fi Direct is set to [On]) and Restart Network from
the operation panel, before your computer will be connected to this machine with Wi-Fi Direct.

» To use a wired LAN cable directly connected to the machine, the Auto-IP (Link-local) address will be assigned to the
machine and the computer. This machine applies Auto-IP as the default settings.

» Configure the settings on the operation panel if your computer supports WPS.
P Wi-Fi Settings (page 7-11)

Wired Connection by Using LAN Cable

1 Connect the machine with a computer

1 Connect the machine with a computer via LAN cable when the machine is powered on.
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2 Turn on the computer.
IP address (link local address) of the machine and computer is generated automatically.

2 Insert the DVD.

NOTE

+ |nstallation on Windows must be done by a user logged on with administrator privileges.

« If the "Welcome to the Found New Hardware Wizard" dialog box displays, select [Cancel].
« If the autorun screen is displayed, click [Run setup.exe].

« If the user account management window appears, click [Yes].

3 Display the screen.

1 Click [View License Agreement]
and read the License Agreement.

2 Click [Accept].

Notice
By using or installing the device drivers and software included in this

package, you agree to become bound by the terms and conditions of
this license agreement.

1

View License Agreement Exit
4 Select [Maintenance].
5 [Wi-Fi Setup Tool] > [OK]
o e - |
iy ocrans
1
2

6 Configure the settings.
1 [Do not use automatic configuration] > [Next] > [Next]

2 [Use LAN cable] > [Next] > [Next]
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3 [Easy setup] > [Next]

The machine is detected.

NOTE

* Only one machine can be searched using Wi-Fi Setup Tool. It may take times to search
the machine.

« If the machine is not detected, select [Advanced setup] > [Next]. Select [Express] or
[Custom] as device discovery method and specify the IP address or host name to
search the machine.

4 Select the machine > [Next]

5 Select [Use the device settings.] on [Authentication mode], and enter the login user

name and password. Login user name and Password are both Admin.

6 Configure the communication settings > [Next]

7 Change the settings of access point as necessary > [Next]

The network is configured.

Wireless LAN Connection by Using Wi-Fi Direct

1 Display the screen.

1 [Menu] key > [A] [ V] key > [Wi-Fi Direct Set] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.

4

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

[A][V] key > [Wi-Fi Direct] > [OK] key
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2

3

Configure the settings.
[A][V] key > [On] > [OK] key

Restart the network.

[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»>] key > [A] [ Y] key > [Restart Network] >
[OK] key > [OK] key

Connect a computer or a handheld device with the machine.
= Setting Wi-Fi Direct (page 2-23)

Insert the DVD.

NOTE

+ Installation on Windows must be done by a user logged on with administrator privileges.

« If the "Welcome to the Found New Hardware Wizard" dialog box displays, select [Cancel].
+ If the autorun screen is displayed, click [Run setup.exe].

« If the user account management window appears, click [Yes].

Display the screen.

1 Click [View License Agreement]
e and read the License Agreement.
By using or installing the device drivers and software included in this 2 CIiCk [Accept]
package, you agree to become bound by the terms and conditions of
this license agreement.

View License Agreement Exit

Select [Maintenance].

[Wi-Fi Setup Tool] > [OK]
o _oEHE

4 Waintenance
'S Run utility programs.

Selecta tool from the list and click Run.
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9

Configure the settings.

1

2

[Do not use automatic configuration] > [Next] > [Next]
[Wi-Fi Direct] > [Next] > [Next]

[Advanced setup] > [Next]

Select [Express] or [Custom] as device discovery method and specify the IP address or
host name to search the machine.

Select the machine > [Next]

Select [Use the device settings.] on [Authentication mode], and enter the login user
name and password. Login user name and Password are both Admin.

Configure the communication settings > [Next]

Change the settings of access point as necessary > [Next]

The network is configured.
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Setting Wi-Fi Direct

You can install the optional Wireless Network Interface Kit (IB-36) on the machine and configure the connection settings
to print in a Wi-Fi Direct environment. The configuration methods are as follows:

Configuring the Connection from the Operation Panel on This Machine

Connecting to Computers or Handheld Devices that Support Wi-Fi Direct

1 Display the screen.
1 [Menu] key > [A] [ V] key > [Wi-Fi Direct Set] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

4 [A][V]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V¥]key > [On] > [OK] key

3 Restart the network.

[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»] key > [A] [ V] key > [Restart Network] >
[OK] key > [OK] key

4 Specify the machine name from the computer or handheld
device.

If a confirmation message appears on the operation panel of the machine, select [Yes].

The network between this machine and the handheld device is configured.
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Connecting to Computers or Handheld Devices Unsupported Wi-Fi Direct

Here, we'll explain the procedures for connecting to iOS handheld devices.

1 Display the screen.
1 [Menu] key > [A] [ V] key > [Wi-Fi Direct Set] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.
NOTE
Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.
Select the [ 4] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

4 [A][V]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V¥]key > [On] > [OK] key

3 Restart the network.
[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»] key > [A] [ Y] key > [Restart Network] >
[OK] key > [OK] key

4 [Menu] key > [A] [ V] key > [Wi-Fi Direct Set] > [»>] key

Note the network name (SSID), IP address, and password.

8

6 Configure the handheld device.
1 [Settings] > [Wi-Fi]
2 Select the network name (SSID) appeared in step 5 from the list.

3 Enter the password that was provided in step 5 > [Connect]

The network between this machine and the handheld device is configured.
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Configuring the Connection by Using Push Button
When your computer or handheld device does not support Wi-Fi Direct but supports WPS, you can configure the

network using push button.

1 Display the screen.
1 [Menu] key > [A] [ V] key > [Wi-Fi Direct Set] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

4 [A][V]key > [Wi-Fi Direct] > [OK] key

2 Configure the settings.
[A][V¥] key > [On] > [OK] key

3 Restart the network.
[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»>] key > [A] [ VY] key > [Restart Network] >
[OK] key > [OK] key

4 [Menu] key > [A] [ V] key > [Wi-Fi Direct] > [>] key > [A] [V] key
> [PushButton Setup] > [OK] key > [OK] key

5 Press the push button on the computer or handheld device and
select the [OK] key simultaneously.

The network between this machine and the computer or handheld device is configured.
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@ IMPORTANT

You can connect up to three handheld devices at the same time using Wi-Fi Direct setting. When the devices
that support Wi-Fi Direct are connected, if you want to connect other device, disconnect the already-
connected devices from the network. The disconnection methods are as follows:

* Disconnect the network from the computer or handheld computer
* Disconnecting all devices from the network on the operation panel
Select [Menu] key > [A] [ V] key > [Wi-Fi Direct] > [»>] key > [A] [ V] key > [Disconnect All] > [OK] key >
[OK] key
* Configuring auto disconnecting time from the System menu
® Wi-Fi Direct Set (page 7-11)
» Configuring auto disconnecting time from the Command Center RX
® Command Center RX User Guide
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Energy Saver function

If a certain period of time elapses after the machine is last used, the machine automatically enters sleep mode, which
minimizes power consumption.

Sleep and Auto Sleep

Auto Sleep

Auto Sleep automatically switches the machine into Sleep if left idle for a preset time.

The default preset time is 1 minute.

To resume, perform the following actions.

» Select the [Go] key.

The machine will be ready to operate within 17 seconds.

Note that ambient environmental conditions, such as ventilation, may cause the machine to respond more slowly.

Follow the steps below to set the sleep timer for the machine to go into sleep mode when not in use.

1 Display the screen.
1 [Menu] key > [A] [¥] key > [Device Common] > [»] key > [A] [V] key > [Timer] > [»>] key
2 Enter the administrator ID and select the [OK] key.
NOTE
Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.
NOTE
Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.
Select the [ 4] or [»] key to move the cursor left or right.

The factory default settings for the administrator password is 3000.

4 [A][V]key > [Sleep Timer] > [OK] key

2 Set the Sleep time.

1 Enter the Sleep time.

NOTE
Select the [A] or [ V] key to enter a number.
Select the [ 4] or [»] key to move the cursor left or right.

2 Select the [OK] key.
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Sleep Level Set.

Card Reader, Application

You can set whether sleep mode operates for each function. When the machine enters sleep mode, the ID card cannot
be recognized.

For more information on Sleep Level Set., refer to the following:
3 Sleep Level Set. (page 7-22)

Sleep Level (Energy Saver and Quick Recovery) (models except for Europe)

For sleep level, you can toggle between the following two modes: Energy Saver mode and Quick Recovery mode. The
default setting is Energy Saver mode.

Energy Saver mode reduces power consumption even more than Quick Recovery mode, and allows Sleep Mode to be
set separately for each function. The ID card cannot be recognized.

NOTE

If the optional Network Interface Kit is installed, Energy Saver cannot be specified.

Follow the steps below to select the sleep level and use Energy Saver mode for each function.

1 Display the screen.

1 [Menu] key > [A] [V¥] key > [Device Common] > [»] key > [A] [¥] key >
[Sleep Level Set.] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

The factory default settings for the administrator password is 3000.

4 [A][VY]key > [Sleep Level] > [OK] key
2 Select the Sleep level.

[A][V] key > [Quick Recovery] or [Energy Saver] > [OK] key

When [Energy Saver] is set, next go on to set whether or not to use Energy Saver mode for
each function.
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3 Set the Sleep rule.
1 [A][V]key > [Network] or [Card Reader] > [OK] key

[Card Reader] is displayed when the optional Card Authentication Kit is activated.

2 [A][V]key > [Off] or [On] > [OK] key

Power Off Rule (models for Europe)

The Power Off Rule is used to stop the power from automatically turning off.

The default preset time is 3 days.
For more information on Power Off Rule settings, refer to the following:

® Power Off Rule (models for Europe) (page 7-22)
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Installing Software

Install appropriate software on your PC from the included DVD (Product Library) if you want to use the printer function of
this machine.

Software on DVD (Windows)

You can use either [Express Install] or [Custom Install] can be selected for the installation method. [Express Install] is
the standard installation method. To install components that cannot be installed by [Express Install], use [Custom Install].

For details on Custom Installation, refer to the following:
® Custom Install (page 2-33)

Software Description 2T
Install

KX DRIVER This driver enables files on a computer to be printed by the machine. O
Multiple page description languages (PCL XL, KPDL, etc.) are supported by
a single driver. This printer driver allows you to take full advantage of the
features of the machine.
Use this driver to create PDF files.

KX XPS DRIVER This printer driver supports the XPS (XML Paper Specification) format -
developed by Microsoft Corporation.

KPDL mini-driver/PCL mini- This is a Microsoft MiniDriver that supports PCL and KPDL. There are some -

driver restrictions on the machine features and option features that can be used
with this driver.

KYOCERA Net Viewer This is a utility that enables monitoring of the machine on the network. -

Status Monitor This is a utility that monitors the printer status and provides an ongoing O
reporting function.

KYOCERA Net Direct Print This makes it possible to print a PDF file without starting Adobe Acrobat/ -
Reader.

FONTS These are display fonts that enable the machine's built-in fonts to be used in O
a software application.

NOTE

Installation on Windows must be done by a user logged on with administrator privileges.
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Installing Software in Windows

Express Install
The following procedure is an example for installing the software in Windows 8.1 using [Express Install].

For details on Custom Installation, refer to the following:

® Custom Install (page 2-33)

1 Insert the DVD.

NOTE

+ Installation on Windows must be done by a user logged on with administrator privileges.

* If the "Welcome to the Found New Hardware Wizard" dialog box displays, select
[Cancel].

« If the autorun screen is displayed, click [Run setup.exe].

« If the user account management window appears, click [Yes].

2 Display the screen.

1 Click [View License Agreement]
and read the License Agreement.

2 Click [Accept].

Notice
By using or installing the device drivers and software included in this

package, you agree to become bound by the terms and conditions of
this license agreement.

1

View License Agreement

3 Select [Express Install].
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4

Install the software.

o - o
§ Express Install
Emm Add single device and its default drivers

" =)

@Y, Communication settin o | C

3
- =

You can also select [Use host name for port name] and set to use the host name of the
standard TCP/IP port. (A USB connection cannot be used.)

When you click [Install], a screen asking for your cooperation with data collection will be
displayed. Select one of the answer choices and click [OK].

@ IMPORTANT

If Wi-Fi or Wi-Fi Direct is enabled, be sure to specify the IP address for the port name.
Installation may fail if the host name is specified.

NOTE

» The machine cannot be detected unless it is on. If the computer fails to detect the

machine, verify that it is connected to the computer via a network or USB cable and that it
is turned on and click (_ (Reload).

« If the Windows security window appears, click [Install this driver software anyway].

* To install Status Monitor on Windows versions preceding Windows 8, it is necessary to
install Microsoft .NET Framework 4.0 beforehand.

CI—— =)

Setup has detected that the following prerequisites have not
been met.

@ Microsoft NET Framework 4.0

www.microsoft.com
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5 Finish the installation.

®
Finished
Your software is ready to use.
Product Detai
# KX DRIVER Installed...
# Kyocera TWAIN Driver Installed
# Status Monitor § Installed
# FOMTS Installed
< Uninstaller Installed

[ [“]4Gk Print a test page
[ [0 Enable event notification
@ (]G Show Quick Print tab

| Einish '

When "Your software is ready to use" appears, you can use the software. To print a test
page, click the "Print a test page" checkbox and select the machine.

Click [Finish] to exit the wizard.

If a system restart message appears, restart the computer by following the screen prompts.
This completes the printer driver installation procedure.

Custom Install

The following procedure is an example for installing the software in Windows 8.1 using [Custom Install].

1 Insert the DVD.

NOTE
+ Installation on Windows must be done by a user logged on with administrator privileges.

* If the "Welcome to the Found New Hardware Wizard" dialog box displays, select
[Cancel].

« If the autorun screen is displayed, click [Run setup.exe].
+ If the user account management window appears, click [Yes].

2 Display the screen.

1 Click [View License Agreement]
and read the License Agreement.

2 Click [Accept].

Notice

By using or installing the device drivers and software included in this
package, you agree to become bound by the terms and conditions of
this license agreement.

1

View License Agreement

3 Select [Custom Install].
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4 Install the software.

1 Select the device to be installed.

o - oIEl

J Custom Install Products to Install
SEE Add multiple devices and printing utilities

nnnnnnnnnnn

¥

@ IMPORTANT

If Wi-Fi or Wi-Fi Direct is enabled, be sure to specify the IP address for the port
name. Installation may fail if the host name is specified.

NOTE

» The machine cannot be detected unless it is on. If the computer fails to detect the
machine, verify that it is connected to the computer via a network or USB cable and
that it is turned on and click ' (Reload).

« If the desired device does not appear, select [Add custom device] to directly select
the device.

2 Select the driver to be installed.

o - oIEl

J Custom Install
SEE Add multiple devices and printing utilities

Back Install Exit
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3 Click [Utility] tab and select the utility to be installed.

o ooy = &
J Custom Install Products o nstal
=B Add multiple devices and printing utilities ..
1 Edit Delete
iz ) omves
utites cat Deiete
KIOCERA Netviewer

2 3

Zitems [&
Back Install Exit
o - =
e @ ErmrrT
Sm Add multiple devices and printing utilities
o women
Il
_
=
File Management Utility les X EdIEADelets,
T T
FONTS. Screen fonts that match the printer's fonts Delete

3 utities

When you click [Install], a screen asking for your cooperation with data collection will be
displayed. Select one of the answer choices and click [OK].

[ NOTE

To install Status Monitor on Windows versions preceding Windows 8, it is necessary to
install Microsoft .NET Framework 4.0 beforehand.

e~ -— - (=23

Setup has detected that the following prerequisites have not
been met.

@ Microsoft NET Framework 4.0

www.microsoft.com
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5 Finish the installation.

© [ p—
Finished
Your software is ready to use.
Product Detai
" KX DRIVER Installed...
" KYOCERA Net Viewer Installed
" KYOCERA Net Direct Print Installed
+ Uninstaller Installed

[C]4G# Print a test page
B Enable event notification
[#]4 Show Quick Print tab

l Einish '

When "Your software is ready to use" appears, you can use the software. To print a test
page, click the "Print a test page" checkbox and select the machine.

Click [Finish] to exit the wizard.

If a system restart message appears, restart the computer by following the screen prompts.
This completes the printer driver installation procedure.
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Uninstalling the Software

Perform the following procedure to delete the Software from your computer.

NOTE

Uninstallation on Windows must be done by a user logged on with administrator privileges.

1 Display the screen.

Click [Search] in charms, and enter "Uninstall Kyocera Product Library" in the search box.
Select [Uninstall Kyocera Product Library] in the search list.

NOTE

In Windows 7, click [Start] button on the Windows and then select [All Programs],
[Kyocera], and [Uninstall Kyocera Product Library] to display the Uninstall Wizard.

2 Uninstall the software.

Place a check in the check box of the software to be deleted.

= - =
£} KYOCERT

Welcome to the Software Remove Wizard

Please close al your applications before contining

/& This wizard helps vou remove software for your prirting system
L\
Select Al

-7 o I

= D 1
S

FEEEEEEE
LEY | | | ]

3 Finish uninstalling.

If a system restart message appears, restart the computer by following the screen prompts.
This completes the software uninstallation procedure.

NOTE
» The software can also be uninstalled using the Product Library.

« In the Product Library screen, click [Uninstall], and follow the on-screen instructions to
uninstall the software.
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Installing Software in Mac Computer

The machine's printer functionality can be used by a Mac computer.

NOTE

* Installation on MAC OS must be done by a user logged on with administrator privileges.
» When printing from a Macintosh computer, set the machine's emulation to [KPDL] or [KPDL(Auto)].

® Print Settings (page 7-9)
« If connecting by Bonjour, enable Bonjour in the machine's network settings.

® Bonjour (page 7-14)
* In the Authenticate screen, enter the name and password used to log in to the operating system.

* When printing via AirPrint, you do not have to install the software.

1 Insert the DVD.

Double-click the [Kyocera] icon.

2 Display the screen.

P 006 4
a e M-owlzlzlle [(elF] @
oS
e | Kyocera OS X 10.5+ build Kyocera 05X 10.5+ PDL Setup
[ panese o
S —

All Tags.

Double-click [Kyocera OS X x.x] depending on your Mac OS version.

3 Install the Printer Driver.

800 -

O} KYOCERA

e

Welcome to the Kyocera Macintosh Installer

You will be guided through the steps necessary to
install this software.

Install the printer driver as directed by the instructions in the installation software.
This completes the printer driver installation.

If a USB connection is used, the machine is automatically recognized and connected.
If an IP connection is used, the settings below are required.
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4 Configure the printer.

1 Open System Preferences and add the printer.

0 0o 0 0o
<o) [Srowal <o) [Sowal a
[ e W Printers.
: = . -
General Desktop & Dock Mission Language Security Spotlight  Notifications. —
Screen Saver Control  &Region & Privacy (" Open Print Queue... |

[_Options & Supplies... |

] = | A

CDs&DVDs  Displays Energy Trackpad l§  Printers & Sound Kinct
Saver Scanners Grams b

[ Share this printer on the network | Shari

E
—-—

iCloud Intenet  Network  Bluetooth  Sharing

H
:
gwv

Default printer: [ Last Printer Used ]

@ Default paper size: | A4 ] @

Users&  Parental  AppStore  Dictation Date&Time  Startup Time  Accessibility
Groups  Controls & Speech Disk Machine

®

4 ® @ ¢ g @

L] =N

2 Select [Default] and click the item that appears in "Name" and then select the driver in

NOTE
When using an IP connection, click the IP icon for an IP connection and then enter the
host name or IP address. The number entered in "Address" will automatically appear in

"Name". Change if needed.

3 Select the options available for the machine.

oo0e

Defutt| Fa P Windows searen

i Setting up [
i

i Make sure your printer’ options are accurately shown here 50 you

i

X ——=

) 2

[ Add |

4 The selected machine is added.

0 0o

<[ > ] [ ShowAll Q

— — ——

[ Open Print Queve... |

[_Options & Supplies... |

(] Share this printer on the network [ Sharing Preferences

Default printer: [ Last Printer Used ]

Default paper size: | A4 ] @

2-39



Installing and Setting up the Machine > Checking the Counter

Checking the Counter

Check the number of sheets printed.

1 Display the screen.
[Menu] key > [A][V¥] key > [Counter] > [ ]key

2 Check the counter.

Select the item you want to check.
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Additional Preparations for the Administrator

In addition to the information provided in this chapter, the administrator of this machine should check the following, and
configure the settings as needed.

Strengthening the Security

One user with administrator rights has been pre-registered in the machine. Logging in as this user will allow you to
configure all settings; therefore, please change the login user name and password.

In addition, this machine is equipped with user authentication function, which can be configured to limit the access to this
machine to only those who have a registered login name and password.

® User Authentication and Accounting (User Login, Job Accounting) (page 8-1)

| want to... Function Reference page
Restrict the users of the machine. Auto Panel Reset page 7-23
Prevent another user from handling the Custom Box page 5-5
documents stored in the machine.
Prevent the data stored in the machine from Data Overwrite 2 Refer to the Data
being leaked. — Security Kit (E)
Encryption Operation Guide.
Completely delete the data on the machine DataSanitization page 7-27
before disposing of the machine.
Protect the transmission from interception and | IPP over SSL page 7-15
wiretapping.
HTTPS page 7-16
SMTP Security Command
Center RX User
Guide
POP3 Security Command
Center RX User
Guide
IPSec page 7-18
SNMPv3 page 7-14

*1 The optional SSD is required.
*2 The optional Data Security Kit is required.
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Command Center RX

If the machine is connected to the network, you can configure various settings using Command Center RX.

This section explains how to access Command Center RX, and how to change security settings and the host name.

% Command Center RX User Guide

[ NOTE

To fully access the features of the Command Center RX pages, enter the User Name and Password and click [Login].
Entering the predefined administrator password allows the user to access all pages, including Document Box. The
factory default setting for the default user with administrator privileges is shown below. (Upper case and lower case
letters are distinguished (case sensitive).)

Login User Name: Admin
Login Password: Admin

Settings that the administrator and general users can configure in Command Center RX are as follows.

Administ- General

Setting Description

rator User
Device The machine's structure can be checked. O O
Information
Job Status Displays all device information, including print jobs, and job log history. O O
Document Box Add or delete document boxes, or delete documents within a document box. O 0*1
Device Settings Configure the advanced settings of the machine. O -
Function Settings | Configure the advanced function settings. O -
Network Settings | Configure the network advanced settings. O -
Security Settings | Configure the security advanced settings. O -
Management Configure the advanced management settings. O -
Settings

*1 The logged in user may not be able to configure some settings, depending on the permissions of the user.
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Accessing Command Center RX

1 Display the screen.

1 Launch your Web browser.

2 In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.
[Menu] key > [A][V] key > [Report Print] > [»] key > [A] [ VY] key > [Print Status Page] >
[OK] key > [OK] key

Examples: https://192.168.48.21/ (for IP address)
https://MFP001 (if the host name is "MFP001")

S [EEE AT |o- ¢ || @ 1921684821 | |

Model :

- cnmma"d cEntEr E Host Name -

Location :

English v [ |Auto-refresh Last Updated @

Admin Login

0 User Name i Status
=

Password i @  Sleeping...

@  Sleeping...

Type Capacity Status

—
|, Pin 250 |ﬁ| Paper Loaded
1 .

The web page displays basic information about the machine and Command Center RX as well
as their current status.

NOTE
If the screen "There is a problem with this website's security certificate." is displayed,
configure the certificate.

# Command Center RX User Guide
You can also continue the operation without configuring the certificate.

2 Configure the function.

Select a category from the navigation bar on the left of the screen.

NOTE

To fully access the features of the Command Center RX pages, enter the User Name and
Password and click [Login]. Entering the predefined administrator password allows the user
to access all pages, including Document Box. The factory default setting for the default user
with administrator privileges is shown below. (Upper case and lower case letters are
distinguished (case sensitive).)

Login User Name: Admin
Login Password: Admin
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Changing Security Settings

1

Display the screen.

1

2

Launch your Web browser.

In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.

[Menu] key > [A][V] key > [Report Print] > [»] key > [A] [ VY] key > [Print Status Page] >
[OK] key > [OK] key

Log in with administrator privileges.

Admin Login

0 User Name
Adrmin
Password
LLLLLJ

The factory default setting for the default user with administrator privileges is shown below. (Upper
case and lower case letters are distinguished (case sensitive).)

Login User Name: Admin
Login Password: Admin

Click [Security Settings].
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2

Configure the Security Settings.

From the [Security Settings] menu, select the setting you want to configure.

Home @ ‘ Security Settings : Device Security ‘ Last Updated: @
Q Admin
("]
Interface Block
? ) ) Network : Refer to this link. Protocol
Device Information >
USE Device : (") Block (®) Unblock
Job Status > i, .
p> USB Host : ()Block (®) Unblock
E5) Document Box > USB Storage (OBlock (® Unblock
=)
%De\ﬂ-w Settings > Lock Operation Panel
Operation Panel : |Un|0r.k hd
%Funcﬁon Settings >
Display Status/Log
@Nemork Settings >
Display Jobs Detail Status : |Shuw All hd ‘
| ] . . I
| Security Settings Display Jobs Log - [Show All v
Device Security
Metwork Security Submit | | Reset |
Certificates

NOTE

For details on settings related to certificates, refer to the following:

% Command Center RX User Guide
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Changing Device Information

1 Display the screen.

1 Launch your Web browser.

2 In the address or location bar, enter the machine's IP address or the host name.

Print the status page to check the machine's IP address and the host name.

[Menu] key > [A][V] key > [Report Print] > [»] key > [A] [ VY] key > [Print Status Page] >

[OK] key > [OK] key

3 Log in with administrator privileges.

Admin Login
0 User Name Device
S admin

Password %

.| R-%

The factory default setting for the default user with administrator privileges is shown below. (Upper
case and lower case letters are distinguished (case sensitive).)

Admin
Admin

Login User Name:
Login Password:

4 From the [Device Settings] menu, click [System].

m

Q Admin
("]

@ ‘ Device Settings : System

3 Device Information

Last Updated:

Host Name :

Device Information >

Asset Number :

Job Status > Location :

B>

[km3B410C

General
Lﬂ_ Document Box >
Language :

RAM Disk Mode

Paper/Feed/Qutput RAM Disk Size :

Energy Saver/Timer
Date/Time

2 ()
%Funcﬁon Settings >

%Nelwork Seftings >

Overide Ad/Letter ;

Altitude Adjustment :

Error Settings

Color Toner Empty Action :

MP Tray Empty :

A7
@on Oor

MB (1-32)

@®0n off

[Normal v

(@) Stop Printing

@ 0n

() Print in B&W

() Off
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2 Specify the host name.

Enter the device information, and then click [Submit].

(@) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

To restart the network interface card, click [Reset] in the [Management Settings]
menu, and then click [Restart Network] in "Restart".
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E-mail Settings

By configuring the SMTP settings, it is possible to send E-mail notices when jobs have been completed.

To use this function, this machine must be connected to a mail server using the SMTP protocol.

In addition, configure the following.

+ SMTP settings

Item: "SMTP Protocol" and "SMTP Server Name" in "SMTP"

* The sender address when the machine sends E-mails
Iltem: "Sender Address" in "E-mail Send Settings"

» The setting to limit the size of E-mails
ltem: "E-mail Size Limit" in "E-mail Send Settings"

The procedure for specifying the SMTP settings is explained below.

1

Display the screen.

Display the SMTP Protocol screen.

1

2

Launch your Web browser.

In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.

[Menu] key > [A][V] key > [Report Print] > [»] key > [A] [ Y] key > [Print Status Page] >
[OK] key > [OK] key

Log in with administrator privileges.

Admin Login Device 5
0 User Name Device
© Admin

Password %

LLLLLJ

&

The factory default setting for the default user with administrator privileges is shown below. (Upper
case and lower case letters are distinguished (case sensitive).)

Login User Name: Admin
Login Password: Admin
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4 From the [Network Settings] menu, click [Protocol].

Print Protocols
B NetBEUI : @®on O of
Device Information > i ] Wired Metwork [ Wi-Fi
“Available Network -

|/] Wi-Fi Direct

%Joh Status > “Workgroup : KM-NetPrinters

{Document Box >

J ‘LPD: @0n O Off
Device Settings Wired Network Wi-Fi
% 9 . Available Network - v 5 M
[] Wi-Fi Direct
QFuncﬁon Settings > “FTP Server (Reception} : ®0n O of
. ] Wired Network W] Wi-Fi
o bt | “Available Network - \WiLFi Direct
& - Network Setfings W] Wi-Fi Dire:
PP @0n O Off
General
S—— . [ Wired Network W Wi-Fi
2 ICPIP ENEDIC et ] Wi-Fi Direct
Polocdl )) G
“Port Number - (1-32767)
Wireless LAN
IPP over SSL: @ 0n () Off

2 Configure the settings.
Set "SMTP (E-mail TX)" to [On] in the "Send Protocols".

Send Protocols ~

SMTP (E-mail TX) : ® 0n () Off

lote
For more settings, click here. E-mail Setfings

SMTP Security | Off [v]

laote
To use these seftings, enable SSL. Network Security
Other Protocols

“SNMPviA2e : @®on () Off

late
For more settings, click here. SNMP Settings

- Available N . ] Wired Network W] Wi-Fi
wailable Network :
[+/] Wi-Fi Direct
This satting is used commanly with SNMPy A2 and
SNMPY3.

“SNMPY3 : Con @ Off
lote
For more settings, click here. SNMP Settings

lote

To use these settings, enable Available Metwork in

SNMPviivZe.
“HTTP @ on ) Off
/] Wired Network o] Wi-Fi

“Available Network -

[ Wi-Fi Direct
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3 Display the screen.
Display the E-mail Settings screen.

From the [Function Settings] menu, click [E-mail].

SMTP

SMTP Protocol : On

Device Information >

Mote :
Settings must be made in SMTP (E-mail TX).
Protocol

>

SMTP Server Name -

Mate
To specify the server name by domain name. set DNS
server. TCPIP

SMTP Port Number : (1-65535)

SMTP Server Timeout : seconds

Authentication Protocel : |0ff W

Off

Common/Job Defaults
Print

SMTP Security

Mote
Make settings here. Protocol

Connection Test :

| ﬁNelmrk Settings > :
| | Demain Restriction Off W

Security Settings > Domain List
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4 Configure the settings.
Enter "SMTP" and "E-mail Send Settings" items.

Setting Description

SMTP

Set to send e-mail from the machine.

SMTP Protocol

Displays the SMTP protocol settings. Check that "SMTP Protocol"
is set to [On]. If [Off] is set, click [Protocol] and set the SMTP
protocol to [On].

SMTP Server Name'!

Enter the host name or IP address of the SMTP server.

SMTP Port Number

Specify the port number to be used for SMTP. Use the SMTP
default port 25.

SMTP Server Timeout

Set the amount of time to wait before time-out in seconds.

Authentication Protocol

To use SMTP authentication, enter the user information for
authentication.

SMTP Security

Set SMTP security.

Turn on "SMTP Security" in "SMTP (E-mail TX)" on the
[Protocol Settings] page.

Connection Test

Tests to confirm that the settings are correct.

Domain Restriction

To restrict the domains, click the [Domain List] and enter the
domain names of addresses to be allowed or rejected. Restriction
can also be specified by e-mail address.

POP3

POP3 Protocol

Check Interval

Run once now

Domain Restriction

POP3 User Settings

You don't need to set the following items when you only enable the
function of sending e-mail from the machine. Set the following
items if you want to enable the function of receiving e-mail on the
machine.

% Command Center RX User Guide

E-mail
Send
Settings

E-mail Size Limit

Enter the maximum size of E-mail that can be sent in kilobytes.
When E-mail size is greater than this value, an error message
appears and E-mail sending is cancelled. Use this setting if you
have set E-mail Size Limit for SMTP server. If not, enter a value of
0 (zero) to enable E-mail sending regardless of the size limit.

Sender Address”’

Specify the sender address for when the machine sends E-mails,
such as the machine administrator, so that a reply or non-delivery
report will go to a person rather than to the machine. The sender
address must be entered correctly for SMTP authentication. The

maximum length of the sender address is 128 characters.

Signature

Enter the signature. The signature is free form text that will appear
at the end of the E-mail body. It is often used for further
identification of the machine. The maximum length of the
signature is 512 characters.

Function Defaults

Change the function default settings in [Common/Job Default
Settings] page.

*1 Be sure to enter the items.

5 Click [Submit].
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Creating a New Custom Box

NOTE

To use Custom Box, an optional SSD must be installed in the machine.

1 Display the screen.
1 Launch your Web browser.

2 In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.
[Menu] key > [A][V] key > [Report Print] > [»>] key > [A] [ V] key > [Print Status Page] >
[OK] key > [OK] key

3 From the [Document Box] menu, click [Custom Box].

Last Updated:
2016/08/04 10:27:11

|B-:|x.1'?' || Goto | Box Name |P

g

Box 01

Box 02

Box 03 565.0 KB

1-3/3box(s)

ﬁNetwork Settings >

g Security Settings >

4 Click [Add].

2 Configure the Custom Box.

1 Enter the box details.

Enter the information for the custom box you want to register. For details on the fields to populate,
refer to the following:

=2 Command Center RX User Guide
2 Click [Submit].
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Printing a document stored in a Custom Box

1 Display the screen.
1 Launch your Web browser.

2 In the address or location bar, enter the machine's IP address or the host name.
Print the status page to check the machine's IP address and the host name.
[Menu] key > [A][V] key > [Report Print] > [»] key > [A] [ VY] key > [Print Status Page] >
[OK] key > [OK] key

3 From the [Document Box] menu, click [Custom Box].

|
Home . Last Updated:
FE. o Document Box : Custom Box 2016/08/04 102711 @

|| Goto | |BoxName |p

Device Information >

S
Job Status >

(o)

Job Box Sethings

%DEVEB Settings >

1-3/3box(s
QFuncﬁon Settings > (<)

ENetwork Settings >

U Security Settings >

4 Click the number or name of the Custom Box in which the document is stored.
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2 Print the document.

ﬁ Home LastUpdated:_ ;

& Admin Document Box

‘ Box Property ‘

Used Area - 320.0 KB / 200.0 MB File Name

Chedk All Delete Move Print 2

Devicelnfom‘lation > 5: De *z %

Job Status > Select Type Eile Name & Date

- 1 [, IESLixt-Note 070214 114749548 2014/07/02
[, IEST.txt-Note 070214 114929991 2014/07/02

‘% TEST.txt - Note 070214 114944398 2014/07/02

1-373 document(s)

1 Select the document you wish to print.

Select the checkbox of the document to be printed.
2 Click [Print].

3 Configure settings for printing, click [Print].
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3 Preparation before Use

This chapter explains the following operations.

o7 To LT To [ =T 0T P 3-2
Precaution for LOAdING PAPET .........ooiiiiiiiiie ittt s ettt e e sttt e e e s et aae e e e s ensae e e e s snnaeeeessnnneeeens 3-3
Loading in the CasSEES .......eiiiiiiiiiiii et 3-4
Loading Paper in the Multi PUrPOSE Tray .......coooiiiiiiiiiie et 3-7
Specifying Paper Size and Media TYPE .....ooiiiiiiiiii e s 3-10

T 01 ] (o] ] =Y PO 3-13

3-1



Preparation before Use > Loading Paper

Loading Paper

Load paper in the cassettes and multipurpose tray.

For the paper load methods for each cassette, refer to the page below.

1

2

3

4

5

No. Page

1 Cassette 1 page 3-4
2 Cassette 2 page 3-4
3 Cassette 3 page 3-4
4 Cassette 4 page 3-4
5 Multi Purpose Tray page 3-7

NOTE

» The number of sheets that can be held varies depending on your environment and paper type.

* You should not use inkjet printer paper or any paper with a special surface coating. (Such paper may cause paper
jams or other faults.)

» For higher quality color printing, use special color paper.
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Precaution for Loading Paper

When you open a new package of paper, fan the sheets to separate them slightly prior to loading in the following steps.

Fan the paper, then tap it on a level surface.

In addition, note the following points.

If the paper is curled or folded, straighten it before loading. Paper that is curled or folded
may cause a jam.

Avoid exposing opened paper to high temperatures and high humidity as dampness can be
a cause of problems. Seal any remaining paper after loading in the multi purpose tray or
cassettes back in the paper storage bag.

If the machine will not be used for a prolonged period, protect all paper from humidity by
removing it from the cassettes and sealing it in the paper storage bag.

@ IMPORTANT

If you print onto used paper (paper already used for printing), do not use paper that is
stapled or clipped together. This may damage the machine or cause poor image
quality.

NOTE

If you use special paper such as letterhead, paper with holes or paper with pre-prints like
logo or company name, refer to the following:

® Paper (page 10-9)
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Loading in the Cassettes

The cassettes can hold plain paper, recycled paper or color paper.
The number of sheets that can be loaded in each cassette is shown below.

Cassette No. Sheets

Cassettes 1 to 4 500 sheets (Plain paper: 80 g/m?)

For details of the supported paper sizes, refer to the following:

® Choosing the Appropriate Paper (page 10-10)

NOTE

A6 paper cannot be loaded in cassettes 2 to 4.

For the paper type setting, refer to the following:
& Type Adjust Setting (page 7-8)

(@) IMPORTANT
The cassettes 1 can hold paper with weight between 60 - 163 glm2. The cassettes 2 to 4 can hold paper with

weight between 60 - 220 g/m?.

1 Pull the cassette completely out of the machine.

[N NOTE

When pulling the cassette out of the machine, ensure it is supported and does not fall out.

2 Adjust the cassette size.

1 Adjust the position of the paper width guides located on the left and right sides of the
cassette. Press the paper width adjusting tab and slide the guides to the paper size required.

Paper sizes are marked on the cassette.
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2 Adjust the paper length guide to the paper size required. Press the paper length adjusting
tab and slide the guides to the paper size required.

3 Turn the size dial so that the size of the paper you are going to use appears in the paper
size window.

NOTE
When the size dial is set to "Other" the paper size must be set into the machine on the
operation panel.

® Paper Size and Media Type for the Cassettes (page 3-10)

3 Load paper.
1 Fan the paper, then tap it on a level surface to avoid paper jams or skewed printing.

2 |oad the paper in the cassette.

P
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(@) IMPORTANT
¢ Load the paper with the print side facing up.

* After removing new paper from its packaging, fan the paper before loading it in
the multi-purpose tray.

® Precaution for Loading Paper (page 3-3)

» Before loading the paper, be sure that it is not curled or folded. Paper that is
curled or folded may cause paper jams.

¢ Ensure that the loaded paper does not exceed the level indicator (see illustration
above).

* If paper is loaded without adjusting the paper length guide and paper width
guide, the paper may skew or become jammed.

4 Gently push the cassette back in.

NOTE
There is a paper gauge on the right side of the front of the cassette to indicate the remaining
paper supply.

]

Specify the type of paper loaded in the cassette using the
operation panel.

® Paper Size and Media Type for the Cassettes (page 3-10)
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Loading Paper in the Multi Purpose Tray

The multi purpose tray will hold up to 100 sheets of plain paper (80 g/m2).

For details of the supported paper sizes, refer to the following:
® Choosing the Appropriate Paper (page 10-10)

For the paper type setting, refer to the following:
® Type Adjust Setting (page 7-8)

Be sure to use the multi purpose tray when you print on any special paper.

@ IMPORTANT

¢ If you are using a paper weight of 106 glm2 or more, set the media type to Thick and set the weight of the
paper you are using.

* Remove each transparency from the top tray as it is printed. Leaving transparencies in the top tray may
cause a paper jam.
The capacity of the multi purpose tray is as follows.
» Plain paper (80 g/m2), recycled paper or color paper: 100 sheets
«  Thick paper (209 g/m?): 15 sheets
» Thick paper (157 g/m2): 30 sheets
«  Thick paper (104.7 g/m?): 50 sheets
» Hagaki (Cardstock): 30 sheets

* Envelope DL, Envelope C5, Envelope #10, Envelope #9, Envelope #6 3/4, Envelope Monarch, Youkei 4, Youkei 2:
5 sheets

e OHP film: 1 sheet
* Coated: 30 sheets

NOTE

* When you load custom size paper, enter the paper size by referring to the following:
® Paper Size and Media Type for the Multi Purpose Tray (MP Tray Setting) (page 3-12)

* When you use special paper such as transparencies or thick paper, select the media type by referring to the
following:

® Paper Size and Media Type for the Multi Purpose Tray (MP _Tray Setting) (page 3-12)

1 Open the multi purpose tray.
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2 Adjust the multi purpose tray size.

Paper sizes are marked on the multi purpose tray.

Asl sTmTl Bsl A4l

Insert the paper along the paper width guides into the tray until it stops.

After removing new paper from its packaging, fan the paper before loading it in the multi
purpose tray.

® Precaution for Loading Paper (page 3-3)

(¥) IMPORTANT
¢ When loading the paper, keep the print side facing up.

¢ Curled paper must be uncurled before use.

¢ When loading paper into the multi purpose tray, check that there is no paper left
over in the tray from a previous job before loading the paper. If there is just a small
amount of paper left over in the multi purpose tray and you want to add more, first
remove the left-over paper from the tray and include it with the new paper before
loading the paper back into the tray.

« If there is a gap between the paper and the paper width guides, readjust the guides
to fit the paper in order to prevent skewed feeding and paper jams.

* Ensure that the loaded paper does not exceed the load limits.

4 Specify the type of paper loaded in the multi purpose tray using
the operation panel.

® Paper Size and Media Type for the Multi Purpose Tray (MP_Tray Setting) (page 3-12)
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When you load envelopes or cardstock in the multi purpose tray

Load the paper with the print side facing up. For the procedure for printing, refer to the following:
® Printer Driver User Guide

Example: When printing the address.

N\ >/
=/
N[ E——] 7
/A th - Open the flap
I I I I Close the flap.
O
]
Oufuku hagaki Hagaki Portrait form Landscape form
(Return postcard) (Cardstocks) envelopes envelopes

(@) IMPORTANT
* Use unfolded Oufuku hagaki (Return postcard).

* How to load envelopes (orientation and facing) will differ depending on the type of envelope. Be sure to
load it in correctly, otherwise printing may be done in the wrong direction or on the wrong face.

[ NOTE

When you load envelopes in the multi purpose tray, select the envelope type by referring to the following:

® Paper Size and Media Type for the Multi Purpose Tray (MP Tray Setting) (page 3-12)
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Specifying Paper Size and Media Type

The default paper size setting for cassette 1, for the multi purpose tray and for the optional paper feeder (cassettes 2 to
4) is "A4" or "Letter", and the default media type setting is "Plain".

To change the type of paper to be used in cassettes, specify the paper size and media type setting.

Paper Size and Media Type for the Cassettes

Specify the paper size and media type of paper to be used in cassettes.

Item Description

Cassette1 (to 4) Size" Select the paper size to be used in Cassettes 1 to 4.
Values

Cassette 1: Executive, Letter, Legal, A4, B5, A5, A6, B6, ISO B5, Custom, Oficio II,
216 x 340 mm, 16K, Statement, Folio

Cassette 2 to 4: Envelope Monarch, Envelope #10, Envelope DL, Envelope C5,
Executive, Letter, Legal, A4, B5, A5, B6, Envelope #9, Envelope #6, ISO B5, Custom,
Oficio ll, 216 x 340 mm, 16K, Statement, Folio, Youkei 2, Youkei 4

If custom is selected, register the custom sizes used in cassettes 1 to 4.
Values

Cassette 1:

Metric

X: 105 to 216 mm (in 1 mm increments)
Y: 148 to 356 mm (in 1 mm increments)

Inch

X: 4.13 to 8.50" (in 0.01" increments)
Y: 5.83 to 14.02" (in 0.01" increments)

Cassette 2 to 4:
Metric

X: 92 to 216 mm (in 1 mm increments)
Y: 162 to 356 mm (in 1 mm increments)

Inch

X: 3.62 to 8.50" (in 0.01" increments)
Y: 6.38 to 14.02" (in 0.01" increments)

X=Length, Y=Width
Vertical
X

| IS S —

Cassette1 (to 4) Type*2 Select the media type of paper to be used in Cassettes 1 to 4.
Values

Cassette 1: PLAIN (60 - 105 g/m?), PREPRINTED, BOND, RECYCLED,
VELLUM (60 - 105 g/m?), ROUGH, LETTERHEAD, COLOR, PREPUNCHED,
THICK (106 - 163 g/m?), HIGH QUALITY, Custom 1 - 8

Cassette 2 to 4: PLAIN (60 - 105 g/m?), PREPRINTED, LABELS, BOND, RECYCLED,
VELLUM (60 - 105 g/m?), ROUGH, LETTERHEAD, COLOR, PREPUNCHED, ENVELOPE,
COATED, THICK (106 - 220 g/m?), HIGH QUALITY, Custom 1 - 8

*1  Only set this when the size dial on the cassette is set to "Other".
*2 To change to a media type other than Plain.
® Type Adjust Setting (page 7-8)
When a paper weight that cannot be loaded in the cassette is set for a media type, that media type does not appear.
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1

2

Display the screen.
[Menu] key > [A][V¥] key > [Paper Settings] > [»] key

Specify the paper size.

1 [A][V¥]key > [Cassette 1 (to 4) Size] > [OK] key

NOTE

[Cassette 2] to [Cassette 4] are shown when the optional paper feeder is installed.

2 Select the paper size, and select the [OK] key.

If you selected [Custom], use the procedure below to specify the paper length and width.
[»] key in "Cassette 1 (to 4) Size" > [A] [¥V] key > [Unit] > [OK] key
Select the paper size units, and select the [OK] key.

[A][V] key > [X Dimension] > [OK] key

o a h~ &

Enter the paper width, and select the [OK] key.
NOTE
Select the [A] or [ V] key to enter a number.

7 [A][V]key >[Y Dimension] > [OK] key

8 Enter the paper length, and select the [OK] key.

NOTE

Select the [A] or [ V] key to enter a number.

©

If you selected [Custom] in the paper size, select [ 4] key.

Specify the media type.

1 [A][V] key > [Cassette 1 (to 4) Type] > [OK] key
NOTE
[Cassette 2] to [Cassette 4] are shown when the optional paper feeder is installed.

2 Select the media type, and select the [OK] key.
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Paper Size and Media Type for the Multi Purpose Tray (MP Tray Setting)

Specify the paper size and media type of paper to be used in the multi purpose tray.

Item Description

MP Tray Size Select the paper size to be used in the multi purpose tray.

Values: Envelope Monarch, Envelope #10, Envelope DL, Envelope C5, Executive, Letter,
Legal, A4, B5, A5, A6, B6, Envelope #9, Envelope #6, ISO B5, Custom,

Hagaki (Cardstock), OufukuHagaki (Return postcard), Oficio Il, 216 x 340 mm, 16K,
Statement, Folio, Youkei 2, Youkei 4

MP Tray Type*1 Select the media type of paper to be used in the multi purpose tray.

Values: PLAIN (60 - 105 glm2), TRANSPARENCY, PREPRINTED, LABELS, BOND,
RECYCLED, VELLUM (60 - 105 glm2), ROUGH, LETTERHEAD, COLOR, PREPUNCHED,
ENVELOPE, CARDSTOCK, COATED, THICK (106 - 220 g/mz), HIGH QUALITY,

Custom 1-8

*1  To change to a media type other than Plain.
® Type Adjust Setting (page 7-8)

1 Display the screen.

[Menu] key > [A][V¥] key > [Paper Settings] > [»] key
2 Specify the paper size.

1 [A][V]key>[MP Tray Size] > [OK] key

2 Select the paper size, and select the [OK] key.
3 Specify the media type.

1 [A][V]key>[MP Tray Type] > [OK] key

2 Select the media type, and select the [OK] key.
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Paper Stopper

When using paper A4/Letter or larger, open the paper stopper shown in the figure.
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4 Printing from PC

This chapter explains the following topics:

T a LT aTo I o a T RPN 4-2
Printing on Non-standard SiZed Paper .........ccueeiiiiiiiiiiiie ettt e e 4-4
Printer Driver Print SEtlings SCrEEN ........uuiiiiiii e 4-5
LA G g I AV ol o T o USSP 4-6
Changing the Default Printer Driver Settings (Windows 8.1) .......ooiiiiiiiii e 4-6
Canceling Printing from @ COMPULET .......ccoii oo e e e e e e e e e e e e e e nranreeeeeees 4-6

Printing DY AP IINT et e e e e e e e e e e e e e e e e e e e e e e e ae s 4-7

Printing by Google Cloud Print ... e e e e e e e e e e e e e s e e e eeeaaaaeaas 4-7

AT a T (oY T o)V 1Y, [T o] 5 - PP 4-7

Printing With WI=Fi DIFECL ...ttt et e e e e e e e e e et e e e e e e e e e e e e e nnnneseneeeeaaeaeas 4-7

Printing Data Saved 0N the PrINTEr ... e e e e 4-8
Specifying the Job Box from a Computer and Storing the JOb .........cccciiiiiiiiiiii e 4-8
Printing Documents from Private Print BOX ..........ooiiiiiiiiii e 4-9
Printing Document from Stored JOD BOX ........uuuiiiiiiiieiiiie ittt e e e e a e e e e 4-11
Printing Document from QUICK COPY BOX .....iiiiiiiiiiiiiiiit e 4-13
Printing Document from Proof and HOId BOX ........coooiiiiiiiiiie et 4-15

N o] o) = 7o) oT= 111 o o TP PRR 4-17

1 e= (0 L3 1Y o T a1 (o] USSR 4-18
Accessing the STatus MONITOT ........oooiiiiiii et e e s e e e b e e e eneeeeae s 4-18
EXiting the Status MONITOT ......eoiiiii e e e e e e e e e s e s s e e reeaaaaaeaeas 4-18
ez LU\ (o] T (o] gl I o] F= PRSP 4-18
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Printing from PC

Follow the steps below to print documents from applications.

NOTE

« To print the document from applications, install the printer driver on your computer from the supplied DVD
(Product Library).
* In some environments, the current settings are displayed at the bottom of the printer driver.

eeeeeeeeeeeeeeeeeeeeeeeeee

BEE

[ print

cccccc

0} KYOCERA
» When printing the cardstock or envelopes, load the cardstock or envelopes in the multi purpose tray before
performing the following procedure.

® When vou load envelopes or cardstock in the multi purpose tray (page 3-9)

1 Display the screen.

Click [File] and select [Print] in the application.

2 Configure the settings.

1 Select the machine from the "Printer" menu and click the [Properties] button.

85x 11 Inches

Muitiple ek LU I T

Page 10f 574

Page s e
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2 Select the [Basic] tab.

3 Click "Print size" menu and select the paper size to use for printing.

To load the paper of size that is not included in print sizes of the machine such as cardstock or
envelopes, the paper size needs to be registered.

® Printing on Non-standard Sized Paper (page 4-4)

To print on the special paper such as thick paper or transparency, click "Media type" menu and select
the media type.

Printing Preferences ?

Collate: On

2 2]

Orientation: Portrait

2] a vl

Duplext Flip on long edge

o KY0CERA

4 Click [OK] button to return to the Print dialog box.

3 Start printing.
Click the [OK] button.
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Printing on Non-standard Sized Paper

If you loaded a paper size that is not included in the print sizes of the machine, register the paper size in the [Basic] tab
of the print settings screen of the printer driver.

The registered size can be selected from the "Print size" menu.

NOTE

To execute printing at the machine, set the paper size and type in the following:
® Paper Size and Media Type for the Multi Purpose Tray (MP Tray Setting) (page 3-12)

1 Display the print settings screen.

2 Register the paper size.

= Printing Preferences ? “ C|ICk the [Basic] tab
Click the [Page Size...] button.
Click the [New] button.

Enter the paper size.

Collate: On
23] FE{Q
fﬂ
|
._:_. .!.

Orientation: Portrait

[afaiviy

Enter the name of the paper.
Click the [Save] button.
Click the [OK] button.

Duplex: Flip on long edge

0 N O O M~ WODN -

In the "Print size" menu, select the paper size
(name) that you registered in steps 4 to 7.

9 Select the type of paper in the "Media type"
menu.

7 kYDCERR 10 Click [MP tray] in the "Source" menu.

I

Select page size: 85x11in,

Envelope DL ~
Oficio Il

8K

18K

216 340 mm

12x18

v

4 3 ‘ New > Delete
(‘ﬁ'ua =lin. 753 :m)

6 O

7 oK Cancel

NOTE

If you loaded a postcard or envelope, select [Cardstock] or [Envelope] in the "Media type" menu.
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Printer Driver Print Settings Screen

The printer driver print settings screen allows you to configure a variety of print-related settings.

® Printer Driver User Guide

No.

= Printing Preferences ?
1 Qrientation Color Collate Duplex Pages per sheet
123125
=i
L » manh u (e o
3 e
B imaging
Printer profiles:
WA Publishing > D
y Factory
. ] Default
Advanced
2 Apply
Save As... ‘ Prafiles... , Print preview [
£} KYOCERD Cancel

Description

[Quick Print] tab

Provides icons that can be used to easily configure frequently used functions. Each time you click an icon, it
changes to an image resembling the print results and applies the settings.

Collate Duplex Pages per sheet

= § E

manp

[Basic] tab

This tab groups basic functions that are frequently used. You can use it to configure the paper size, and
duplex printing.

[Layout] tab

This tab lets you configure settings for printing various layouts, including booklet printing, combine mode,
poster printing, and scaling.

[Imaging] tab

This tab lets you configure settings related to the quality of the print results.

[Publishing] tab

This tab lets you create covers and inserts for print jobs and put inserts between sheets of OHP film.
[Job] tab

This tab lets you configure settings for saving print data from the computer to the machine. Regularly used
documents and other data can be saved to the machine for easy printing later. Since saved documents can
be printed directly from the machine, this function is also convenient when you wish to print a document that
you don't want others to see.

[Advanced] tab

This tab lets you configure settings for adding text pages or watermarks to print data.

[Profiles]

Printer driver settings can be saved as a profile. Saved profiles can be recalled at any time, so it's a
convenient practice to save frequently used settings.

[Reset]
Click to revert settings to their initial values.
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Printing from PC > Printing from PC

Printer Driver Help

The printer driver includes Help. To learn about print settings, open the printer driver print settings screen and display
Help as explained below.

1 Click the [?] button in the upper right corner of the
screen and then click the item you want to know
about.

2 Click the item you want to know about and press
the [F1] key on your keyboard.

» ot it prview
o KYOCERA Gancel

Changing the Default Printer Driver Settings
(Windows 8.1)

The default printer driver settings can be changed. By selecting frequently used settings, you can omit steps when
printing. For the settings, refer to the following:

® Printer Driver User Guide
1 In charms on Desktop, click [Settings], [Control Panel], and then [Devices and Printers].

2 Right-click the printer driver icon of the machine, and click the [Printer properties] menu of
the printer driver.

3 Click the [Basic] button on the [General] tab.

4 Select the default settings and click the [OK] button.

Canceling Printing from a Computer

To cancel a print job executed using the printer driver before the printer begins printing, do the following:

NOTE

When canceling printing from this machine, refer to the following:
® Canceling Jobs (page 5-2)

1 Double-click the printer icon ( [fft ) displayed on the taskbar at the bottom right of the
Windows desktop to display a dialog box for the printer.

2 Click the file for which you wish to cancel printing and select [Cancel] from the "Document"
menu.
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Printing by AirPrint

AirPrint is a printing function that is included standard in iOS 4.2 and later products, and Mac OS X 10.7 and later
products.

This function enables you to connect and print to any AirPrint compatible device without installing a printer driver.

To allow the machine to be found when printing by AirPrint, you can set machine location information in Command
Center RX.

® Command Center RX User Guide

R

AirPrint

Printing by Google Cloud Print

Google Cloud Print is a printing service provided by Google and does not require a printer driver. This service enables a
user with a Google account to print from a machine connected to the Internet.

The machine can be configured in the Command Center RX.

® Command Center RX User Guide

NOTE

A Google account is necessary to use Google Cloud Print. Obtain a Google account if you do not have one.

It is also necessary to register the machine with the Google Cloud Print service in advance. The machine can be
registered from a PC connected to the same network.

Printing by Mopria
Mopria is a standard on printing function included in Android 4.4 or later products. Mopria Print Service needs to be

installed and enabled in advance.

For details on how to use, refer to a Web site of Mopria Alliance.

Printing with Wi-Fi Direct

Wi-Fi Direct is a wireless LAN standard that Wi-Fi Alliance has been established. This is one of the functions of the
wireless LAN, without a wireless LAN access point or wireless LAN router, between devices can communicate directly
on a peer to peer basis.

The printing procedure by the Wi-Fi Direct is the same as that from the normal handheld devices.

When you use a printer name or Bonjour name on the port settings of the printer property, you can print the job by
specifying the name at Wi-Fi Direct connection.

When you use an IP address for the port, specify the IP address of this machine.
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Printing from PC > Printing Data Saved on the Printer

Printing Data Saved on the Printer

If you configure settings in the [Job] tab of the printer driver and then print, the print job will be saved in the Job Box
(memory) and printing can be executed at the machine.

Follow the work flow below when using Job Box.

Specifying the Job Box from a computer and sending the print job. (page 4-8)

v

Using the operation panel to specify a file within a Box and printing it.

You can print the documents from the following boxes.

® Printing Documents from Private Print Box (page 4-9)

® Printing Document from Stored Job Box (page 4-11)

® Printing Document from Quick Copy Box (page 4-13)

® Printing Document from Proof and Hold Box (page 4-15)

Specifying the Job Box from a Computer and Storing
the Job

Use the procedure below to store data in a Job Box.
1 Click [File] and select [Print] in the application. The Print dialog box displays.
2 Select the machine from the "Name" menu.
3 Click the [Properties] button. The Properties dialog box displays.
4 Click the [Job] tab and select the [Job storage (e-MPS)] check box to set the function.
NOTE

» To use Stored Job Box and Quick Copy Box, an optional SSD must be installed in the
machine.

 For information on how to use the printer driver software, refer to the following:

® Printer Driver User Guide
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Printing from PC > Printing Data Saved on the Printer

Printing Documents from Private Print Box

In Private Printing, you can specify that a job is not to be printed until you operate the machine. When sending the job
from the application software, specify a 4-digit access code in the printer driver. The job is released for printing by
entering the access code on the operation panel, ensuring confidentiality of the print job. The data will be deleted upon
completion of the print job or after the power switch is turned off.

The following operations are possible:

® Printing the Documents (page 4-9)

® Deleting the Documents (page 4-10)

Printing the Documents

Print the documents stored in a Private Print box. The procedure is as follows.

1 Display the screen.

1 [Menu] key > [A] [¥] key > [Job Box] > [»] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[All Files] > [A] [ VY] key > [OK] key

To apply this process to all documents in Private/Stored Job, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.
Printing starts.

Upon completion of printing, the Private/Stored job is automatically deleted.

NOTE
« If the document is protected by an access code, the password entry screen will be
displayed. Enter the password using the arrow keys, and then select [OK] key.

« If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.

* If you selected [All Files], select [A] key after "Copies ---" is displayed to set the
number of copies.
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Printing from PC > Printing Data Saved on the Printer

Deleting the Documents

Delete the documents stored in a Private Print box. The procedure is as follows.

1

Display the screen.

1 [Menu] key > [A] [¥] key > [Job Box] > [»>] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

Delete the document.

1 Select the document to delete.
[All Files] > [A] [ V] key > [OK] key

To apply this process to all documents in Private/Stored Job, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.

NOTE
« If the document is protected by an access code, the password entry screen will be
displayed. Enter the password using the arrow keys, and then select [OK] key.

+ If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.
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Printing from PC > Printing Data Saved on the Printer

Printing Document from Stored Job Box

In Stored Job, the print data sent from the application is saved to the machine. You can set up an access code as
necessary. If you set up an access code, enter the access code when printing. Print data will be stored in the Stored Job
Box after printing. This will allow printing of the same print data repeatedly.

The following operations are possible:

® Printing the Documents (page 4-11)

® Deleting the Documents (page 4-12)

Printing the Documents

Print the documents stored in a Stored Job box. The procedure is as follows.

1 Display the screen.

1 [Menu] key > [A] [¥] key > [Job Box] > [»>] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[All Files] > [A] [ VY] key > [OK] key

To apply this process to all documents in Private/Stored Job, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.

Printing starts.

NOTE
« If the document is protected by an access code, the password entry screen will be
displayed. Enter the password using the arrow keys, and then select [OK] key.

+ If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.

* If you selected [All Files], select [A] key after "Copies ---" is displayed to set the
number of copies.
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Printing from PC > Printing Data Saved on the Printer

Deleting the Documents

Delete the documents stored in a Stored Job box. The procedure is as follows.

1

Display the screen.

1 [Menu] key > [A] [¥] key > [Job Box] > [»>] key > [A] [¥] key > [Private/Stored] >
[OK] key

2 Select the creator of the document, and select the [OK] key.

Print and delete the document.

1 Select the document to delete.
[All Files] > [A] [ V] key > [OK] key

To apply this process to all documents in Private/Stored Job, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.

NOTE
« If the document is protected by an access code, the password entry screen will be
displayed. Enter the password using the arrow keys, and then select [OK] key.

+ If you selected [All Files] and the access code does not match any of the documents,
and in addition there are no documents without access codes, "ID error" is displayed.
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Printing from PC > Printing Data Saved on the Printer

Printing Document from Quick Copy Box

Quick Copy feature facilitates additional prints of a document already printed. Activating Quick Copy and printing a
document using the printer driver allow the print data to be stored in the Quick Copy Job Box. When additional copies
are required, you can reprint the required number of copies from the operation panel. By default, up to 32 documents
can be stored. When power is turned off, all stored jobs will be deleted.

NOTE

» When the number of jobs reaches the limit, the oldest job will be overwritten by the new one.
» To maintain free space on the box, you can set the maximum number of stored jobs.
® Quick Copy (page 4-17)

The following operations are possible:

® Printing the Documents (page 4-13)

® Deleting the Documents (page 4-14)

Printing the Documents

You can print the documents stored in the Quick Copy box. The procedure is as follows.

1 Display the screen.
1 [Menu] key > [A] [V] key > [Job Box] > [»] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[All Files] > [A][V] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.
Printing starts.

NOTE
If you selected [All Files], select [ A] key to set the number of copies. When using the
number of copies specified with print job, select "Copies ---".
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Printing from PC > Printing Data Saved on the Printer

Deleting the Documents

You can delete the documents stored in the Quick Copy box. The procedure is as follows.

1

Display the screen.
1 [Menu] key > [A] [V] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

Delete the document.

1 Select the document to delete.
[All Files] > [A][VY] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.
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Printing from PC > Printing Data Saved on the Printer

Printing Document from Proof and Hold Box

The Proof and Hold feature produces only a single proof print of multiple-print job and holds printing of the remaining
copies. Printing a multiple-print job in Proof and Hold using the printer driver allows only a single copy to be printed while
maintaining the document data in the Job Box. To continue to print the remaining copies, use the operation panel. You
can change the number of copies to print.

The following operations are possible:

® Printing the Documents (page 4-15)

o Deleting the Documents (page 4-16)

Printing the Documents

You can print the documents stored in the Proof and Hold box. The procedure is as follows.

1 Display the screen.
1 [Menu] key > [A] [V] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

2 Print the document.

1 Select the document to print.
[All Files] > [A][V] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 Specify the number of copies to print as desired, and select the [OK] key.

Printing starts.

NOTE
If you selected [All Files], select [ A] key to set the number of copies. When using the
number of copies specified with print job, select "Copies ---".
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Printing from PC > Printing Data Saved on the Printer

Deleting the Documents

You can delete the documents stored in the Proof and Hold box. The procedure is as follows.

1

Display the screen.
1 [Menu] key > [A] [V] key > [Job Box] > [»>] key > [A] [¥] key > [Quick Copy] > [OK] key

2 Select the creator of the document, and select the [OK] key.

Delete the document.

1 Select the document to delete.
[All Files] > [A][VY] key > [OK] key
To apply this process to all documents in Quick Copy/Proof-and-Hold, select [All Files].

2 [Delete] appears.

If the [ V] key is selected when "Copies" appears, [Delete] will appear.

3 Select the [OK] key.

The document is deleted.
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Printing from PC > Job Box Setting

Job Box Setting

Configures settings for Job Box.

1 Display the screen.

[Menu] key > [A] [V¥] key > [Job Box] > [»] key > [A] [¥] key > [Job Box Configuration] >
[>] key

2 Configure the settings.

The available settings are shown below.

Item Description

Quick Copy To maintain free space on the box, you can set the maximum number of
stored jobs.

Value: number between 0 and 300

NOTE

When 0 is set, Quick Copy cannot be used.

Delete This setting specifies that documents, such as Private Printing, Quick
Copying, or Proof and Hold Printing, saved temporarily in the job box are
automatically deleted after they have been saved for a set time.

Value: Off, 1 hour, 4 hours, 1 day, 1 week

NOTE
This function is valid for documents saved after the function is set.

Regardless of this function setting, temporary documents are deleted
when the main power switch is turned off.

Storage Media Select which storage media to use.
Value: SSD, SD Card

NOTE

This setting is not displayed if the optional SSD or SD card is not
installed.




Printing from PC > Status Monitor

Status Monitor

The Status Monitor monitors the printer status and provides an ongoing reporting function.

NOTE

When you activate Status Monitor, check the status below.
+ KX DRIVER is installed.
 Either [Enhanced WSD] or [EnhancedWSD(SSL)] are set to [On] in "Security".

2 Security (page 7-25)

Accessing the Status Monitor

The Status Monitor also starts up when printing is started.

Exiting the Status Monitor

Use either of the methods listed below to exit the Status Monitor.

+ Exit manually:
Click the settings icon and select Exit in the menu to exit the Status Monitor.

+ Exit automatically:
The Status Monitor automatically shuts down after 7 minutes if it is not being used.

Status Monitor Display

The display of the Status Monitor is as follows.

Quick View State
The status of the printer is displayed using icons. Detailed information is displayed when the Expand button is clicked.
_—t x|

o
{F— Settings icon

Expand button

Alert Tab
Toner Status Tab

Paper Tray Status Tab
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iy
E
=

=
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2

Printing Progress Tab

Detailed information is displayed by clicking on each icon tab.
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Printing from PC > Status Monitor

Printing Progress Tab

The status of the print jobs is displayed.

ik W . e ® e - - B
Sm=3000= e
M| 0% 70% | 96% 87% 91% 92% a
Job Name Printe... Status e
= - Printing
—Job list
Status icon

Select a job on the job list and it can be canceled using the menu displayed with a right-click.

Paper Tray Status Tab

Information is displayed about the paper in the printer and about the amount of paper remaining.

Sy . S A e - . = =
w3 goI=
0%  70% | 96% &7% 91% 92% S
Name Size Type Level
A MP Tray Letter  Plain 0%
Cassette 1 A4 Plain 70%

Toner Status Tab

The amount of toner remaining is displayed.

I W — -

o = - - O
== P00 D=
0% 70% | 8% B7% 91% 92% I
Toner Level Mame
Black 96%
Cyan 87%
Magenta 91%
Yellow 92%
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Alert Tab

If an error occurs, a notice is displayed using a 3D image and a message.

=383 .

@ Cover open
The printing system's top cover is open.
Close it securely.

@ Cover open

The rear cover 1 is opened.
Close it securely.

Status Monitor Context Menu

The following menu is displayed when the settings icon is clicked.

1000 -

Command Center RX
% | 96% B7% 91% 2% Motification...

Toner www.kyoceradocumentsolutions.com
Black Exit
Cyan
Magenta 91%
Yellow 92%

+ Command Center RX
If the printer is connected to a TCP/IP network and has its own IP address, use a web browser to access the
Command Center RX to modify or confirm the network settings.This menu is not displayed when using USB
connection.
® Command Center RX User Guide

* Notification...
This sets the display of the Status Monitor.
= Status Monitor Notification Settings (page 4-21)

+  www.kyoceradocumentsolutions.com
Open our website.

+ Exit
Exits the Status Monitor.
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Status Monitor Notification Settings

The Status Monitor settings and event list details are displayed.

Available events:
Events Sound file [ Text to Speech

Cover open
Paper jam
Add paper
Sleep
Add toner
Toner low
Mot connected
Printing completed
Others

Select whether notification is performed when an error in the event list occurs.

1 Select Enable event notification.

If this setting is set to Off, then the Status Monitor will not start up even when printing is
executed.

2 Select an event to use with the text to speech function in
Available events.

3 Click Sound file / Text to Speech column.
Click the browse (...) button to notify the event by sound file.

Available events:

Events Sound file [ Text to Speech

Cover open |
Paper jam

Add paper

Sleep

Add toner

Toner low

Mot connected

NOTE

The available file format is WAV.

When customizing the message texts to read on the screen aloud, enter the texts in the text
box.
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5 Operation on the Machine

This chapter explains the following topics:
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Operation on the Machine > Canceling Jobs

Canceling Jobs

You can also cancel jobs by selecting the [Cancel] key.

1 While the printer displays "Processing”, select [Cancel] key.

"?" appears on the message display followed by the job name currently in progress.

2 Cancel a job.

Select the job to cancel, and select the [OK] key.

The job is canceled.
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Operation on the Machine > What is Document Box?

What is Document Box?

Document Box contains four types of component boxes which provide the following functions.
The following types of document boxes are available.
Custom Box (page 5-5)

Custom Box is a component box which you can create within the Document Box and store data for later retrieval. You
can create or delete a Custom Box, and manipulate data in various ways as described below:

& Creating a New Custom Box (page 5-5)

Storing Documents (page 5-5)

Printing Documents (page 5-6)

Editing Documents (page 5-6)

Deleting Documents (page 5-7)

Printing lists (page 5-8)

[ NOTE

To use Custom Box, an optional SSD must be installed in the machine.

Job Box

This is a box to save jobs executed from a PC.

NOTE

* You can set up the machine so that temporary documents in job boxes are automatically deleted.
® Delete (page 4-17)

* For details on operating the Job Box, refer to the following:

® Printing Data Saved on the Printer (page 4-8)

Private Print/Stored Job Box (page 4-9, page 4-11)

In Private Printing, you can specify that a job is not to be printed until you operate the machine. When sending the job
from the application software, specify a 4-digit access code in the printer driver. The job is released for printing by
entering the access code on the operation panel, ensuring confidentiality of the print job. The data will be deleted upon
completion of the print job or after the power switch is turned off.

In Stored Job, the print data sent from the application is saved to the machine. You can set up an access code as
necessary. If you set up an access code, enter the access code when printing. Print data will be stored in the Job Box
after printing. This will allow printing of the same print data repeatedly.

Quick Copy/Proof and Hold Box (page 4-13, page 4-15)

Quick Copy feature facilitates additional prints of a document already printed. Activating Quick Copy and printing a
document using the printer driver allow the print data to be stored in the Job Box. When additional copies are required,
you can reprint the required number of copies from the operation panel. By default, up to 32 documents can be stored.
When power is turned off, all stored jobs will be deleted.

NOTE
When you attempt to store documents in excess of the above maximum, the oldest document data will be overwritten
by the latest document data.

The Proof and Hold feature produces only a single proof print of multiple-print job and holds printing of the remaining
copies. Printing a multiple-print job in Proof and Hold using the printer driver allows only a single copy to be printed while
maintaining the document data in the Job Box. To continue to print the remaining copies, use the operation panel. You
can change the number of copies to print.
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Removable Memory Box (page 5-9)

A USB memory stick can be connected to the USB memory slot on the machine to print a saved file. You can print data
directly from the USB memory without a PC.
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Using a Custom Box

Custom Box is a component box which you can create within the Document Box and store data for later retrieval. You
can create or delete a Custom Box, and manipulate data in various ways as described below:

» Creating a New Custom Box (page 5-5)
Storing Documents (page 5-5)

Printing Documents (page 5-6)

Editing Documents (page 5-6)

Deleting Documents (page 5-7)

Printing lists (page 5-8)

NOTE

The operation on Custom Box you perform from operation panel can also be made using Command Center RX.

% Command Center RX User Guide

Creating a New Custom Box

Custom boxes are created in Command Center RX.

#® Command Center RX User Guide

Editing and Deleting Custom Box
To change or delete a Custom box, use Command Center RX.

% Command Center RX User Guide

Storing Documents

Custom box stores the print data which is sent from a PC. For the operation of the printing from the PC, refer to the
following:

® Printer Driver User Guide
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Operation on the Machine > Using a Custom Box

Printing Documents

The procedure for printing documents in a custom box is explained below.

1 Display the screen.

1 [Menu] key > [A] [V¥] key > [Custom Box] > [»>] key > [A] [¥] key > [Select Box] >
[OK] key

2 Select the box containing the document you want to print, and select the [OK] key.
3 Select the [P] key.

NOTE

If a custom box is protected by a password, enter the correct password.

2 Print the document.

1 Select the document you want to print, and select the [OK] key.

To print all documents, select [Print All Files] and select the [OK] key.

2 Enter the print quantity, and select the [OK] key.

You can select a number between 001 and 999 as the number of copies.
3 Select the desired paper source and select the [OK] key.

4 Set Quiet Mode.
[A] [V¥] key > [Off] or [On] > [OK] key
P Quiet Mode (page 6-3)

5 Set Delete after Print.
[A] [¥] key > [Off] or [On] > [OK] key
If [On] is selected, automatically deletes a document from the box after printing is complete.

® Delete after Printed (page 6-3)

Printing of the selected document begins.

Editing Documents

To edit a document stored in a Custom box, use Command Center RX.

® Command Center RX User Guide
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Deleting Documents

The procedure for deleting documents in a custom box is explained below.

1 Display the screen.

1 [Menu] key > [A] [V¥] key > [Custom Box] > [»>] key > [A] [¥] key > [Select Box] >
[OK] key

2 Select the box containing the document you want to delete, and select the [OK] key.
3 Select the [»] key.

NOTE

If a custom box is protected by a password, enter the correct password.

2 Delete the document.

1 Select the document you want to delete > [OK] key
Select the [OK] key and finalize the selection.

If you want to delete all the documents, select [Delete All Files] > [OK] key.

2 [A][V]key > [Delete] > [OK] key

The document is deleted.

NOTE
If [V] is selected when "Copies 001" appears, or if [A] is selected when "Copies 999"
appears, [Delete] will appear.
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Printing lists

Print a file list

You can print a list of the documents in a selected Custom box. Use the procedure below to print a file list.

1 Display the screen.

1 [Menu] key > [A] [¥] key > [Custom Box] > [»] key > [A] [¥] key > [Select Box] >
[OK] key

2 Select a document list you want to print, and select the [OK] key.
3 Select the [»] key.

[N NOTE

If a custom box is protected by a password, enter the correct password.

2 Print a file list.
[A][V] key > [Print File List] > [OK] key > [OK] key

You can print a list of the documents in a selected Custom box.

Print a box list

You can print the Custom box list. Use the procedure below to print a box list.

1 Display the screen.
[Menu] key > [A][V¥] key > [Custom Box] > [»] key

2 Print a box list.
[A][V¥] key > [Print Box List] > [OK] key > [OK] key

You can print the Custom box list.
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Printing Documents Stored in Removable
USB Memory

Plugging USB memory directly into the machine enables you to quickly and easily print the files stored in the USB
memory without having to use a computer.

The following file types can be printed:
PDF file (Version 1.7 or older)
TIFF file (TIFF V6/TTN2 format)
JPEG file
XPS file
OpenXPS file
» PDF files you wish to print should have an extension (.pdf).
» Files to be printed should be saved no further down than the top 3 folder levels, including the root folder.

* Plug the USB memory directly into the USB Memory Slot.

1 Plug the USB memory.
Plug the USB memory into the USB Memory Slot.

Print the document

1 Display the screen.

[Menu] key > [A][V¥] key > [USB Memory] > [»>] key
2 Print the document.
[A][V¥]key > [Print File] > [OK] key > [OK] key
Select the document, and select the [OK] key.
Select the [OK] key.

A WO N =

Enter the print quantity, and select the [OK] key.

You can select a number between 001 and 999 as the number of copies.

a

Select the desired paper source and select the [OK] key.
6 Set Quiet Mode.

[A][V] key > [Off] or [On] > [OK] key

® Quiet Mode (page 6-3)

Printing of the selected file begins.
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Operation on the Machine > Printing Documents Stored in Removable USB Memory

Print a file list

1 Display the screen.
[Menu] key > [A] [¥] key > [USB Memory] > [»] key

2 Print a file list.
[A][V¥] key > [Print File List] > [OK] key > [OK] key

You can print a list of the files in USB memory.
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Operation on the Machine > Removing USB Memory

Removing USB Memory

Follow the steps below to remove the USB memory.

(&) IMPORTANT
Be sure to follow the proper procedure to avoid damaging the data or USB memory.

1 Display the screen.
[Menu] key > [A][V¥] key > [USB Memory] > [»] key

2 Select [Remove Devicel.
[A][V¥] key > [Remove Device] > [OK] key > [OK] key

3 Remove the USB memory.
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Functions Available on the Machine

For details on each function, see the table below.

. o Referen
Functions Description ererence
page
Quiet Mode Lower print speed for quiet processing. page 6-3
Del. after Print Automatically deletes a document from the box once printing is complete. page 6-3
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Functions

Quiet Mode

Lower print speed for quiet processing.

Select this mode when the running noise is uncomfortable.
It is possible to set the use of Quiet Mode for each function.
(Value: [Off] / [On])

NOTE

» The processing speed will be slower than normal when in Quiet Mode.

» This cannot be used when [Prohibit] is set for "Each Job".

® Each Job (page 7-28)

Delete after Printed

Automatically deletes a document from the box once printing is complete.
(Value: [Off] / [On])
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Setup and Registration (System Menu) > System Menu

System Menu

Configure settings related to overall machine operation.

Operation Method

Select the [Menu] key to show the settings on the message display. Then, select from the settings displayed.

® Operation Method (page 2-11)

NOTE

In order to change settings that require administer privileges, you must log in with administrator privileges.
The factory default administrator ID and administrator password are set as shown below.
Administrator ID: 3000

Administrator Password: 3000

Refer to Menu Settings on the following page and configure as needed.
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Menu Settings

This section explains the functions that can be configured in Menu. To configure the settings, select the item in System
Menu and select the setting item. For details on each function, see the table below.

Item Description Reference Page
Print Report Print reports to check the machine settings and status. page 7-4
Counter Check the number of sheets printed. page 2-40
Paper Settings Configure settings for paper. page 7-6
Print Settings Configure settings for printing. page 7-9
Wi-Fi Direct Set Set Wi-Fi Direct. page 7-11
Wi-Fi Settings Set Wi-Fi. page 7-11
Wired Network Configure wired network settings. page 7-13
Network Settings Configure network settings. page 7-14
Optional Network Configure settings for the optional Network Interface Kit or Wireless page 7-18
Network Interface Kit.
Message Language Select the language displayed on the message display. page 7-19
Date Setting Configure settings related to the date and time. page 7-19
Buzzer Set options for buzzer sound during the machine operations. page 7-20
RAM Disk Mode A RAM disk can be created and its size can be set. page 7-20
SSD Format an optional SSD. page 7-20
SD Card Format an SD/SDHC memory card. page 7-21
Error Handling Select whether to cancel or continue the job when error has occurred. page 7-21
ColorToner Empty Select whether printing is prohibited or the Print in Black and White page 7-21
setting is used for printing once the color toner runs out.
Sleep Level Set. Select the Sleep level. page 7-22
Power Off Rule (models for Select whether or not the machine enters Power Off mode. page 7-22
Europe)
Power Off Timer (models for Select whether to turn off the power automatically after a period of page 7-22
Europe) inactivity.
Disp. Status/Log Set the display method of the Status/Log. page 7-23
Low Toner Alert Set the amount of remaining toner to notify the administrator when to page 7-23
order a toner when the toner is running low.
Timer Configure settings related to the time. page 7-23
Security The security functions can be set up to protect printer operation and the page 7-25
print data.
User/Job Account Configures settings related to machine management. —
User Login:
® Overview of User Login Administration (page 8-2)
Job Accounting:
® Overview of Job Accounting (page 8-6)
Administrator The Administrator setting is a function that identifies a user who can use | page 7-27

the printer and manage other users.
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Item Description Reference Page
Adjust/Maintenance Adjust printing quality and conduct machine maintenance. page 7-28
Restart Printer Restart the machine without turning the power switch off. Use this to deal | page 7-28

with any unstable operation by the machine. (Same as the computer

restart.)
Op functions You can use the optional applications installed on this machine. page 7-28
Software Check the machine's system and engine software versions. page 7-28
Wired Status The wired network connection status appears. page 7-28
Opt. Network Status The connection status of an optional network interface kit appear. page 7-29
Wi-Fi Status The wireless LAN status appears. page 7-29
Wi-Fi Direct Information on the device that is connected by Wi-Fi Direct appears. page 7-30

Report Print

Print reports to check the machine settings and status.

[Menu] key > [A][ V] key > [Report Print] > [»>] key

Item Description

Print Menu Map Prints Menu Map to check the settings of the machine.

Menu Map 0} KYOCERA

Print Config. List Prints the list of settings of the system menu. The settings of this machine can be checked.
Configuration List 1} KYOCERA
Firmware Version

Print Status Page Prints the status page, allowing you to check the information including current settings, memory

capacity, and optional equipment installed.

Status Page 0} KYOCERA
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Item Description

Print Fonts List Prints the font list, allowing you to check the font samples installed in the machine.

Font Name | [scatablesBitmap] [ Passwore d | [ selectior [FSET] Font ID
(1111]]] (1111]]] [ 111} LLLLILL L)) (111}

| _ _| e
(111}
Font Name. Scalable/Bitmap] [_P: ction LLLL]

| [

Print RAM Disk File List You can print a list of the files in the RAM disk.

NOTE

This setting is displayed when [RAM Disk Mode] is set to [On].

Print SSD File List You can print a list of the files in the SSD.

NOTE

Displayed when the optional SSD is installed.

Print SD Card File List You can print a list of the files in the SD Card.

NOTE
Displayed when the SD Card is installed.

Print Data Sanitization Report | Prints the data sanitization report.
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Paper Settings
[Menu] key > [A] [ VY] key > [Paper Settings] > [»>] key

Configure settings for paper.

Item Description

MP Tray Size Select the paper size to be used in the multipurpose tray.

Values: Envelope Monarch, Envelope #10, Envelope DL, Envelope C5, Executive, Letter,
Legal, A4, B5, A5, A6, B6, Envelope #9, Envelope #6, ISO B5, Custom,

Hagaki (Cardstock), OufukuHagaki (Return postcard), Oficio Il, 216 x 340 mm, 16K,
Statement, Folio, Youkei 2, Youkei 4

MP Tray Type*1 Select the media type of paper to be used in the multipurpose tray.

Values: PLAIN (60 - 105 g/m?), TRANSPARENCY, PREPRINTED, LABELS, BOND,
RECYCLED, VELLUM (60 - 105 g/m?), ROUGH, LETTERHEAD, COLOR, PREPUNCHED,
ENVELOPE, CARDSTOCK, COATED, THICK (106 - 220 g/m?), HIGH QUALITY,

Custom 1-8

Cassette1 (to 4) Size™? Select the paper size to be used in Cassettes 1 to 4.
Values

Cassette 1: Executive, Letter, Legal, A4, B5, A5, A6, B6, ISO B5, Custom, Oficio II,
216 x 340 mm, 16K, Statement, Folio

Cassette 2 to 4: Envelope Monarch, Envelope #10, Envelope DL, Envelope C5,
Executive, Letter, Legal, A4, B5, A5, B6, Envelope #9, Envelope #6, ISO B5, Custom,
Oficio ll, 216 x 340 mm, 16K, Statement, Folio, Youkei 2, Youkei 4

If custom is selected, register the custom sizes used in cassettes 1 to 4.
Values

Cassette 1:

Metric

X: 105 to 216 mm (in 1 mm increments)
Y: 148 to 356 mm (in 1 mm increments)

Inch

X: 4.13 to 8.50" (in 0.01" increments)
Y: 5.83 to 14.02" (in 0.01" increments)

Cassette 2 to 4:
Metric

X: 92 to 216 mm (in 1 mm increments)
Y: 162 to 356 mm (in 1 mm increments)

Inch

X: 3.62 to 8.50" (in 0.01" increments)
Y: 6.38 to 14.02" (in 0.01" increments

X=Length, Y=Width

Vertical
X
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Item Description

Cassette1 (to 4) Type'> Select the media type of paper to be used in Cassettes 1 to 4.
Values

Cassette 1: PLAIN (60 - 105 g/m?), PREPRINTED, BOND, RECYCLED,
VELLUM (60 - 105 g/m?), ROUGH, LETTERHEAD, COLOR, PREPUNCHED,
THICK (106 - 163 g/m?), HIGH QUALITY, Custom 1 - 8

Cassette 2 to 4: PLAIN (60 - 105 g/m?), PREPRINTED, LABELS, BOND, RECYCLED,
VELLUM (60 - 105 g/m?), ROUGH, LETTERHEAD, COLOR, PREPUNCHED, ENVELOPE,
COATED, THICK (106 - 220 g/m?), HIGH QUALITY, Custom 1 - 8

Type Adjust Select weight for each media type.

For Custom 1 to 8, settings for duplex printing and media type name can be changed.

P Type Adjust Setting (page 7-8)

Reset Type Adjust Resets the attribute settings of all media types set in "Media Type Set".
® Type Adjust Setting (page 7-8)
Paper Setup Msg Set whether to display the confirmation screen for the paper setting when a new paper is set for
each cassette.
MP Tray

Values: On, Off

NOTE

[Cassette 2] to [Cassette 4] are shown when the optional paper feeder is installed.

Cassette 1 (to 4)

*1 To change to a media type other than "Plain".
= Type Adjust Setting (page 7-8)
*2 Only set this when the size dial on the cassette is set to "Other".
*3 To change to a media type other than "Plain".
® Type Adjust Setting (page 7-8)
When a paper weight that cannot be loaded in the cassette is set for a media type, that media type does not appear.
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Type Adjust Setting

The following media type and paper weight combinations are available.

Paper Weight

Weight (g/m?)

Paper Weight

Weight (g/m?)

Light 52 g/m? to 59 g/m? Heavy 11 106 g/m? to 135 g/m?
Normal 1 60 g/m? to 74 g/m? Heavy 21 136 g/m? to 163 g/m?
Normal 2 75 g/m? to 90 g/m? Heavy 3" 164 g/m? to 220 g/m?
Normal 3 91 g/m?to 105 g/m? Extra Heavy"" Transparencies

*1 The processing speed will be slower than normal.

Each media type's default weight is indicated.

Media Type Default Media Type Default
PLAIN Normal 2 CARDSTOCK Heavy 1
TRANSPARENCY Extra Heavy COLOR Normal 2
ROUGH Normal 3 PREPUNCHED Normal 2
VELLUM Normal 1 LETTERHEAD Normal 2
LABELS Heavy 1 ENVELOPE Heavy 2
RECYCLED Normal 2 THICK Heavy 2
PREPRINTED Normal 2 HIGH QUALITY Normal 2
BOND Normal 3 COATED Heavy 1
CUSTOM 1 - 8 Normal 2

For Custom 1 to 8, settings for duplex printing can be changed.

Duplex Path Enable

Duplex printing allowed.

Description

Disable

Duplex printing not allowed.
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Print Settings
[Menu] key > [A] [ V] key > [Print Settings] > [»>] key

Configure settings for printing.

Item Description

Paper Source Select the default paper source from Cassette 1-4 and multipurpose tray.
Values: MP Tray, Cassette 1 (to 4)

NOTE

[Cassette 2] to [Cassette 4] are shown when the optional paper feeder is installed.

Auto Cass.Change Select the following actions when the paper runs out in the paper source while printing.
Values: On, Off

NOTE

When selecting [Off], the machine displays "Load Cassette #" (# is a cassette number) or
"Load MP Tray", and stops printing.

Load the paper according to the paper source displayed to resume printing.

To print from the other paper cassette, select [A] or [ V] key to display "Use alternative?",
select [A] or [ V] key to select the desired paper source, and then select the [OK] key.

When selecting [On], the machine continues printing automatically when the other cassette
contains the same paper as the currently-used cassette.

MP Tray Priority If paper is set in the multipurpose tray then it is possible for priority to be given to that
multipurpose tray in the paper feed.

Values

Off: The printer driver settings are followed.

Auto Feed: If Auto is selected in the printer driver and there is paper in the multipurpose
tray then the paper feed will be from the multipurpose tray.

Always: If there is paper in the multipurpose tray then the paper feed will be from the
multipurpose tray regardless of what is set in the printer driver.

Paper Feed Mode While printing from the computer, select how to feed paper when the paper source and type are
specified.

Values
Auto: Search the paper source that matches the selected paper size and type.
Fixed: Print on paper loaded in the specified paper source.

Duplex Select binding orientation for duplex mode.
Values: Off, Short edge bind, Long edge bind

Override A4/LT Select whether to treat A4 size and Letter, which are similar in size, as the same size when
printing.

Values

Off: A4 and Letter are not regarded as the same in size.

On: A4 and Letter are regarded as the same in size. The machine will use whichever size
is in the paper source.

Emulation Select the emulation for operating this machine by commands oriented to other types of
printers.
Values: PCL 6, KPDL, KPDL(Auto)
Error Report When you have selected [KPDL] or [KPDL (Auto)], select the [»] key to set "Error Report".
Values: Off, On
Color Mode You can choose whether reports are printed in color or black and white.

Values: Black & White, Color
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Item Description

Print Quality Set the Print Quality.
KIR Mode The machine is equipped with the smoothing function, which realizes an excellent printing of
about 9600 dpi (600 dpi x 15 gradation) x 600 dpi.
Value: Off, On
Gloss Mode Gloss Mode increases the effect of glossiness in printing. However, printing takes longer time.

Values: Off, On

@ IMPORTANT

[On] is not available when [LABELS] and [TRANSPARENCY] is selected as the paper
type setting.

o Cassettel (to 4) Type (page 7-7)
MP Tray Type (page 7-6)

Depending on the paper used, printing in gloss mode may cause curl in paper.
To reduce curl, try using thicker paper.

EcoPrint Mode

EcoPrint conserves toner when printing. This is recommended for test copies where faded
printing is not a problem.

Values: Off, On

EcoPrint SavelLuvl

Select the default EcoPrint SavelLvl.
Values: 1 (Lower) to 5 (Higher)

NOTE

Raising the level reduces toner consumption, but image quality falls.

Resolution Set the resolution used for printing.
Value: 1200 dpi, 600 dpi
NOTE
Settings that are received from the printer driver have priority over the operation panel settings.
Page Setting You can set print preferences such as the number of pages and print orientation.
Copies Set the default number of copies, from 1 to 999.
Value: 1 to 999 copies
Orientation You can select portrait (upright) or landscape (sideways) page orientation.
Value: Portrait, Landscape
Wide A4 Turn this to on to increase the maximum number of characters that can be printed in a line for
an A4 page (78 characters at 10 pitch) and Letter size page (80 characters at 10 pitch). This
setting is only effective in PCL 6 emulation.
Value: Off, On
XPS FitTo Page Set the default value for the XPS fit to page function.
Value: Off, On
TIFF/JPEG Size Select the image size (resolution) when printing JPEG or TIFF file.
Value: Paper Size, Image Resolution, Print Resolution
User Name Set whether the user name set in the printer driver is displayed.
Value: Off, On
Job Name Set whether the job name set in the printer driver is displayed.

Value: Off, Job Name, Job No.+Job Name, Job Name+Job No.
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Wi-Fi Direct Set

[Menu] key > [A] [ VY] key > [Wi-Fi Direct Set] > [»] key
Set Wi-Fi Direct.

NOTE

This function is displayed when the optional Wireless Network Interface Kit is installed.

Wi-Fi Direct
Item Description

Wi-Fi Direct Select whether to use Wi-Fi Direct.
Value: Off, On

Auto Disconnect Automatically disconnect devices connected through Wi-Fi Direct.
Value: Off, On
NOTE
This function is displayed when [Wi-Fi Direct] is set to [On].

Timer (Day:Hour:Min) If you select [ON] to Auto Disconnect, set the waiting time for automatic disconnection.

Value: Day (00 to 99), Hour (00 to 23), Minute (00 to 59)

Wi-Fi Settings
[Menu] key > [A] [ V] key > [Wi-Fi Settings] > [»>] key
Set Wi-Fi.

NOTE

This function is displayed when the optional Wireless Network Interface Kit is installed.

Wi-Fi
Description
Wi-Fi Select whether to use Wi-Fi.
Value: Off, On
Quick Setup
Item Description
Quick Setup If the machine will connect to an access point that supports the automatic wireless network

setup, connection settings can be configured by Quick Setup.

Push Button If the access point supports the push button method, wireless settings can be configured using
the push button. This setting executes push button, and the connection is started by pressing
the push button on the access point.

[ NOTE

The push button method supports only the WPS.

PIN(Device) Starts connection using the machine's PIN code. Enter the PIN code into the access point. The
PIN code of the machine is automatically generated.
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TCP/IP

Item Description

TCP/IP Select whether to use TCP/IP (IPv4) Protocol.
Value: Off, On

DHCP Select whether to use the DHCP (IPv4) server.
Value: Off, On

Auto-IP Select whether to use Auto-IP.
Value: Off, On

IP Address Set the IP address.
Value: #HE.HEE HEHE

NOTE

When DHCP is set to [On], this item is displayed only and cannot be entered.

Subnet Mask Set the IP subnet mask.
Value: ##H 1 HHHE

NOTE

When DHCP is set to [On], this item is displayed only and cannot be entered.

Gateway Set the IP gateway address.
Value: #H# i

NOTE

When DHCP is set to [On], this item is displayed only and cannot be entered.

(&) IMPORTANT
* When setting the Auto-IP, enter "0.0.0.0" in [IP Address].

» After changing the setting, restart the network or turn the machine OFF and then ON.
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TCP/IP (IPv6)

Item Description

TCP/IP (IPv6) Select whether to use TCP/IP (IPv6).
Value: Off, On

RA(Stateless) Select whether to use RA (Stateless).
Value: Off, On

NOTE

This function is displayed when [TCP/IP (IPv6)] is set to [On].

DHCPv6 Select whether to use the DHCP (IPv6) server.
Value: Off, On

NOTE

This function is displayed when [TCPI/IP (IPv6)] is set to [On].

(&) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

Restart Network

Description

Restart Network Restarts the network.

Wired Network

[Menu] key > [A] [ V] key > [Wired Network] > [»] key

Configure wired network settings.

Item Description

TCP/IP For details on setting value.
® TCP/IP (page 7-12)

TCP/IP (IPv6) For details on setting value.
» TCP/IP (IPv6) (page 7-13)

LAN Interface Specify the settings for the LAN interface to be used.
Value: Auto, 10BASE-Half, 10BASE-Full, 100BASE-Half, 100BASE-Full, 1000BASE-T

Restart Network Restarts the network.

(&) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

7-13
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Network Settings
[Menu] key > [A] [ V] key > [Network Settings] > [»] key

Configure network settings.

Item Description

Communication™

Select the network to be used for the network authentication.
Value: Wi-Fi, Wired Network

SSL Server Select whether to use SSL.
Value: Off, On
IPSec Select whether to use IPSec.
Value: Off, On
Bonjour Select whether to use Bonjour.
Value: Off, On
NOTE
This function is displayed when TCP/IP is set to [On].
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [Bonjour] is set to [On].

IP Filter (IPv4)

Select whether to communicate using IP Filter (IPv4).
Value: Off, On

IP Filter (IPv6)

Select whether to communicate using IP Filter (IPv6).
Value: Off, On

NetBEUI Selects whether to receive documents using NetBEUI. 2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [NetBEUI] is set to [On].

SNMPv3 Select whether to communicate using SNMPv3."2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network

NOTE

This function is displayed when [SNMPv3] is set to [On].

Wired Network

FTP(Server) Select whether to receive documents using FTP. 2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi™1 Value: Disable, Enable

NOTE

This function is displayed when [FTP(Server)] is set to [On].
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Item Description

SNMP Select whether to communicate using SNMP.™
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network NOTE
This function is displayed when [SNMP] is set to [On].

SMTP Select whether to send E-mail using SMTP.
Value: Off, On
POP3 Select whether to receive E-mail using POP3.
Value: Off, On
RAW_Port Select whether to receive documents using Raw Port.”2
Value: Off, On
Wi-Fi Direct™? Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

Wired Network NOTE

This function is displayed when [RAW_Port] is set to [On].

LPD Selects whether to receive documents using LPD."2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.

Wi-Fi'! Value: Disable, Enable

Wired Network NOTE

This function is displayed when [LPD] is set to [On].

IPP Selects whether to receive documents using IPP. To use the IPP protocol, select [Not* Sgcure
(IPP&IPPS)] on IPP Security under Security Settings from the Command Center RX. 2 3
Value: Off, On
Wi-Fi Direct ™! Set whether to enable this function for each network.

Wi-Fi'! Value: Disable, Enable

Wired Network NOTE

This function is displayed when [IPP] is set to [On].

IPP over SSL Select whether or not to use IPP over SSL."% ™3
Value: Off, On

NOTE

When selecting [On], it also requires a certificate for SSL. the default certificate is the
self-certificate of the machine.

% Command Center RX User Guide

Wi-Fi Direct™ Set whether to enable this function for each network.

Wi-Fi'! Value: Disable, Enable

Wired Network NOTE

This function is displayed when [IPP over SSL] is set to [On].
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Item Description

Wired Network

HTTP Select whether to communicate using HTTP.”2
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi™1 Value: Disable, Enable

NOTE

This function is displayed when [HTTP] is set to [On].

Wired Network

HTTPS Select whether to communicate using HTTPS.2 3
Value: Off, On
Wi-Fi Direct™! Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

NOTE

This function is displayed when [HTTPS] is set to [On].

Wired Network

ThinPrint Select whether to use ThinPrint."2 3
Value: Off, On
NOTE
This function is displayed only when the optional ThinPrint Option is activated.
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

NOTE

This function is displayed when [ThinPrint] is set to [On].

ThinPrint over SSL

To use the Thin Print over SSL protocol, set [ThinPrint Over SSL] to [On].”% ™3
Value: Off, On

[N NOTE

» This function is displayed when [ThinPrint] is set to [On].

* When selecting [On], it also requires a certificate for SSL. The default certificate is the
self-certificate of the machine.

% Command Center RX User Guide

Wi-Fi Direct™

Wi-Fi1

Wired Network

Set whether to enable this function for each network.
Value: Disable, Enable

NOTE

This function is displayed when [ThinPrint over SSL] is set to [On].

Wired Network

WSD-PRINT Set whether to use our proprietary web services.
Value: Off, On
Wi-Fi Direct™? Set whether to enable this function for each network.
Wi-Fi'! Value: Disable, Enable

NOTE

This function is displayed when [WSD-PRINT] is set to [On].
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Item Description

Enhanced_WSD

Set whether to use our proprietary web services. 2

Value: Off, On

Wi-Fi Direct™

Wi-Fi'1

Wired Network

Set whether to enable this function for each network.
Value: Disable, Enable

NOTE

This function is displayed when [Enhanced_WSD] is set to [On].

Wired Network

EnhancedWSD(SSL) Set whether to use our proprietary web services over SSL."2 73
Value: Off, On
Wi-Fi Direct™ Set whether to enable this function for each network.
Wi-Fi™1 Value: Disable, Enable

NOTE

This function is displayed when [EnhancedWSD(SSL)] is set to [On].

Wired Network

REST Select whether or not to use REST.
Value: Off, On
Wi-Fi Direct™’ Set whether to enable this function for each network.
Wi-Fi™1 Value: Disable, Enable

NOTE

This function is displayed when [REST] is set to [On].

REST over SSL

Select whether or not to use REST over SSL."2 ™3
Value: Off, On

[ NOTE

» This function is displayed when [REST over SSL] is set to [On].

*  When selecting [On], it also requires a certificate for SSL. The default certificate is the
self-certificate of the machine.

Wi-Fi Direct™

Wi-Fi'1

Wired Network

Set whether to enable this function for each network.
Value: Disable, Enable

NOTE

This function is displayed when [REST over SSL] is set to [On].

*1
*2
*3

This function is displayed when the optional Wireless Network Interface Kit is installed.
The setting will be changed after restarting the device or network.
Set [SSL Server] to [On] in Network Settings.

P SSL Server (page 7-14)

(&) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.
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Optional Network
[Menu] key > [A] [ Y] key > [Optional Network] > [»] key

Configure settings for the optional Network Interface Kit or Wireless Network Interface Kit.

NOTE

This menu is displayed when the optional network interface kit or Wireless Network Interface Kit is installed.

Item Description

TCP/IP For details on setting value. (Except [Bonjour])
2 TCP/IP (page 7-12)

For the setting value of [Bonjour].

= Bonjour (page 7-14)

TCP/IP (IPv6) For details on setting value.

= TCP/IP (IPv6) (page 7-13)

NetWare Use NetWare to receive documents.
Value: Off, On

AppleTalk Selects whether to receive documents using AppIeTaIk.*1
Value: Off, On

IPSec Select whether to use IPSec.
Value: Off, On

LAN Interface Select the LAN Interface type.”!

Value: Auto, 10BASE-Half, 10BASE-Full, 100BASE-Half, 100BASE-Full, 1000BASE-T
NOTE

This function is displayed when the optional network interface kit is installed.

MACAddressFilter Select whether to use MAC Address Filter.

® Operation Guide for the optional network interface kit
Value: Off, On

Restart Network Restarts the network card of the device.

*1  The setting will be changed after restarting the device or network.
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Device Common
Configures overall machine operation.

Message Language

[Menu] key > [A][V¥] key > [Device Common] > [»] key > [A] [V ] key > [Message Language] > [OK] key

Description

Message Language Select the language displayed on the message display.

Date Setting
[Menu] key > [A][V¥] key > [Device Common] > [»] key > [A] [V ] key > [Date Setting] > [»>] key

Configure settings related to the date and time.

Item Description

Date (Year/Mon/Day) Set the date for the location where you use the machine.
Value: Year (2000 to 2037), Month (01 to 12), Day (01 to 31)

P Setting Date and Time (page 2-14)

NOTE

If you change the date while using the trial version of an application, you will no longer be able
to use the application.

Time (Hour:Min:Sec) Set the date and time for the location where you use the machine.
Value: Hour (00 to 23), Minute (00 to 59), Second (00 to 59)

® Setting Date and Time (page 2-14)

NOTE

If you change the time while using the trial version of an application, you will no longer be able
to use the application.

Date Format Select the display format of year, month, and date. The year is displayed in Western notation.
Value: Month/Day/Year, Day/Month/Year, Year/Month/Day

Time Zone Set the time difference from GMT. Choose the nearest listed location from the list. If you select
a region that utilizes summer time, configure settings for summer time.

P Setting Date and Time (page 2-14)

Summer Time
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Buzzer

[Menu] key > [A][V¥] key > [Device Common] > [»>] key > [A] [ V] key > [Buzzer] > [»] key

Set options for buzzer sound during the machine operations.

Item Description

Key Confirmation Emit a sound when a key is selected on the operation panel.
Value: On, Off

Job End Emit a sound when a print job is normally completed.
Value: On, Off

Ready Emit a sound when the warm-up is completed.
Value: On, Off

Error Emit a sound when errors occur.
Value: On, Off

RAM Disk Mode
[Menu] key > [A] [ V] key > [Device Common] > [»>] key > [A] [ V] key > [RAM Disk Mode] > [OK] key

Item Description

RAM Disk Mode A RAM disk can be created and its size can be set.

Creating a RAM disk makes it possible to print from a Job Box.
Value

RAM Disk Mode: On, Off

RAM Disk Size: The setting range varies depending on the amount of memory installed
and the option memory usage setting.

(&) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

SSD
[Menu] key > [A] [V ] key > [Device Common] > [»] key > [A] [ V] key > [SSD] > [»] key

Format an optional SSD.
When an optional SSD is inserted into the printer for the first time, it must be formatted before use.

(&) IMPORTANT
Formatting will destroy any existing data on a storage device including a used SSD.

NOTE

This function will not be displayed when the optional Data Security Kit is installed.
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SD Card
[Menu] key > [A][V¥] key > [Device Common] > [»>] key > [A] [V ] key > [SD Card] > [»] key
Format an SD/SDHC memory card.

A new SD card must be formatted before it can be used in the machine.

(&) IMPORTANT
Formatting will destroy any existing data on a storage device including a used SD card.

Error Handling
[Menu] key > [A] [ Y] key > [Device Common] > [»] key > [A] [ VY] key > [Error Handling] > [»] key

Select whether to cancel or continue the job when error has occurred.

Item Description

Duplex Select what to do when duplex printing is not possible for the selected paper size and media type.
Value

Off: Printed in 1-sided

On: Message to cancel printing is displayed.

Paper Mismatch Select what to do when the selected paper size or type does not match paper size or type
loaded in the specified paper source while printing from the computer by specifying the
cassette or multipurpose tray.

Value
Off: The setting is ignored and the job is printed.
On: Message to cancel printing is displayed.

MP Tray Empty Turn this setting to [On] if you want the error displayed when the multipurpose tray is
configured as the default paper source, and there is no paper in the multipurpose tray, or turn it
to [Off] not to have the error displayed.

Value: On, Off

ColorToner Empty
[Menu] key > [A] [ V] key > [Device Common] > [»] key > [A] [ V] key > [ColorToner Empty] > [OK] key

Description

ColorToner Empty Select whether printing is prohibited or the Print in Black and White setting is used for printing
once the color toner runs out.

Value: Stop printing, Printin B & W
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Sleep Level Set.
[Menu] key > [A][V¥] key > [Device Common] > [»] key > [A] [V ] key > [Sleep Level Set.] > [»] key

Item Description

Sleep Level (models except for | Select the Sleep level.

Europe) Set the Energy Saver mode to reduce power consumption even more than Quick Recovery
mode.

Value: Quick Recovery, Energy Saver

Card Reader™’ Set whether to use the Energy Saver mode for Card Reader.
Value: Off, On

NOTE

When the machine enters Energy Saver, the ID card cannot be recognized.

Application Set whether or not power save priority is used when an application starts.
Value: Off, On

*1 Displayed only when the optional Card Authentication Kit is activated.

Power Off Rule (models for Europe)
[Menu] key > [A][V¥] key > [Device Common] > [»] key > [A] [ V] key > [Power Off Rule] > [»] key
Select whether or not the machine enters Power Off mode.

Item Description

Network Set whether or not the machine enters Power Off mode for Network.
Value: Off, On

Even when [Network] is set to [Off], if the machine does not communicate with the other
devices, the machine will enter Power Off Mode.

USB Cable Set whether or not the machine enters Power Off mode for USB cable.
Value: Off, On

Even when [USB Cable] is set to [Off], if the machine does not communicate with the other
devices, the machine will enter Power Off Mode.

USB Host Set whether or not the machine enters Power Off mode for USB host.
Value: Off, On

RAM Disk Set whether or not the machine enters Power Off mode for RAM Disk.
Value: Off, On

NIC Set whether or not the machine enters Power Off mode for NIC.
Value: Off, On

Power Off Timer (models for Europe)
[Menu] key > [A] [ V] key > [Device Common] > [»] key > [A] [ V] key > [Power Off Timer] > [»] key

Description

Power Off Timer Select whether to turn off the power automatically after a period of inactivity.

Value: 1 hour, 2 hours, 3 hours, 4 hours, 5 hours, 6 hours, 9 hours, 12 hours, 1 day,
2 days, 3 days, 4 days, 5 days, 6 days, 1 week
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Disp. Status/Log

[Menu] key > [A] [ V] key > [Device Common] > [»] key > [A] [ V] key > [Disp. Status/Log] > [»] key

Item

Description

Disp. Status/Log

Set the display method of the Status/Log.

If the ID card authentication is enabled, this setting is applied when you refer to the print job or
print job log from Command Center RX.

JobsDetailStatus

Value: Show All, My Jobs Only, Hide All

Jobs Log

Value: Show All, My Jobs Only, Hide All

Low Toner Alert

[Menu] key > [A][V¥] key > [Device Common] > [»] key > [A] [V¥] key > [Low Toner Alert] > [»>] key

Item

Description

Low Toner Alert

Set the amount of remaining toner to notify the administrator when to order a toner when the
toner is running low.

Value: Off, On
Low Toner Alert: Set the toner level for notification of low toner.

The setting range is 5 to 100% (in 1% increments). Displayed when
[Off/On] is set to [On] and the [ V] key is selected.

NOTE

Selecting [Off] alerts you low toner when the amount of remaining toner becomes 5%.

Timer

[Menu] key > [A] [ VY] key > [Timer] > [»] key

Configure settings related to the time.

Item

Description

Auto Panel Reset

If no jobs are run for a certain period of time, automatically reset settings and return to the
default setting. Select to use Auto Panel Reset or not.

Value: Off, On

NOTE
The time allowed to elapse before the panel is reset is set with the following:

#® Panel Reset Timer (page 7-23)

Panel Reset Timer

If you select [On] for Auto Panel Reset, set the amount of time to wait before Auto Panel Reset.
Value: 5 to 495 seconds (in 5 second increments)

NOTE

This function is displayed when [Auto Panel Reset] is set to [On].

Sleep Timer

Set amount of time before entering Sleep.
Value

For Europe

1 to 60 minutes (1 minute increments)
Except for Europe

1 to 240 minutes (1 minute increments)

® Sleep and Auto Sleep (page 2-27)
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Item Description

Auto Error Clear If an error occurs during processing, processing stops to wait for the next step to be taken by
the user. In the Auto Error Clear mode, automatically clear the error after a set amount of time
elapses.

Value: Off, On
Error Clear Timer If you select [On] for Auto Error Clear, set the amount of time to wait before automatically

clearing errors.
Value: 5 to 495 seconds (in 5 second increments)

NOTE

This function is displayed when [Auto Err. Clear] is set to [On].

FormFeed TimeOut Receiving print data from the computer, the machine may sometimes wait if there is no
information signaling that the last page does not have any more data to be printed. When the
preset timeout passes, the machine automatically prints paper. The options are between 5 and
495 seconds.

Value: 5 to 495 seconds (in 5 second increments)

WeeklyTimer Set. Configure settings for switching the machine to OFF and waking it automatically at a specified
time for each day of the week.
Value: Off, On
Retries™! Set whether or not retry of machine power-off is performed.

Value: Limited, Unlimited

Retry Times 2 Set the number of retries for turning OFF this machine.
Value: 0 to 10 times

Retry Interval 2 Set the retry interval.
Value: 10 to 60 seconds (increments of 1 seconds)

Pwr On Time (###.)*1 Set whether or not the machine power will turn on at a time specified for each day of the week.
Value: Disable, Enable

Power On Time For each day of the week, specify the time at which the machine power will turn on.
Value: Hour (00 to 23), Minute (00 to 59)

Pwr Off Time (###.)*1 Set whether or not the machine power will turn off at a time specified for each day of the week.
Value: Disable, Enable

Power Off Time For each day of the week, specify the time at which the machine power will turn off.
Value: Hour (00 to 23), Minute (00 to 59)

*1  This function is displayed when [WeeklyTimer Set.] is set to [On].
*2  This function is displayed when [Retries] is set to [Limited].
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Security

The security functions can be set up to protect printer operation and the print data.

I/F Block
[Menu] key > [A] [ V] key > [Security] > [»>] key > [A] [ V] key > [I/F Block] > [»] key

This allows you to protect this machine by blocking the interface with external devices such as USB hosts.

Item Description

USB Host This locks and protects the USB port (USB host).
Value: Unblock, Block

USB Device This locks and protects the USB interface connector (USB Device).
Value: Unblock, Block

Option I/F This locks and protects the optional interface slots.
Value: Unblock, Block

USB Storage This locks and protects the USB memory slot.
Value: Unblock, Block

NOTE

This function is available when USB Host is set to [Unblock].

(@) IMPORTANT
After changing the setting, restart the network or turn the machine OFF and then ON.

Security Level

[Menu] key > [A] [ V] key > [Security] > [»>] key > [A] [ V] key > [Security Level] > [OK] key

Item Description

Security Level Specify the security level.
Value:

Very High: In addition to [High] setting, this setting disables the machine settings to be
changed from external command.

High: This is the security setting we recommend. Use this setting normally.

Low: This mode is used during maintenance. Do not use normally.
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SSD Initializ.
[Menu] key > [A] [ V] key > [Security] > [»>] key > [A] [ V] key > [SSD Initializ.] > [»>] key

Item Description

SSD Initializ. This changes security function settings.

NOTE

» This function is displayed when the optional SSD is installed and the optional Data Security
Kit is activated.

* Input of the security password is required to change security function settings. The initial
setting for the Security Password is "000000".

SecurityPasswd You can customize the security password so that only the administrator can use the security kit.
Enter a password that uses 6 to 16 alphanumeric characters and symbols.
You will need to enter the password again for confirmation.

) IMPORTANT
Avoid any easy-to-guess numbers for the security password (e.g. 11111111 or 12345678).

Initialization This can be used to delete all the data stored in the SSD. Overwrite all the data stored in the
SSD when disposing of the machine.

@ IMPORTANT

If you accidentally turn the power switch off during initialization, the SSD might possibly
crash or initialization might fail.

NOTE

If you accidentally turn off power during initialization, turn it back on.
Initialization will restart automatically.
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Data Security
[Menu] key > [A] [ V] key > [Security] > [»>] key > [A] [ V] key > [Data Security] > [»>] key

Configure settings for data stored in the machine's memory.

Item Description

DataSanitization Return the following information registered in the machine to the factory defaults.
» System settings
+ Data saved in Custom Box

* Optional applications

@ IMPORTANT

Data saved in an application or SD card cannot be erased. To erase data on an SD card,
you must format the SD card.

® SD Card (page 7-21)

NOTE

* Once in progress, the processing cannot canceled.

» Before executing this function, disconnect modular, network, and other cables.
» Before performing this function, set all interface block settings to [Unblock].
=% |/F Block (page 7-25)

» Do not turn off the main power switch while sanitizing the data. If the main power is turned
off during data erasing, erasing will be executed automatically when the power is restored,
however, complete erasure cannot be guaranteed.

Run Immediately | Data Sanitization will be performed.

Schedule Completely erase address and image data saved in the device at the scheduled time.
Value: Off, On

If [On] is selected, set the date and time that sanitization is to be performed. The setting range
is Year (2000 to 2037), Month (1 to 12), Day (1 to 31), Hour (00 to 23).

Device Use The device use restriction after the data sanitization is completed.
The device cannot be used if [Prohibit] is selected.
Value: Permit, Prohibit

User/Job Account
[Menu] key > [A][V¥] key > [User/Job Account] > [»>] key
Configure settings related to machine management.

® Overview of User Login Administration (page 8-2)

Overview of Job Accounting (page 8-6)
Unknown ID Job (page 8-20)

Administrator
[Menu] key > [A][V¥] key > [Administrator] > [»] key
The Administrator setting is a function that identifies a user who can use the printer and manage other users.

® Administrator settings (page 8-21)
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Adjust/Maintenance
[Menu] key > [A] [ Y] key > [Adjust/Maintenance] > [»>] key

Adjust printing quality and conduct machine maintenance.

Item Description

Quiet Mode Lower print speed for quiet processing.
Quiet Mode Set the Quiet Mode. Select this mode when the running noise is uncomfortable.
Value: Off, On
Each Job It is possible to set the use of Quiet Mode for each job. Set whether or not to permit the setting

for each job.
Value: Permit, Prohibit

ColorCalibration This machine contains a calibration function that automatically makes adjustments to
compensate for changes that occur over time due to variations in the ambient temperature and
humidity. This function can be used for fine adjustment of tone and color drift to print in the
optimum color.

® ColorCalibration (page 9-21)
If color tone does not improve or color drift does not improve after executing this color

adjustment, refer to the following:
= Registration (page 9-21)

Registration Normal When first installing the machine or moving it to a new location, color drift during printing may
occur. Use this function to correct the color position of each of cyan, magenta and yellow to
Registration Details resolve color drift.

® Registration (page 9-21)

Restart Printer Restart the machine without turning the power switch off. Use this to deal with any unstable
operation by the machine. (Same as the computer restart.)

Service Setting Settings for machine maintenance and inspection. This menu is primarily used by service
technicians to perform maintenance.

Op functions
[Menu] key > [A] [ V] key > [Op functions] > [»] key

Description

Op functions You can use the optional applications installed on this machine.
=® Optional Applications (page 10-6)

Software
[Menu] key > [A] [ V] key > [Software] > [»] key

Description

Version Check the machine's system and engine software versions.

Wired Status

[Menu] key > [A][V¥] key > [Wired Status]

The wired network connection status appears.
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Opt. Network Status

[Menu] key > [A][V¥] key > [Opt. Network Status] > [»>] key
The connection status of an optional network interface kit appear.

Wi-Fi Status
[Menu] key > [A] [ V] key > [Wi-Fi Status]

The wireless LAN status appears.

NOTE

This function is displayed when the optional Wireless Network Interface Kit is installed.

Item Description

Wi-Fi Status Check the wireless LAN status.

NetwkName(SSID) Check the SSID (Service Set Identifier) of the wireless LAN to which the machine connects.

NOTE

» This function is displayed when [Wi-Fi] is set to [On].

* Detailed information is displayed when [»] key is clicked.
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Wi-Fi Direct
[Menu] key > [A] [ VY] key > [Wi-Fi Direct]

Information on the device that is connected by Wi-Fi Direct appears.

NOTE

This function is displayed when the optional Wireless Network Interface Kit is installed.

Item Description

Wi-Fi Direct Check the current number of connections.
PushButton Setup Execute the push button of the device you want to connect to start the connection to the
machine.

NOTE

This function is displayed when [Wi-Fi Direct] is set to [On].

Device Name Check the device name.

NOTE
» This function is displayed when [Wi-Fi Direct] is set to [On].

» Detailed information is displayed when [»] key is selected.

NetwkName (SSID) Check the SSID (Service Set Identifier) of the wireless LAN to which the machine connects.

NOTE
« This function is displayed when [Wi-Fi Direct] is set to [On].

» Detailed information is displayed when [»] key is selected.

Password Check the password of the wireless LAN to which the machine connects.

NOTE

This function is displayed when [Wi-Fi Direct] is set to [On].

IP Address Check the IP address of the machine.

NOTE

This function is displayed when [Wi-Fi Direct] is set to [On].

Netwk Authentic Check network authentication type.

NOTE

This function is displayed when [Wi-Fi Direct] is set to [On].

Data Encryption Check the encryption method.

NOTE

This function is displayed when [Wi-Fi Direct] is set to [On].

Disconnect All Automatically disconnect devices connected through Wi-Fi Direct.

NOTE

This function is displayed when [Wi-Fi Direct] is set to [On].
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8 User Authentication and
Accounting (User Login,
Job Accounting)

This chapter explains the following topics:
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Overview of User Login Administration

User login administration specifies how the user access is administered on this machine. An IC card is used for machine
login.

NOTE

To use user authentication, the IC card authentication kit is required.

= Card Authentication Kit(B) "Card Authentication Kit" (page 10-3)
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Enabling User Login Administration

NOTE

This functions appears when the Card Authentication kit is activated.

= Card Authentication Kit(B) "Card Authentication Kit" (page 10-3)

1 Display the screen.
1 [Menu] key > [A][V] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.
NOTE
Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.
Select the [ 4] or [»] key to move the cursor left or right.
The default setting is "3000".
4 [A][VY]key>[User Login Set.] > [»] key

2 Configure the settings.
[A][V]key > [Login Type] > [OK] key > [A] [ V] key > [Netwk Authentic.] > [OK] key

NOTE

Select [Off] to disable user login administration.
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Key Login

Set whether or not login by arrow key is allowed when user authentication is enabled.

NOTE

 This functions appears when the Card Authentication kit is activated.

® Card Authentication Kit(B) "Card Authentication Kit" (page 10-3)

 This function can only be used when the administrator logs in.

1 Display the screen.
1 [Menu] key > [A][V] key > [User/Job Account] > [»>] key

2 Enter the administrator ID and select the [OK] key.

[ NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.
NOTE
Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.
The default setting is "3000".
4 [A][VY]key>[User Login Set.] > [»] key

2 Configure the settings.
[A][V]key > [Key Login] > [OK] key > [A] [ V] key > [Prohibit] or [Permit] > [OK] key
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Using User Login Administration

This section explains procedures while setting job accounting.

Login/Logout

When User Login is enabled, the IC card authentication screen will appear each time the machine is used.
Use the procedure below to login and logout.

Login

Place the ID card on the ID card reader.

Logout

When the operations are complete, select the [Logout] key. You will return to the IC card authentication screen.
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Overview of Job Accounting

Job accounting manages the print count accumulated by individual accounts by assigning an ID to each account.

1 Enable job 2 Setting an 3 Entertheassignedaccount 4 Count the number of pages
accounting. (Refer account. (Refer ID when performing the printed.
to page 8-7.) to page 8-9.) job. (Refer to page 8-5.)

A: 00000001

To manage the job account from PC
In addition to the above settings, the following are necessary to manage the job account from PC.

To Manage the Number of Sheets Used on Jobs Printed from a PC

To manage the number of jobs to be printed from the PC on the network, you need to configure settings by using the
printer driver on the PC.

1 Set Job Accounting for the PC on 2 Execute printing. 3 Count the number of
the network by using the printer pages printed.
driver. (Refer to page 8-14.)

a
=
=

A: 00000001 A

Ul

Th

B: 00000002
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Enabling Job Accounting

Enable job accounting. Use the procedure below.

1 Display the screen.
1 [Menu] key > [A] [V ] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The default setting is "3000".

2 Configure the settings.
[A][V]key > [Job Account] > [OK] key > [A] [ V] key > [On] > [OK] key

NOTE

To disable job accounting, select [Off].
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Job Accounting Access

Set the job accounting access.

1 Display the screen.
1 [Menu] key > [A][V¥] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The default setting is "3000".

2 Configure the settings.
[A][V]key > [AccountingAccess] > [OK] key > [A] [ Y] key > [Local] or [Network] > [OK] key
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Setting an Account

You can add, change and delete an account and set the restriction for each account.

Adding an Account

Add a new account.

NOTE
Because account IDs are managed as numeric strings, "1" and "001" are handled as different accounts. Also, once
Job Accounting is enabled, no jobs are printed unless information is attached showing the accounts from which the

jobs are being printed.

1 Display the screen.
1 [Menu] key > [A][V¥] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The default setting is "3000".

4 [A][VY]key>[Add Account] > [OK] key

2 Enter the account ID.

1 Enter the account name.

NOTE
You can set a number from 1 to 8 digits.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

Any "Account ID" that has already registered cannot be used. Enter any other account
ID.

2 Select the [OK] key.

A new account is added on the account list.
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Restricting the Use of the Machine

This section explains how to restrict the use of the machine by account or the number of sheets available.

Restriction Items

Item Descriptions

Restriction Limits the total number of sheets used for printing.
Color Restriction Limits the number of pages used for color printing.
Maximum Output Limits the number of sheets used for printing. This setting is displayed when the

"Restriction" is set to [Counter Limit].

Color Max.Output Limits the number of pages used for color printing. This setting is displayed when
the "Color Restriction" is set to [Counter Limit].

Applying Restriction

1 Display the screen.
1 [Menu] key > [A][V¥] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The default setting is "3000".
3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The default setting is "3000".

4 [A][VY]key > [Select Account] > [OK] key

2 Configure the settings.

-

Select the account you want to change and select the [OK] key.

N

Select the [»] key.
3 [A][V]key > [Restriction] or [Color Restriction] > [OK] key

4 [A][V]key > [Off], [Counter Limit] or [Reject Usage] > [OK] key

When [Counter Limit] is selected, proceed to next step.

5 [A][V]key > [Maximum Output] or [Color Max.Output] > [OK] key
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6 Enter a counter limit on pages > [OK] key

[ NOTE

You can set any value between 1 and 9,999,999.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.
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Editing an Account

This changes the registered account information.

1

Display the screen.

1 [Menu] key > [A][V¥] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

a4

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The default setting is "3000".

[A][V]key > [Select Account] > [OK] key

Edit an account.

1

A W N

Select the account you want to change and select the [OK] key.
Select the [»] key.
Select the item you want to change, and select the [OK] key.

Refer to "Restricting the Use of the Machine" to change account information.

#® Restricting the Use of the Machine (page 8-10)

The account information is changed.
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Deleting an Account

This deletes the account.

NOTE
Because account IDs are managed as numeric strings, "1" and "001" are handled as different accounts. Also, once
Job Accounting is enabled, no jobs are printed unless information is attached showing the accounts from which the

jobs are being printed.

1 Display the screen.
1 [Menu] key > [A][V] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE
Enter a password consisting of between 0 (no settings) and 16 digits.

Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.
The default setting is "3000".

4 [A][V]key > [Delete Account] > [OK] key

2 Delete an account.

Select the account you want to delete and select [OK] key.

The account is deleted.
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Job Accounting for Printing

The number of jobs to be printed from the computer can be managed by Job Accounting.

Setting Printer Driver

To manage the number of jobs to be printed from the PC on the network, you need configure the following settings by
using the printer driver on the PC. Instructions are based on interface elements as they appear in Windows 8.1.

1 Display the screen.

1

3

Select [Settings] in charms on Desktop, and select [Control Panel], and then [Devices
and Printers].

NOTE
In Windows 7, click [Start] button on the Windows, and then click [Devices and
Printers].

Right-click the printer driver icon of the machine, and click the [Printer properties] menu of
the printer driver.

Click [Administrator] on the [Device Settings] tab.

2 Configure the settings.

1

Select [Job accounting] on the [Job Accounting] tab.

3 |

General | Lock Settings UserLoglv Job Accounting I 1

'® Use specinic account ID:

() Prampt for account 1D

Account IDs:

Account ID Description User names (computer) Add...

Prompt for account 1D and validate

Displa At 1D list

Validate user name (computer] or prampt for agcount ID

2 Set the Account ID.

[Use specific account ID]: Enter the Account ID. Printing will be performed using the entered
Account ID. If this option is selected, the user does not have to enter the Account ID for each print job.

[Prompt for account ID]: A screen for entering the Account ID will be displayed when attempting a
printing. The Account ID must be entered each time a printing is attempted.

[Prompt for account ID and validate]: A screen for entering the Account ID will be displayed when
attempting a printing. The Account ID stored in the Account ID list needs to be entered. The Account
ID must be entered each time a printing is attempted.

[Display account ID list]: The Account ID list is displayed when printing. The Account ID to be used
needs to be selected from the list.

[Validate user name (computer) or prompt for account ID]: When printing, the Windows user
name is searched in the "Login user names" and printing is possible if the name is registered. If the
name is not registered, the printing will be canceled for users with only user authority. If the user has
administrator privileges, the screen to enter the user name and password will appear.
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3 Click [OK].

NOTE

For other settings of job accounting, refer to the following:

® Printer Driver User Guide
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Configuring Job Accounting

Apply Limit
Use this to specify the action taken when a department exceeds its printing limits.
[Menu] key > [A] [ V] key > [User/Job Account] > [»] key > [A] [ V] key > [Apply Limit] > [»>] key

For details on each function, see the table below.

Item Description

Apply Limit This specifies how the machine behaves when the counter has reached the limit of restriction.
The table below describes the action taken.

Value
Immediately: Job stops when the counter reaches its limit.
Subsequently: Printing of the job continues but the subsequent job will be rejected.
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Counting the Number of Pages Printed

This counts the number of pages printed. Counts are classified into Total Job Accounting and Each Job Accounting. A
new count can also be started after resetting the count data which was stored for a certain period of time.

[Menu] key > [A] [ V] key > [User/Job Account] > [»] key > [A] [V ] key > [Select Account] > [»] key

Each Job Account

This counts the number of pages for each account and resets the counts by account. When checking Each Job
Accounting, select the account for which you want to check the count.

Types of the counts are as follows.

Item Descriptions

Counter Displays the total number of sheets used for color and black & white printing.
Color Counter Displays the number of pages used for color printing.
Reset Counter Resets the counter.

Select the [OK] key in the confirmation screen.
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Print Job Accounting List

The total pages counted of all relevant accounts can be printed as an accounting list.

ACCOUNT. REPORT (% KYOCERA

rrrrrrrrrrrrrrr

Use the procedure below to print a job accounting report.

1 Prepare paper.

Check that A4 or Letter paper is loaded in the cassette.

2 Display the screen.
1 [Menu] key > [A] [V¥] key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.

The default setting is "3000".

3 Print the report.
[A][V]key > [Print Job Accounting List] > [OK] key > [OK] key

Select an account and then select the [OK] key, Job Accounting List is printed.

[ NOTE

You can set a number from 1 to 8 digits.
Select the [A] or [ V] key to enter a number.
Select the [«] or [»] key to move the cursor left or right.

If the entered account ID does not match the registered ID, a warning beep will sound and
login will fail. Enter the correct account ID.
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Using Job Accounting

This section explains procedures while setting job accounting.

Login/Logout
If job accounting is enabled, an account ID entry screen appears each time you use this machine.

Use the procedure below to login and logout.

Login

1 In the account ID entry screen, enter the account ID using the arrow key and select the
[OK] key.

NOTE
You can set a number from 1 to 8 digits.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»>] key to move the cursor left or right.

If the entered account ID does not match the registered ID, a warning beep will sound
and login will fail. Enter the correct account ID.

2 Proceed to complete the rest of the steps.

Logout

When the operations are complete, select the [Logout] key to return to the account ID entry screen.
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Unknown ID Job

Use this procedure to specify whether print jobs from departments with unknown account IDs are permitted.

The setting items are as follows.

Item Descriptions

Permit

The job is permitted to be printed.

Reject

The job is rejected (not printed).

1

Display the screen.
1 [Menu] key > [A][V]key > [User/Job Account] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The default setting is "3000".

2 Configure the settings.

[A][V]key > [Unknown ID Job] > [OK] key > [A] [ V] key > [Reject] or [Permit] > [OK] key
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Administrator settings

The Administrator setting is a function that identifies a user who can use the printer and manage other users.

When using the Security and Job Accounting functions, the administrator ID and password set here are authenticated,
and settings can be specified after they are properly authenticated.

1 Display the screen.
1 [Menu] key > [A][V] key > [Administrator] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The default setting is "3000".

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 digits.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The default setting is "3000".

2 Configure the settings.

The setting items are as follows.

Item Descriptions

Change ID You can use this to set the administrator ID. The default setting is "3000".

Select the [A] or [ V] key to increase or decrease, respectively, the value
at the blinking cursor. Enter the specified ID. Select the [«] and [»>] key
to move the cursor right and left. Enter an ID consisting of between 1 and
16 numbers.

Change Password You can use this to set the administrator password. The default setting is
"3000".

Select the [A] or [ ¥] key to increase or decrease, respectively, the value
at the blinking cursor. Enter the password to be changed. Select the [«]
and [»] key to move the cursor right and left. Enter a password
consisting of between 0 and 16 numbers.

NOTE

The administrator password is not displayed.
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Regular Maintenance

Cleaning

Clean the machine regularly to ensure optimum printing quality.

A\ caution

For safety, always unplug the power cord before cleaning the machine.

Paper Transfer Unit

The paper transfer unit should be cleaned each time the toner container and waste toner box are replaced. To maintain
optimum print quality, it is also recommended that the inside of the machine be cleaned once a month as well as when
the toner container is replaced.

Print problems such as soiling of the reverse side of printed pages may occur if the paper transfer unit becomes dirty.

A CAUTION

Some parts are very hot inside the machine. Exercise caution as there is a risk of burn injury.

Transfer Belt @
Registration Roller
(Metal)

Transfer Roller @
Paper Ramp

Wipe away the paper dust on the registration roller and the paper ramp using the cloth.

@ IMPORTANT

Be careful not to touch the transfer roller and transfer belt during cleaning as this
may adversely affect print quality.
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Toner Container Replacement

When toner runs low, "Toner low" appears in the message display. Make sure you have a new toner container available
for replacement.

When the message displays "Replace the toner.", replace the toner.

Frequency of Toner Container Replacement

The life of the toner containers depends on the amount of toner required to accomplish your printing jobs. According to
ISO/IEC 19798 and EcoPrint switched off the toner container can print as follows (A4/Letter paper is assumed):

Toner Color Life of the Toner Container (Printable pages)
Black 8,000 images
Cyan 6,000 images
Magenta 6,000 images
Yellow 6,000 images

NOTE
» The average number of pages that can be printed by the toner containers included with the machine are as follows.
Black (K): 3,500 images. Cyan (C), Magenta (M), Yellow (Y): 2,500 images.

» To maintain quality, we recommend using genuine Kyocera toner containers, which must pass numerous quality
inspections.

» The memory chip in the toner container of this product stores information necessary for improving customer
convenience, operation of the recycling system for used toner containers, and planning and development of new
products. The stored information does not include information that makes it possible to identify individuals, and is
only used anonymously for the above purposes.

A\ caution

Do not attempt to incinerate parts which contain toner. Dangerous sparks may cause burns.
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Replacing the Toner Container

Installation procedures of the toner container is same for every color. The procedures here represent the yellow toner
container.

9-4



Troubleshooting > Regular Maintenance

(@) IMPORTANT
Do not touch the points shown below.
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8

NOTE

« If the Upper Tray does not close, check that the new toner container is installed correctly (in step 6).

» Return the exhausted toner container to your dealer or service representative. The collected toner container will be
recycled or disposed in accordance with the relevant regulations.
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Waste Toner Box Replacement

When the waste toner box becomes full, immediately replace the waste toner box.

A\ caution

Do not attempt to incinerate parts which contain toner. Dangerous sparks may cause burns.

1
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4

NOTE

Return the exhausted waste toner box to your dealer or service representative. The collected waste toner box will be
recycled or disposed in accordance with the relevant regulations.
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Troubleshooting

Solving Malfunctions

The table below provides general guidelines for problem solving.

If a problem occurs with your machine, look into the checkpoints and perform procedures indicated on the following

pages. If the problem persists, contact your Service Representative.

NOTE

When contacting us, the serial number will be necessary.
To check the serial number, refer to the following:

® Checking the Equipment's Serial Number (page i)

. . . Referen
Checkpoints Corrective Actions ererence
Page
The screen does not Check the power cord. Connect both ends of the power cord page 2-8
respond when the main securely.
power switch is turned on.
Blank sheets are ejected. Are the originals loaded correctly? Check that the settings of the —
application software.
Printouts are totally too light. | Is the paper damp? Replace the paper with new paper. page 3-2
Is the toner distributed evenly within the | Shake the toner container from side to page 9-3
ABC ABC toner container? side several times.
123 123 : , :
Is EcoPrint mode enabled? Disable [EcoPrint Mode] mode. page 7-10
— Select the [Menu] key > [Adjust/ —
Maintenance] > [Service Setting] >
[Drum], and then select [OK] and [OK].
— Make sure the paper type setting is page 7-8
correct for the paper being used.
Printouts are fuzzy. Is the machine being used in conditions | Use in an environment that has suitable | —
of very humid, or humidity or humidity.
ABC temperature rapidly changes?
123 — Select the [Menu] key > [Adjust/ —
Maintenance] > [Service Setting] >
[Drum], and then select [OK] and [OK].
Images are skewed. Is the paper loaded correctly? Check the position of the paper width page 3-4
guides.
ABC
19
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Symptom

Checkpoints

Corrective Actions

Reference

Page

Irregular horizontal lines —
appear in the image.

Select the [Menu] key > [Adjust/
Maintenance] > [Service] > [MC] and
increase the adjustment value. Increase
the adjustment value 1 level at a time
from the current value. If there is no
improvement after the value is
increased by 1 level, increase by 1 level
again. If there is still no improvement,
return the setting to the original value.

The altitude is 1000 m or —
higher and irregular
horizontal white lines appear
in the image.

Select the [Menu] key > [Adjust/
Maintenance] > [Service] > [Altitude
Adj.], and set to an elevation one level
higher than the current setting.

The altitude is 1000 m or —
higher and dots appear in
the image.

ABC

Select the [Menu] key > [Adjust/
Maintenance] > [Service] > [Altitude
Adj.], and set to an elevation one level
higher than the current setting.

|

123.

Paper often jams. Is the paper loaded correctly? Load the paper correctly. page 3-2
Is the paper of the supported type? Is it | Remove the paper, turn it over, and page 3-4
in good condition? reload it.

Is the paper curled, folded or wrinkled? | Replace the paper with new paper. page 3-4
Are there any loose scraps or jammed Remove any jammed paper. page 9-26
paper in the machine?

2 or more sheets are — Load the paper correctly. page 3-2

overlaps when ejected.

(multi feed)

ABC
123
Printouts are wrinkled. Is the paper loaded correctly? Load the paper correcily. page 3-2
ABC Is the paper damp? Replace the paper with new paper. page 3-2
123
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. . . Referen
Symptom Checkpoints Corrective Actions ePea;e ce
Printouts are curled. Is the paper damp? Replace the paper with new paper. page 3-2
123
Cannot print. Is the machine plugged in? Plug the power cord into an AC outlet. —
Is the machine powered on? Turn on the power switch. page 2-9
Are the USB cable and network cable Connect the correct USB cable and page 2-7
connected? network cable securely.
Cannot print with USB Is the USB host blocked? Select [Unblock] in the USB host page 7-25
memory. settings.
UitE m.emc?ry il — Check that the USB memory is securely | —
recognized. plugged into the machine.
Dirt on the top edge or back | Is the interior of the machine dirty? Clean the interior of the machine. page 9-2
of the paper.
ABC
123
Part of the image is — Open and then close the rear cover. page 2-2
periodically faint or shows -
white lines. — Select the [Menu] key > [Adjust/ —
Maintenance] > [Service] > [MC] and
decrease the adjustment value.
Decrease the adjustment value 1 level
at a time from the current value. If there
is no improvement after the value is
decreased by 1 level, decrease by 1
level again. If there is still no
improvement, return the setting to the
original value.
Skewed-color printout. — Run [ColorCalibration]. page 9-21
— Run [Color Regist.]. page 9-21

A

ABC

Colors appear different than
you anticipated.

When printing from a computer
Adjust the color using the printer driver.

The previous image remains
and lightly printed.

AB

Select the [Menu] key > [Adjust/
Maintenance] > [Service] > [MC] and
increase the adjustment value. Increase
the adjustment value 1 level at a time
from the current value. If there is no
improvement after the value is
increased by 1 level, increase by 1 level
again. If there is still no improvement,
return the setting to the original value.
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. . . Referen
Symptom Checkpoints Corrective Actions epea;e ce
The color toner is empty. Do you want to continue printing in black | If the black toner is remained, the page 7-21
and white? machine continues printing in black and
white by selecting [Print in B & W] of
[ColorToner Empty].
The machine is emitting Check the room temperature to see ifit | Depending on the printing environment | —
steam in the area around the | is low, or if damp paper was used. and the paper's condition, the heat
paper ejection slot. generated during printing will cause the

moisture in the paper to evaporate, and
the steam emitted may look like smoke.
This is not a problem, and you can
continue printing. If the steam concerns
you, raise the room temperature, or
replace the paper with a newer, dryer
paper.
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Responding to Messages

If the message display or the computer displays any of these messages, follow the corresponding procedure.

NOTE

When contacting us, the serial number will be necessary. To check the serial number, refer to the following:

® Checking the Equipment's Serial Number (page i)

A

Message Checkpoints Corrective Actions Relfaearszce
Access denied. — The Log in operation failed for the —
You cannot login. specified number of times so it is no
longer possible to attempt to log in.
Contact a system administrator.
Account error — Failed to specify Job Accounting —
Press GO when processing the job externally.
The job is canceled. Select the [GO]
key.
Add paper Cassette # Is the indicated cassette out of The paper has run out in the paper | page 3-4
paper? source displayed. Supply paper
- according to the paper source
Add paper MP Tray Is the paper of thg selected size displayed (paper cassettes, MP page 3-7
loaded in the multi purpose tray? tray, or optional paper feeders).
Administrator only. — You can only change the settings —
selected when logged in as a user
with administrator privileges.

Message

Checkpoints

Corrective Actions

Reference
Page

Call service — #i## represents a mechanical error | —
0123456 (#=0, 1, 2, ...). Call for service. The
printer does not operate when this
message is displayed. The total
number of pages printed is also
indicated, e.g. 0123456.
Call service — F##H## represents a controller error —
Fii (#=0,1, 2, ...). Call for service. The

printer does not operate when this
message is displayed.

Canceling data

Displayed when data is being
canceled.

Cannot connect server
Press GO

The job is canceled. Select the [GO]
key.

Check the connection status with
the server.
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. . . Referen
Message Checkpoints Corrective Actions ePeage ce
Cannot connect to — Set machine time to match the page 2-14
Authentication Server server's time.
— Check the connection status with —
the server.
Cannot start this job — This job is canceled because it is —
Press GO restricted by Authentication
settings. Select the [GO] key.
Cannot use this box — You cannot use the specified box. —
Press GO Job is canceled. Select the [GO]
key.
Cannot use this — This message is displayed whena | —
function. user tries to use the restricted
function.
Cassette # not loaded — The corresponding paper cassette —
is not installed. Install the cassette.
Check cassette # — Open and then close the indicated —
cassette.
Check the toner — The toner container is not installed | page 9-3
container correctly. Set it correctly.
Check waste toner box — The waste toner box is not installed | page 9-7
correctly. Set it correctly.
Is the waste toner box full? Replace the waste toner box. page 9-7

Close rear cover #

Close the waste toner
cover.

Close top cover

Is there any cover which is open?

Close the cover indicated on the
screen.

Message

Checkpoints

Corrective Actions

Reference

Page

Device busy

This message is displayed when
Remove Device was selected while
a USB memory was being used.

The previous screen is displayed
again 1 or 2 seconds.

Duplex disabled
Press GO

Did you select a paper size/type
that cannot be duplex printed?

Select [Menu] to select the
available paper. Select the [GO] key
to print without using Duplex
function.
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E

Reference

Message Checkpoints Corrective Actions P
age

Enter Account — An account code must be entered. —
This message is displayed if you try
to print from the operation panel
(e.g. printing a status page or using
the Job Retention function) when
the Job Accounting function is
enabled.

Error.Power off — Turn the power switch off and then —
Fitiit back on again. If this message still
remains, turn the power switch off,
and contact your service
representative or authorized service
center.

Error.Power off — The printer controller and operation | —
F000 panel cannot exchange data. Turn
the power switch off and then back
on again. If this message still
remains, turn the printer off and
unplug it from the mains power
supply. Then contact your service
representative or authorized service
center. See the back page of this
manual for the relevant phone
numbers.

Exceeded Max. output — The printing count exceeded the page 8-10
Press GO acceptable count restricted by Job
Accounting. Cannot print any more.
This job is canceled. Select the
[GO] key.

Reference
Page

Message Checkpoints Corrective Actions

Format SSD. — The SSD installed in the printer is page 7-20
not formatted, and therefore cannot
be read or written.

Reference
Page

Message Checkpoints Corrective Actions

High temperature. — Adjust the temperature and the —
Adjust room temp. humidity of your room.
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n . . Referen
Message Checkpoints Corrective Actions ePeage ce
ID error The user ID entered for a private job | page 4-9
is not correct. Check the user ID page 4-11
that you specified on the printer
driver.
lllegal Account The account ID was incorrect when | page 8-9

Press GO

processing the job externally. The

job is canceled. Select the [GO] key.

Incorrect login info.
Press GO

The login user name or password
was incorrect when processing the
job externally. Enter the correct
login user name or password. The

job is canceled. Select the [GO] key.

J
Message Checkpoints Corrective Actions Re:,eargzce
Job not stored Printing using the Job Box function | —
Press GO failed because there was
insufficient space available on the
SSD or RAM disk, or because the
RAM disk was disabled when
demounting the SSD. To print an
error report and return the printer to
the print-ready status, select the
[GO] key.
Job restricted This job is canceled because it is page 8-10
Press GO restricted by Job Accounting. Select
the [GO] key.
K
Message Checkpoints Corrective Actions Rem;ear;;\ce
KPDL error PostScript error has occurred. The | —
Press GO job is canceled. Select the [GO] key.
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L
. . . Referen
Message Checkpoints Corrective Actions ePeage ce
Load Cassette # Is the paper of the selected size or | Load paper and select the [GO] key | page 7-9
(paper size) type loaded in the cassettes or multi | to print on the paper in the currently
N purpose tray? selected paper source.
Select [Menu] to select the other
Load Cassette # paper source.
(paper type)
Load MP Tray page 7-9
(paper size)
il
Load MP Tray
(paper type)
Low security — This message is displayed when —
Low was selected in Security Level.
Low temperature. — Adjust the temperature and the —
Adjust room temp. humidity of your room
M
Message Checkpoints Corrective Actions Re:’eargzce
Memory overflow — The total amount of data received —
Press GO by the printer exceeds the printer’s
internal memory. Try adding more
memory. Select the [GO] key to
resume printing. You can abandon
printing by selecting the [Cancel]
key.
N

Message

Checkpoints

Corrective Actions

Reference

No multi copies
Press GO

Multi copies cannot be printed
because RAM disk is disabled or
the SSD is not installed. The job is
canceled. Select the [GO] key.

Try adding more memory or
installing SSD, and configuring the
RAM disk settings.

Page

page 10-3

9-17
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Message

Checkpoints

Corrective Actions

Reference

Page

Non-genuine Toner.

Is the installed toner container our
own brand?

The manufacturer assumes no
responsibility for damage caused by
a non-genuine toner. We
recommend that you only use
genuine toner containers. When
you want to use the toner container
currently installed, select the [OK]
key and the [Cancel] key
simultaneously for 3 seconds or
more.

Not completed
Press GO

The restarting of the option network
failed. Please restart it again.

Message

Checkpoints

Corrective Actions

Reference

Page

Paper jam
HEHHEHEHEHEHEHHRHER

If a paper jam occurs, the machine
will stop and the location of the jam
will be indicated on the screen.

Leave the machine on and select
[Help]. Follow the instruction to
remove the jammed paper.

page 9-26

Paper loading

The selected cassette is being
prepared.

Paper path error

There is no paper cassette in the
printer, or the cassette is not
inserted properly. After reinserting
the paper cassette, you should be
able to print. When two or more
optional feeders are installed and
the lowest one is selected, the
same message will appear if any of
the upper paper feeder and the
printer cassette is improperly
installed.
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R

Message

RAM disk error
Press GO

Checkpoints

Corrective Actions

An error has occurred on the RAM
disk. Job is canceled. Select the
[GO] key.

The possible error codes and their
descriptions are as follows.

04: Insufficient space on the RAM
disk. If the optional RAM disk is
installed, increase the RAM disk
size by changing RAM Disk Size in
Menu.

Reference
Page

page 7-20

Register with Google
Cloud Print?

The message is displayed when the
printer receives the register request
for Google Cloud Print. Select the
[OK] key to register the printer as a
Google Cloud Print device. Select
the [Cancel] key to cancel the
registration.

Replace MK

Replace Maintenance Kit which is
displayed on the message display.
Replacement of the maintenance kit
is necessary at every 300,000
images of printing and requires
professional servicing. Contact your
Service Representative.

Replace the toner.
[CIIMILYIIK]

Replace the toner container to our
specified toner container. Select the
[GO] key to print using the
remaining black toner for a while.

page 9-3

Message

Shake the toner
container. [C][M][Y][K]

Checkpoints

Corrective Actions

Shake the toner container well and
reinstall it.

Reference
Page

page 9-3

SSD error.
Press GO

An error has occurred on SSD. Job
is canceled. Select the [GO] key.

The possible error codes and their
descriptions are as follows.

01: The amount of data that can be
saved at once has been exceeded.
Turn the power OFF/ON. If the error
still occurs, divide the file into
smaller files. If the error occurs after
the file is divided, the specified file
may be damaged. Delete the file.
04: Insufficient space on SSD to

complete this operation. Move data
or delete unneeded data.
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T

Message

Toner low
[CIIMI[Y][K]

Checkpoints

Corrective Actions

It is almost time to replace the toner
container. Obtain a new toner
container.

Reference
Page

Top tray paper full

Remove paper from the top tray.

Message

Unknown toner PC
[CIIMI[Y][K]

Checkpoints

Does the installed toner container's
regional specification match the
machine’s?

Corrective Actions

Install the specified toner container.

Reference
Page

USB memory error
Press GO

An error occurred in the removable
memory. The job stopped. Select
the [GO] key.

The possible error codes and their
descriptions are as follows.

01: The amount of data that can be
saved at once has been exceeded.
Turn the power OFF/ON. If the error
still occurs, the removable memory
is not compatible with the machine.

Use the removable memory
formatted by this machine. If the
removable memory cannot be
formatted, it is damaged. Connect a
compatible removable memory.

Use alternative?
it

When the cassette does not contain
any paper that matches the print
data (paper size and type), this
message allows you to specify an
alternative cassette to use instead.
Select the [A] [ V] key to select
alternative paper source and select
the [OK] key to resume printing.

Message

Wrong Account

Checkpoints

Corrective Actions

Displayed when an attempt is made
to register an account in the Job
Accounting menu by entering an
account code that already exists.

Reference
Page

page 8-9

Wrong Password

The password does not match the
password set. Enter the correct
password.

page 8-21
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Adjustment/Maintenance

ColorCalibration

This machine contains a calibration function that automatically makes adjustments to compensate for changes that
occur over time due to variations in the ambient temperature and humidity. So that the highest quality color printing can
be maintained, this color calibration operation is carried out automatically each time the power to the machine is turned
on. If color tone does not improve or color drift does not improve after executing this color adjustment, perform color print
position correction on the following:

® Registration (page 9-21)

1 Display the screen.
[Menu] key > [A][V¥] key > [Adjust/Maintenance] > [»] key

2 Perform the Color Calibration.
[A][V]key > [ColorCalibration] > [OK] key > [OK] key

"Completed." is displayed and the screen returns to the Adjust/Maintenance menu.

Registration

This function is available to resolve color drift. If it is not resolved by normal registration or to perform more detailed
settings, use the detailed settings.

[ NOTE

To perform Registration, verify that either Letter or A4 paper is loaded into a cassette.

@ IMPORTANT

Before performing Registration, be sure to perform ColorCalibration on page 9-21. If color drift remains,
perform registration. By performing Registration without performing Color Calibration, the color drift will be
resolved once, however, it may cause the serious color drift later.

Normal Registration

1 Display the screen.

[Menu] key > [A] [ V] key > [Adjust/Maintenance] > [»>] key > [A] [V] key >
[Registration Normal] > [»] key

2 Print the chart.
[A][V]key > [Print Registration Chart] > [OK] key > [OK] key

A chart is printed. On the chart, for each of M (magenta), C (cyan) and Y (yellow), 3 chart
types are printed on one sheet: H-L (left), V (vertical), H-R (right).
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Chart Example

ssssssssss
nnnnnnnnn

xxxxxxxxxx
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HHH}MIHI ;

xxxxxxxxxx
:::::::::

Color Registration Correction Chart

.H'uwmm
iy

ssssssssss
---------

cccccccccc
sssssssss

'U"WW““\“

1111111111
»»»»»»»»»

3 Display the correction menu

[Menu] key > [A] [ V] key > [Adjust/Maintenance] > [»>] key > [A] [ V] key >
[Registration Normal] > [»] key > [A] [ V] key > [Adjust Magenta] > [OK] key

The magenta correction menu appears.

4 Enter the appropriate value.

1 Find the location on each chart where 2 lines most closely match. If this is the 0 position,
registration for that color is not required. For the illustration, B is the appropriate value.

IGECA13579
HFDB02468

Nm‘

WU wWwHEPAEQH
@ o sNO WY mT
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2 Selectthe [«] or [»] key to change the L, V, and R items, select the [A] or [ V] key to enter
the values read from the chart, and select the [OK] key.

To increase the value from 0 up to a maximum of 9, select the [ A] key. To decrease the value, select
the [ V] key.

Select [ ¥] to change the value from 0 to an alphabetical letter. Continue selecting to change from A
through |. To move in the opposite direction, select [A].

3 Select the [OK] key.

Magenta correction is completed.

4 Repeat steps 3 to 4 to correct cyan and yellow.
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Detailed Settings

1 Display the screen.

[Menu] key > [A] [ V] key > [Adjust/Maintenance] > [»>] key > [A] [V] key >
[Registration Details] > [»>] key

2 Print the chart.
[A][V]key > [Print Registration Chart] > [OK] key > [OK] key

A chart is printed. On the chart, for each of M (magenta), C (cyan) and Y (yellow), charts for H-
1to 5 and V-1 to 5 are printed.

Chart Example

11111111111111111111111111111111111111111111111111
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3

Display the correction menu
[Menu] key > [A][V¥] key > [Adjust/Maintenance] > [»>] key > [A] [ V] key >
[Registration Details] > [>] key > [A] [V] key > [M 12345 3] > [OK] key

The magenta correction menu appears.

Enter the appropriate value.

1 Find the location on each chart where 2 lines most closely match. If this is the 0 position,
registration for that color is not required. For the illustration, B is the appropriate value.

IGECA13579
HFDBO2468

|||||’ (I
1l

VCNUWLWEPARQH
ooasNOo WY m

From charts H-1 to H-5, read the values from H-1 to H-5.

From charts V-1 to V-5, read only the values from V-3 (center).

2 Select the [«] or [»] key to change the H and V items, select the [A] or [ V] key to enter
the values read from the chart, and select the [OK] key.

To increase the value from 0 up to a maximum of 9, select the [ A] key. To decrease the value, select
the [ V] key.

Select [¥] to change the value from 0 to an alphabetical letter. Continue selecting to change from A
through |. To move in the opposite direction, select [A].

3 Select the [OK] key.

Magenta correction is completed.

4 Repeat steps 3 to 4 to correct cyan and yellow.
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Clearing Paper Jams

If a paper jam occurs, the message display will display "Paper Jam." and the machine will stop.

Refer to these procedures to remove the jammed paper.

Jam Location Indicators

1 Shows the location of a paper jam.

Paper jam
Cassette 1

NOTE
Online help messages are available in the printer's message display to provide simple instructions for clearing jams.
Select [@] when the paper jam message has appeared. For details on Help Screen, refer to the following:

® Help Screen (page 2-12)

If a paper jam occurs, the location of the jam will be displayed on the message display as well as the clearing instructions.

Paper Jam Location Indicator Paper Jam Location Reference Page
Paper jam Multi Purpose Tray page 9-27
MP Tray

Paper jam Cassettes 1 to 4 page 9-29
Cassette 1 (~4)

Rear Cover Rear Cover 1 (Feed) page 9-30
Paper jam Rear Cover 2 page 9-31
Rear Cover 2

Paper jam Rear Cover 3 page 9-33
Rear Cover 3

Paper jam Rear Cover 1 page 9-34
Rear Cover

Paper jam Duplex Unit page 9-36
Duplex unit

After you remove the jam, the machine will warm up again and the error message will be cleared. The machine resumes
with the page that was printing when the jam occurred.

9-26



Troubleshooting > Troubleshooting

Precautions with Paper Jams
» Do not reuse jammed papers.

+ If the paper tears during removal, be sure to remove any loose scraps of paper from inside the machine. Scraps of
paper left in the machine could cause subsequent jamming.

A\ caution

The fixing unit is extremely hot. Take sufficient care when working in this area, as there is a danger of getting
burned.

Multi Purpose Tray

1
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Cassettes 1to 4

Procedures for handling a paper jam in Cassettes 1 to 4 are all the same. This section explains procedures using
Cassette 1 as an example.

1
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Rear Cover 1 (Feed)

1

ACAUTION

Some parts are very hot inside the machine. Exercise caution as there is a risk of
burn injury.
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3

Rear Cover 2

NOTE

If the paper cannot be removed, do not try to forcefully remove it.
® Rear Cover 1 (Feed) (page 9-30)
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2
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Rear Cover 3

NOTE

If the paper cannot be removed, do not try to forcefully remove it.
® Rear Cover 1 (Feed) (page 9-30)
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Rear Cover 1

ACAUTION

Some parts are very hot inside the machine. Exercise caution as there is a risk of
burn injury.
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Duplex Unit

ACAUTION

Some parts are very hot inside the machine. Exercise caution as there is a risk of
burn injury.
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Optional Equipment

Overview of Optional Equipment

The following optional equipment is available for the machine.

(7) 1B-36

(1) Card Authentication Kit(B)

(2) PF-5100

<>

(6) SD Memory Card
SDHC Memory
Card

Software option

(8) Data Security kit(E)

>

(3) HD-6/HD-7 (4) 1B-50 (5) 1B-51

(9) UG-33
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(1) Card Authentication Kit(B) "Card Authentication Kit"

User login administration can be performed using ID cards. To do so, it is necessary to register ID card information on
the previously registered local user list. For more information about how to register this information, refer to the
following:

® Card Authentication Kit(B) Operation Guide

(2) PF-5100 "Paper Feeder (500-sheet x1)"

Up to three additional cassettes identical to the machine's cassettes can be installed in the machine. Loading method
are the same as the standard cassettes.

® Loading in the Cassettes (page 3-4)

(3) HD-6/HD-7 "SSD"

With SSD installed in the machine, received data can be rasterized and stored on this SSD. This enables high-speed
printing of multiple copies using an electric sort function. Also, you can use the Document Box functions.

® \What is Document Box? (page 5-3)

(4) 1B-50 "Network Interface Kit"

The Network Interface Kit provides a high-speed connection for the Gigabit-per-second interface. Settings are possible
for a variety of OS and network protocols.

= |B-50 User's Manual

(5) 1B-51 "Wireless Network Interface Kit"

This is a wireless LAN interface card which supports the wireless LAN specifications IEEE802.11n (Max 300 Mbps) and
11 g/b.

With the utilities supplied, settings are possible for a variety of OS and network protocols.
% [B-51 User's Manual
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(6) "SD/SDHC Memory Card"

An SD/SDHC memory card is useful for storing fonts, macros, and overlays. The machine is equipped with a slot for an
SDHC memory card with a maximum size of 32 GB, and an SD memory card with a maximum size of 2 GB.

Reading the SD/SDHC Memory Card

Once inserted in the machine's slot, the contents of the SD/SDHC memory card can be read from the operation panel or
automatically when you power on or reset the machine.

Installing and Formatting the SD/SDHC Memory Card

To use an unused SD/SDHC memory card, you must first use the machine to format the SD/SDHC memory card.

1 Power off the machine and unplug the power cord.

Menu fn Logout

A
< [oK | »

A 4 Cancel

¢ 2

(O Ready | ( Energy Saver || Attention

Check that the indicators are off.

2 Remove the cover.

3 Remove the cover.
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4 Insert the SD/SDHC memory card into the SD/SDHC memory card slot.

5 Replace the covers and close the rear cover.

6 Insert the power cord into the socket and turn on the power switch.

7 Format the SD/SDHC memory card from the operation panel.

For the procedure for formatting, refer to the following:
& SD Card (page 7-21)

(7) Wireless Network Interface Kit (IB-36)

This is a wireless LAN Interface card which supports the wireless LAN specifications IEEE802.11n (Max 65 Mbps) and
11 g/b. In addition, network printing is possible without using the wireless LAN router because Wi-Fi Direct is supported.

(8) Data Security Kit(E) "Data Security Kit"

The Data Security Kit overwrites all unnecessary data in the storage area so that it cannot be retrieved. The Data
Security Kit encrypts data before storing it in the SSD. It guarantees higher security because no data cannot be decoded
by ordinary output or operations.

(9) UG-33 "ThinPrint Option"

This application allows print data to be printed directly without a print driver.
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Optional Applications

Overview of the Applications

The applications listed below are installed on this machine.

Application

Data Security Kit

Card Authentication Kit '

ThinPrint Option*1

*1 This can be used on a trial basis for a limited time.

NOTE
+ Restrictions such as the number of times the application can be used during the trial period differ depending on the
application.

* If you change the date/time while using the trial version of an application, you will no longer be able to use the
application.

Starting Application Use
Use the procedure below to start using an application.
1 [Menu] > [A] [V] key > [Op functions] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The factory default settings for the administrator password is 3000.

4 Select [Details] of the application you will start using, and select the [»] key.

5 [A][V]key > [Official] > [OK] key > [OK] key

To use the application as a trial, select [Trial] without entering the license key.

10-6



Appendix > Optional Equipment
6 Enter the license key > [OK] key

[ NOTE

Select the [A] or [ V] key to enter a number.
Select the [«] or [»>] key to move the cursor left or right.

Some applications do not require you to enter a license key. If the license key entry screen does not
appear, go to Step 7.

7 Select [Yes].

NOTE
If you started the Security Kit or Thin Print option and entered the license key, turn the
power OFF/ON.

Checking Details of Application
Use the procedure below to check the details of application.
1 [Menu] >[A][V] key > [Op functions] > [»] key

2 Enter the administrator ID and select the [OK] key.

NOTE

Enter an ID consisting of between 1 and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [«] or [»] key to move the cursor left or right.
The factory default settings for the administrator ID is 3000.

3 Enter the administrator password and select the [OK] key.

NOTE

Enter a password consisting of between 0 (no settings) and 16 numbers.
Select the [A] or [ V] key to enter a number.

Select the [ 4] or [»] key to move the cursor left or right.

The factory default settings for the administrator password is 3000.

4 Select [Details] of the application you will start using, and select the [»] key.

You can view detailed information on the selected application. Select the [ A] key to view the next
screen. Select the [ V] key to return to the previous screen.

The table below lists the item you can view.

Function Name

License

Trial Counts

Date of Trial

Extend Trial Period

Status
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Extend the trial period.

[«][»] key > [Extend Trial Period] > [OK] key > [OK] key

The trial period is extended.
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Paper

This section explains the paper sizes and types that can be used in the paper source.

For details on the sizes, types, and number of sheets of paper that can be loaded in each paper tray, refer to the
following:

® Specifications (page 10-17)

Basic Paper Specifications

This machine is designed to print on standard copy paper as used in regular ('dry') copiers and page printers such as
laser printers. It also supports a variety of other types of paper that conform to the specifications given in this appendix.

Be careful when choosing paper. Paper unsuitable for the machine may cause jams or may be wrinkled.

Supported Paper

Use standard copy paper for regular copiers or laser printers. The printing quality will be affected by the quality of paper.
Poor quality paper may result in unsatisfactory output.

Basic Paper Specifications

The following table lists the specifications of paper that is supported with this machine. Refer to the subsequent sections
for further details.

Criteria Specifications

Weight Cassettes: 60 to 163 g/m?

Multi purpose tray: 60 to 220 g/m?

Dimensional accuracy +0.7 mm
Squareness of corners 90° £0.2°
Moisture content 4 to 6%

Pulp content 80% or more

NOTE

Some recycled paper does not meet requirements for use with this machine as listed in the Basic Paper Specifications
shown below, such as moisture or pulp content. For this reason, we recommend purchasing a small amount of
recycled paper as a sample for testing prior to use. Choose recycled paper that gives the best printing results and
contains low levels of paper dust.

We are not responsible for the problems occurred from the use of paper that does not conform to our specifications.
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Choosing the Appropriate Paper

This section describes guidelines for choosing paper.

Condition

Avoid using paper with bent corners or that is curled, dirty, or torn. Do not use paper that has a rough surface or paper
fiber lint, or that is especially delicate. Use of paper in any of these conditions will not only deliver poor copies but may
also cause jams and shorten the useful life of the machine. Choose paper with a smooth and even surface; however,
avoid coated paper or paper with a treated surface as it may damage the drum or fusing unit.

Ingredients

Do not use paper such as paper that has been coated or surface-treated or paper that contains plastic or carbon. Those
types of paper may produce harmful fumes from the heat of printing and may damage the drum.

Be sure to use the standard paper that contains at least 80% pulp, i.e., not more than 20% of the total paper content
consists of cotton or other fibers.

Supported Paper Sizes

Paper of the following sizes is supported by the machine.

Measurements in the table take into account a 0.7 mm dimensional accuracy for length and width. Corner angles must
be 90° £ 0.2°.

Paper Size Cassette 1 Cassettes 2to4  Multi Purpose
Tray
Envelope Monarch (3-7/8 x 7-1/2") x O O
Envelope #10 (4-1/8 x 9-1/2") x O O
Envelope DL (110 x 220 mm) x O O
Envelope C5 (162 x 229 mm) x O O
Executive (7-1/4 x 10-1/2") O O O
Letter O O O
Legal O O O
A4 (297 x 210 mm) O O O
B5 (257 x 182 mm) O O O
A5 (210 x 148 mm) O O O
A6 (148 x 105 mm) O x O
B6 (182 x 128 mm) O O O
Envelope #9 (3-7/8 x 8-7/8") x O O
Envelope #6 (3-5/8 x 6-1/2") x O O
ISO B5 (176 x 250 mm) O O O
Hagaki (Cardstock) (100 x 148 mm) X x O
Oufuku hagaki (Return postcard) (148 x 200 mm) x x O
Oficio Il O O O
216 x 340 mm O O O
16K (273 x 197 mm) O O O
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Paper Size Cassette 1 Cassettes 2to4  Multi Purpose
Tray

Statement O O O
Folio (210 x 330 mm) O O O
Youkei 4 (105 x 235 mm) x O O
Youkei 2 (114 x 162 mm) X O O
Custom Cassette 1: 105 x 148 to 216 x 356 mm

Cassettes 2 t0 4: 92 x 162 to 216 x 356 mm

Multi Purpose Tray: 70 x 148 to 216 x 356 mm

Smoothness

The paper surface should be smooth, but it must be uncoated. With paper that is too smooth and slippery, several
sheets may accidentally be supplied at once, causing jams.

Basis Weight

In countries that use the metric system, basis weight is the weight in grams of one sheet of paper one square meter in
area. In the United States, basis weight is the weight in pounds of one ream (500 sheets) of paper cut to the standard
size (or trade size) for a specific grade of paper. Paper that is too heavy or too light may be supplied incorrectly or cause
paper jams, which may cause excessive wear of the machine. Mixed paper weight (i.e., thickness) may cause several
sheets to be supplied at once accidentally and may also cause blurring or other printing problems if the toner fails to
adhere correctly.

Moisture Content

Paper moisture content is the ratio of moisture to dryness expressed as a percentage. Moisture affects how the paper is
supplied, the electrostatic chargeability of the paper, and how the toner adheres.

Paper moisture content varies depending on the relative humidity in the room. High relative humidity causes paper to
become damp, making the edges expand so it appears wavy. Low relative humidity causes paper to lose moisture,
making the edges tighten and weakening print contrast.

Wavy or tight edges may cause the paper to slip when it is supplied. Try to keep the moisture content between 4 to 6%.
To maintain the right level of moisture content, bear in mind the following considerations.
« Store paper in a cool, well-ventilated place.

» Store paper flat and unopened in the package. Once the package is opened, reseal it if the paper is not to be used for
a while.

» Store paper sealed in the original package and box. Put a pallet under the carton to keep it raised above the floor.
Especially during rainy seasons keep the paper a sufficient distance away from wooden or concrete floors.

» Before using paper that has been stored, keep it at the proper moisture level for at least 48 hours.

» Do not store paper where it is exposed to heat, sunlight, or dampness.
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Other Paper Specifications

Porosity: The density of the paper fibers.
Stiffness: Paper must be stiff enough or it may buckle in the machine, causing jams.

Curl: Most paper naturally tends to curl after the package is opened. When paper passes through the fixing unit, it curls
upward slightly. To deliver flat printouts, load the paper so that the curl faces towards the bottom of the paper tray.

Static electricity: During printing, paper is electrostatically charged so that the toner adheres. Choose paper that can be
discharged quickly so that copies do not cling together.

Whiteness: Paper whiteness affects print contrast. Use whiter paper for sharper, brighter copies.

Quality: Machine problems may occur if sheet sizes are not uniform or if corners are not square, edges are rough,
sheets are uncut, or edges or corners are crushed. In order to prevent these problems, be especially careful when you
cut the paper yourself.

Packaging: Choose paper that is properly packaged and stacked in boxes. Ideally, the packaging itself should have
been treated with a coating to inhibit moisture.

Specially treated paper: We do not recommend printing onto the following types of paper, even if it conforms to the
basic specifications. When you use these kinds of paper, purchase a small amount first as a sample to test.

* Glossy paper
+  Watermarked paper
» Paper with an uneven surface

» Perforated paper
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Special Paper

This section describes printing onto special paper and print media.
The following paper and media can be used.
» Transparencies

* Preprinted paper

+ Bond paper

* Recycled paper

» Thin paper

» Letterhead

+ Colored paper

* Prepunched paper

* Envelopes

» Hagaki (Cardstock)

* Thick paper

» Labels

+ Coated

» High-quality paper

When using these paper and media, choose those that are designed specifically for copiers or page printers (such as
laser printers). Use the multi purpose tray for transparencies, thick paper, envelopes, cardstocks, and label paper.

Choosing Special Paper

Although special paper that meets the following requirements can be used with the machine, print quality will vary
considerably due to differences in the construction and quality of special paper. Thus, special paper is more likely than
regular paper to cause printing problems. Before purchasing special paper in volume, try testing a sample to ensure the
print quality is satisfactory. General precautions when printing onto special paper are given below. Note that we are not
responsible for any harm to the user or damage to the machine caused by moisture or specifications of special paper.

Select a cassette or multi purpose tray for special paper.

Transparencies

Transparencies must be able to withstand the heat of printing. Transparencies must meet the following conditions.

Heat resistance Must withstand at least 190°C
Thickness 0.100 to 0.110 mm
Material Polyester

Dimensional accuracy +0.7 mm

Squareness of corners 90° £0.2°

To avoid problems, use the multi purpose tray for transparencies and load transparencies with the long side facing the
machine.

If transparencies jam frequently at output, try pulling the leading edge of sheets gently as they are ejected.
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Label

Be sure to feed labels from the multi purpose tray.

For selecting labels, use extreme care so that the adhesive may not come in direct contact with any part of the machine
and that the labels are not easily peeled from the carrier sheet. Adhesives that stick to the drum or rollers and peeled
labels remaining in the machine may cause a failure.

When printing onto labels, you must be liable for the print quality and possible trouble.

Top sheet

Carrier sheet

Labels consist of three layers as shown in the illustration. The adhesive layer contains materials that are easily affected
by the force applied in the machine. The carrier sheet bears the top sheet until the label is used. This composition of
labels may cause more problems.

The label surface must be covered completely with the top sheet. Gaps between labels may cause peeling of labels,
resulting in a serious failure.

Some label paper has large margins on the top sheet. When using such paper, do not peel these margins from the
carrier sheet before completing output.

Allowed Not allowed

Top sheet —

Carrier sheet ———p»

Use label paper that conforms to the following specifications.

Top sheet weight 44 to 74 g/m?

Basis weight 104 to 151 g/m?
(overall paper weight)

Top sheet thickness 0.086 to 0.107 mm
Overall paper thickness 0.11510 0.145 mm
Moisture content 4 to 6 % (composite)
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Hagaki (Cardstock)

Before loading Hagaki (Cardstock) into the multi purpose tray, fan them and align the edges. If the Hagaki (Cardstock)
paper is curled, straighten it before loading. Printing onto curled Hagaki (Cardstock) may cause jams.

Use unfolded Oufuku hagaki (Return postcard) (available at post offices). Some Hagaki (Cardstock) may still have rough
edges developed by a paper cutter on the back side. Remove any such rough edges by placing the Hagaki (Cardstock)
on a flat surface and rubbing the edges gently a few times with a ruler.

Envelopes

Envelopes should be fed from the MP tray with the print-side up or the optional paper feeder with the print-side up.

NOTE

Do not load paper above the load limits located on the paper width guide of the optional paper feeder.

Due to the structure of envelopes, printing evenly over the entire surface may not be possible in some cases. Thin
envelopes in particular may be wrinkled by the machine in some cases as they pass through. Before purchasing
envelopes in volume, try testing a sample to ensure the print quality.

Storing envelopes for a long period may cause them to become wrinkled. Thus, keep the package sealed until you are
ready to use them.

Keep the following points in mind.

» Do not use envelopes with exposed adhesive. In addition, do not use the type of envelope in which the adhesive is
exposed after the top layer is peeled off. Serious damage may be caused if the paper covering the adhesive comes
off in the machine.

» Do not use envelopes with certain special features. For example, do not use envelopes with a grommet for winding a
string to close the flap or envelopes with an open or film-covered window.

+ If paper jams occur, load fewer envelopes at once.

Thick Paper

Before loading thick paper in the multi purpose tray, fan it and align the edges. Some thick paper may still have rough
edges developed by a paper cutter on the back side. Remove any such rough edges just as with Hagaki (Cardstock) by
placing the paper on a flat surface and rubbing the edges gently a few times with a ruler. Printing onto paper with rough
edges may cause jams.

[ NOTE

If the paper is not supplied correctly even after it is smoothed, load the paper in the multi purpose tray with the leading
edge raised a few millimeters.
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Colored Paper
Colored paper must conform to the specifications.

® Basic Paper Specifications (page 10-9)

In addition, the pigments in the paper must be able to withstand the heat of printing (up to 200°C or 392°F).

Preprinted Paper
Preprinted paper must conform to the specifications.

® Basic Paper Specifications (page 10-9)

The colored ink must be able to withstand the heat of printing. It must be resistant to silicone oil as well. Do not use
paper with a treated surface such as glossy paper used for calendars.

Recycled Paper

Recycled paper must conform to the specifications; however, its whiteness may be considered separately.

® Basic Paper Specifications (page 10-9)

NOTE

Before purchasing recycled paper in volume, try testing a sample to ensure satisfactory print quality.

Coated Paper

Coated paper is created by treating the surface of the base paper with a coating that provides higher printing quality than
plain paper. Coated paper is used for particularly high quality printing.

The surface of high-quality or medium-quality paper is coated with special agents that improve ink adhesion by making
the paper surface smoother. These agents are used either to coat both sides of the paper or just one side. The coated
side appears slightly glossy.

@ IMPORTANT

When printing on coated paper in very humid environments, ensure that the paper is kept dry as moisture
may cause sheets to stick together when they are fed into the machine. If printing in very humid
environments, set coated paper for one sheet each.
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Specifications

(@) IMPORTANT
Specifications are subject to change without notice.

Machine
Item Description
Type Desktop

Printing Method Electrophotography by semiconductor laser

Paper Weight Cassette 60 to 163 g/m2
Multi Purpose 60 to 220 g/m?
Tray
Paper Type Cassette Plain, Rough, Recycled, Vellum, Preprinted, Bond, Color (Colour),
Prepunched, Letterhead, Thick, High Quality, Custom 1 to 8
(Duplex: Same as Simplex)
Multi Purpose Plain, Transparency (OHP film), Rough, Vellum, Labels, Recycled,
Tray Preprinted, Bond, Cardstock, Coated, Color (Colour), Prepunched,
Letterhead, Envelope, Thick, High Quality, Custom 1 to 8
Paper Size Cassette A4, A5, A6, B5, B6, Letter, Legal, Statement, Executive, Oficio Il,

Folio, 216 x 340 mm, 16K, B5 (1ISO),
Custom (105 x 148 mm to 216 x 356 mm)

Multi Purpose
Tray

A4, A5, A6, B5, B6, Folio, 216 x 340 mm, Letter, Legal, Statement,
Executive, Oficio Il, 16K, B5 (ISO), Envelope #10, Envelope #9,
Envelope #6 3/4, Envelope Monarch, Envelope DL, Envelope C5,
Hagaki (Cardstock), Oufuku Hagaki (Return postcard), Youkei 4,
Youkei 2, Custom (70 x 148 mm to 216 x 356 mm)

Warm-up Time Power on 26 seconds or less
(620202?”1'60':’ Sleep 17 seconds or less
Paper Capacity | Cassette 500 sheets (80 g/m?)
Multi Purpose 100 sheets (80 g/m?)
Tray
*1  Up to upper limit height line in the cassette.
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Output Tray
Capacity

Top tray

Description

250 sheets (80 g/m?)

Image Write System

Semiconductor laser and electrophotography

Memory 1024 MB
Interface Standard USB Interface Connector: 1 (Hi-Speed USB)
Network interface: 1 (10 BASE-T/100 BASE-TX/1000 BASE-T)
USB Port: 2 (Hi-Speed USB)
Option eKUIO: 1
Operating Temperature 10 to 32.5°C/50 to 90.5°F
Environment Humidity 10 to 80 %
Altitude 3,500 m/11,482 ft maximum
Brightness 1,500 lux maximum

Dimension (W x D x H)

15.36" x 20.95" x 16.13"
390 x 532 x 409.5 mm

Weight

Approx. 62.4 Ib/Approx. 28.3 kg
(without toner container)

Space Required (W x D)
(Using multi purpose tray)

15.36" x 28.58"
390 x 725.8 mm

Power Source

120 V Specification Model: 120 V v 60 Hz 9.0 A
230 V Specification Model: 220 to 240 V ~v 50/60 Hz 5.0 A

The power consumption of the
product in networked standby (If
all network ports are connected.)

The information is available at the website below.

http://www.kyoceradocumentsolutions.eu/index/environment/
green_products/low_power_consumption.html

Options

= Optional Equipment (page 10-2)
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Printer Functions

Item Description

Printing Speed Black and White Printing Full Color Printing

A4-R 30 sheets/min 30 sheets/min
Letter-R 32 sheets/min 32 sheets/min
Legal 26 sheets/min 26 sheets/min
B5 27 sheets/min 27 sheets/min
A5 27 sheets/min 27 sheets/min
A6 27 sheets/min 27 sheets/min

First Print Time | Black and
(A4, feed from White
Cassette)

6.0 seconds or less

Color 7.0 seconds or less

Resolution 600 x 600 dpi, 9600 dpi equivalent x 600 dpi, 1200 x 1200 dpi

Windows 7, Windows 8, Windows 8.1, Windows 10,
Windows Server 2008/R2, Windows Server 2012/R2,
Windows Server 2016,

Mac OS 10.5 or later

Operating System

Interface USB Interface Connector: 1 (Hi-Speed USB)

Network interface: 1 (10 BASE-T/100 BASE-TX/1000 BASE-T)
Optional Interface (Option): 1 (For IB-50/IB-51 mounting)
Wireless LAN (Option): 1 (For IB-36 mounting)

Page Description Language PRESCRIBE

Emulations PCL6 (PCL-XL, PCL5c), KPDL3, XPS

Paper Feeder (500-sheet) (Option)

Item Description

Paper Supply Method Friction roller feeder (No. Sheets: 500, 80 g/m?)

Paper Size A4, A5, B5, B6, Folio, 216 x 340 mm, Letter, Legal, Statement,
Executive, Oficio Il, 16K, B5 (ISO), Envelope #10, Envelope #9,
Envelope #6 3/4, Envelope Monarch, Envelope DL, Envelope C5,
Youkei 4, Youkei 2, Custom (92 x 162 to 216 x 356 mm)

Supported Paper Paper weight: 60 to 220 g/m?

Media types: Plain, Rough, Recycled, Preprinted, Labels, Bond,
Vellum, Color (Colour), Prepunched, Letterhead, Envelope, Coated,
Thick, High Quality, Custom 1 to 8

15.36" x 20.95" x 4.57"
390 x 532 x 116 mm

Dimensions
(W) x (D) x (H)

Weight 9.1 Ibs. or less/ 4.1 kg or less

NOTE

Consult your dealer or service representative for recommended paper types.
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Glossary

Accessibility

The machine is designed featuring good accessibility even for the elderly and those who are physically challenged or
visually impaired.

Apple Talk

AppleTalk offers file sharing and printer sharing and it also enables you to utilize application software that is on another
computer on the same AppleTalk network.

Auto Form Feed Timeout

During data transmission, the machine may sometimes have to wait until receiving the next data. This is the auto form
feed timeout. When the preset timeout passes, the machine automatically prints output. However, no output is
performed if the last page has no data to be printed.

Auto-IP

Auto-IP is a module that enables dynamic IPv4 addresses to be assigned to a device on startup. However, DHCP
requires a DHCP server. Auto-IP is a server-less method of choosing an IP address. IP addresses between 169.254.0.0
to 169.254.255.255 are reserved for Auto-IP and assigned automatically.

Auto Paper Selection

A function to automatically select paper in the same size as originals when printing.

Auto Sleep

A mode designed for electrical power saving, activated when the machine is left unused or there is no data transfer for a
specific period. In Sleep mode, power consumption is kept to a minimum.

Bonjour

Bonjour, also known as zero-configuration networking, is a service that automatically detects computers, devices and
services on an IP network. Bonjour, because an industry-standard IP protocol is used, allows devices to automatically
recognize each other without an IP address being specified or DNS server being set. Bonjour also sends and receives
network packets by UDP port 5353. If a firewall is enabled, the user must check that UDP port 5353 is left open so that
Bonjour will run correctly. Some firewalls are set up so as to reject only certain Bonjour packets. If Bonjour does not run
stably, check the firewall settings and ensure that Bonjour is registered on the exceptions list and that Bonjour packets
are accepted. If you install Bonjour on Windows OS, the Windows firewall will be set up correctly for Bonjour.

Custom Box

The Custom Box function stores print data for each individual user on the printer and allows the user to print single or
multiple copies of the stored data later using the printer's operation panel.

Default Gateway

This indicates the device, such as a computer or router, that serves as the entrance/exit (gateway) for accessing
computers outside the network that you are on. When no specific gateway is designated for a destination IP address,
data is sent to the host designated as the Default Gateway.
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DHCP (Dynamic Host Configuration Protocol)

Dynamic Host Configuration Protocol (DHCP) that automatically resolves IP addresses, subnet masks, and gateway
addresses on a TCP/IP network. DHCP minimizes the load of network management employing a large number of client
computers because it relieves individual clients including printers from the |P address being assigned.

DHCP (IPv6)

DHCP (IPv6) is the next-generation of the Internet's Dynamic Host Configuration Protocol and supports IPv6. It extends
the BOOTP startup protocol that defines the protocols used for transferring configuration information to hosts on the
network. DHCP (IPv6) permits the DHCP server to use its expanded functionality to send configuration parameters to an
IPv6 node. Because the network addresses that can be used are allocated automatically, the IPv6 node management
workload is reduced in systems where the administrator has to exercise close control over IP address allocation.

dpi (dots per inch)

A unit for resolution, representing the number of dots printed per inch (25.4 mm).

EcoPrint Mode

A printing mode that helps save toner. Copies made in this mode are thus lighter than normal.

Emulation

The function to interpret and execute other printers' page description languages. The machine emulates operation of
PCL6, KPDL3 (PostScript 3 compatible).

FTP (File Transfer Protocol)

A protocol to transfer files on the TCP/IP network, whether the Internet or an intranet. Along with HTTP and SMTP/POP,
FTP is now frequently used on the Internet.

Grayscale

A computer color expression. Displayed images of this sort are typically composed of shades of gray, varying from black
at the weakest intensity to white at the strongest, without any other colors. Gray levels are displayed in numerical levels:
that is, white and black only for 1 bit; 256 gray levels (including white and black) for 8 bits; and 65,536 gray levels for 16
bits.

IP Address

An Internet protocol address is a unique number that represents a specific computer or related device on the network.
The format of an IP address is four sets of numbers separated by dots, e.g. 192.168.110.171. Each number should be
between 0 and 255.

IPP

IPP (Internet Printing Protocol) is a standard that uses TCP/IP networks such as the Internet to enable print jobs to be
sent between remote computers and printers. IPP is an extension of the HTTP protocol used to view websites and
enables printing to be carried out via routers on printers in remote locations. It also supports the HTTP authentication
mechanisms along with SSL server and client authentication as well as encryption.

Job Box

The Job Box function stores print data on the printer and allows users to print single or multiple copies of the stored data
later using the printer's operation panel.
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KPDL (Kyocera Page Description Language)

Kyocera's PostScript page description language compatible with Adobe PostScript Level 3.

Multi Purpose (MP) Tray

The paper supply tray on the front side of the machine. Use this tray instead of the cassettes when printing onto
envelopes, Hagaki (Cardstock), transparencies, or labels.

NetBEUI (NetBIOS Extended User Interface)

An interface, developed by IBM in 1985, as an update from NetBIOS. It enables more advanced functions on smaller
networks than other protocols such as TCP/IP, etc. It is not suitable for larger networks due to lack of routing capabilities
to choose the most appropriate routes. NetBEUI has been adopted by IBM for its OS/2 and Microsoft for its Windows as
a standard protocol for file sharing and printing services.

Outline font

With outline fonts, character outlines are represented with numerical expressions and fonts can be enlarged or reduced
in different ways by changing the numeric values of those expressions. Printing remains clear even if you enlarge fonts,
since the characters are defined with outlines represented with numerical expressions. You can specify the font size in
steps of 0.25 points up to 999.75 points.

PDF/A

This is "ISO 19005-1. Document management - Electronic document file format for long-term preservation - Part 1: Use
of PDF (PDF/A)", and is a file format based on PDF 1.4. It has been standardized as ISO 19005-1, and is a
specialization of PDF, which has been mainly used for printing, for long-term storage. A new part, ISO 19005-2 (PDF/A-
2), is currently being prepared.

POP3 (Post Office Protocol 3)

A standard protocol to receive E-mail from the server in which the mail is stored on the Internet or an intranet.

PostScript

A page description language developed by Adobe Systems. It enables flexible font functions and highly-functional
graphics, allowing higher quality printing. The first version called Level 1 was launched in 1985, followed by Level 2 that
enabled color printing and two-byte languages (e.g. Japanese) in 1990. In 1996, Level 3 was released as an update for
the Internet access and PDF format as well as gradual improvements in implementation technologies.

PPM (prints per minute)

This indicates the number of A4 size printouts made in one minute.

Printer Driver

The software to enable you to print data created on any application software. The printer driver for the machine is
contained in the DVD enclosed in the package. Install the printer driver on the computer connected to the machine.

RA(Stateless)

The IPv6 router communicates (transmits) information such as the global address prefix using ICMPV6. This information
is the Router Advertisement (RA).

ICMPV6 stands for Internet Control Message Protocol, and is a IPv6 standard defined in the RFC 2463 "Internet Control
Message Protocol (ICMPv6) for the Internet Protocol Version 6 (IPv6) Specification".
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RAM Disk

Using part of the printer's memory as a virtual disk, you can set any amount of memory from overall printer memory as a
RAM disk in order to use features such as electronic sorting (shortening print time).

SMTP (Simple Mail Transfer Protocol)

A protocol for E-mail transmission over the Internet or an intranet. It is used for transferring mail between mail servers as
well as for sending mail from clients to their servers.

Status Page

The page lists machine conditions.

Subnet Mask

The subnet mask is a way of augmenting the network address section of an IP address.

A subnet mask represents all network address sections as 1 and all host address sections as 0. The number of bits in
the prefix indicates the length of the network address. The term "prefix" refers to something added to the beginning and,
in this context, indicates the first section of the IP address. When an IP address is written, the length of the network
address is indicated by the prefix length after a forward slash (/). For example, "24" in the address "133.210.2.0/24". In
this way, "133.210.2.0/24" denotes the IP address "133.210.2.0" with a 24-bit prefix (network section). This new network
address section (originally part of the host address) made possible by the subnet mask is referred to as the subnet
address. When you enter the subnet mask, be sure to set the "DHCP" setting to "Off".

TCPI/IP (Transmission Control Protocol/Internet Protocol)

TCPI/IP is a suite of protocols designed to define the way computers and other devices communicate with each other
over a network.

TCPIIP (IPv6)

TCP/IP (IPv6) is based on the current Internet protocol, TCP/IP (IPv4). IPv6 is the next-generation Internet protocol and
expands the available address space, which resolves the problem of the lack of addresses under IPv4, while also
introducing other improvements such as additional security functionality and the capacity to prioritize data transmission.
TWAIN (Technology Without An Interesting Name)

A technical specification for connecting scanners, digital cameras, and other image equipment to computers. The
TWAIN compatible devices enable you to process image data on any relevant application software. TWAIN is adopted
on a large amount of graphic software (e.g. Adobe Photoshop) and OCR software.

USB (Universal Serial Bus) 2.0

A USB interface standard for Hi-Speed USB 2.0. The maximum transfer rate is 480 Mbps. This machine is equipped with
USB 2.0 for high-speed data transfer.

WIA (Windows Imaging Acquisition)

A function to import images supported after Windows Me/XP from digital cameras and other peripheral devices. This
function replaces what TWAIN used to do. The feature is provided as a part of Windows functions and improves ease of
operation, so that you import images directly to My Computer without using any application.
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